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Technology Licenses
The hardware and/or software described in 
this document are furnished under a 
license and may be used or copied only in 
accordance with the terms of such license.

U.S. Government Rights

The Software is “commercial computer 
software,” as defined by Federal Acquisition 
Regulation (“FAR”) 2.101. Pursuant to FAR 
12.212 and 27.405-3 and Department of 
Defense FAR Supplement 

(“DFARS”) 227.7202, the U.S. government 
acquires commercial computer software 
under the same terms by which the soft-
ware is customarily provided to the public. 
Accordingly, Keysight provides the Soft-
ware to U.S. government customers under 
its standard commercial license, which is 
embodied in its End User License Agree-

ment (EULA), a copy of which can be found 
at http://www.keysight.com/find/sweula. 
The license set forth in the EULA represents 
the exclusive authority by which the U.S. 
government may use, modify, distribute, or 
disclose the Software. The EULA and the 
license set forth therein, does not require 
or permit, among other things, that Key-
sight: (1) Furnish technical information 
related to commercial computer software 
or commercial computer software docu-
mentation that is not customarily provided 
to the public; or (2) Relinquish to, or other-
wise provide, the government rights in 
excess of these rights customarily provided 
to the public to use, modify, reproduce, 
release, perform, display, or disclose com-
mercial computer software or commercial 
computer software documentation. No 
additional government requirements 
beyond those set forth in the EULA shall 
apply, except to the extent that those 
terms, rights, or licenses are explicitly 
required from all providers of commercial 
computer software pursuant to the FAR and 
the DFARS and are set forth specifically in 
writing elsewhere in the EULA. Keysight 
shall be under no obligation to update, 
revise or otherwise modify the Software. 
With respect to any technical data as 
defined by FAR 2.101, pursuant to FAR 
12.211 and 27.404.2 and DFARS 227.7102, 
the U.S. government acquires no greater 
than Limited Rights as defined in FAR 
27.401 or DFAR 227.7103-5 (c), as appli-
cable in any technical data. 

Warranty

THE MATERIAL CONTAINED IN THIS DOCU-
MENT IS PROVIDED "AS IS," AND IS SUB-
JECT TO BEING CHANGED, WITHOUT 
NOTICE, IN FUTURE EDITIONS. FURTHER, 
TO THE MAXIMUM EXTENT PERMITTED BY 
APPLICABLE LAW, KEYSIGHT DISCLAIMS 
ALL WARRANTIES, EITHER EXPRESS OR 
IMPLIED WITH REGARD TO THIS MANUAL 
AND ANY INFORMATION CONTAINED 

HEREIN, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A PAR-
TICULAR PURPOSE. KEYSIGHT SHALL NOT 
BE LIABLE FOR ERRORS OR FOR INCIDEN-
TAL OR CONSEQUENTIAL DAMAGES IN 
CONNECTION WITH THE FURNISHING, 
USE, OR PERFORMANCE OF THIS DOCU-
MENT OR ANY INFORMATION CONTAINED 
HEREIN. SHOULD KEYSIGHT AND THE 
USER HAVE A SEPARATE WRITTEN AGREE-
MENT WITH WARRANTY TERMS COVER-
ING THE MATERIAL IN THIS DOCUMENT 
THAT CONFLICT WITH THESE TERMS, THE 
WARRANTY TERMS IN THE SEPARATE 
AGREEMENT WILL CONTROL.

Safety Notices

CAUTION
A CAUTION notice denotes a hazard. 
It calls attention to an operating pro-
cedure, practice, or the like that, if 
not correctly performed or adhered 
to, could result in damage to the 
product or loss of important data. Do 
not proceed beyond a CAUTION 
notice until the indicated conditions 
are fully understood and met. 

WARNING
A WARNING notice denotes a hazard. 
It calls attention to an operating pro-
cedure, practice, or the like that, if 
not correctly performed or adhered 
to, could result in personal injury or 
death. Do not proceed beyond a 
WARNING notice until the indicated 
conditions are fully understood and 
met.
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Safety Summary
The following general safety precautions must be observed during all phases of operation 
of this instrument. Failure to comply with these precautions or with specific warnings or 
operating instructions in the product manuals violates safety standards of design, 
manufacture, and intended use of the instrument. Keysight Technologies assumes no 
liability for the customer's failure to comply with these requirements. Product manuals 
are provided with your instrument on CD-ROM and/or in printed form. Printed manuals 
are an option for many products. Manuals may also be available on the Web. Go to 
www.keysight.com and type in your product number in the Search field at the top of the 
page.

General This product is a Safety Class 1 instrument (provided with a protective earth terminal). 
The protective features of this product may be impaired if it is used in a manner not 
specified in the operation instructions.

All Light Emitting Diodes (LEDs) used in this product are Class 1 LEDs as per IEC 
60825-1.

Environment Conditions This instrument is intended for indoor use in an installation category II, pollution degree 2 
environment. It is designed to operate at a maximum relative humidity of 95% and at 
altitudes of up to 2000 meters.

Refer to the specifications tables for the ac mains voltage requirements and ambient 
operating temperature range.

Before Applying Power Verify that all safety precautions are taken. The power cable inlet of the instrument serves 
as a device to disconnect from the mains in case of hazard. The instrument must be 
positioned so that the operator can easily access the power cable inlet. When the 
instrument is rack mounted the rack must be provided with an easily accessible mains 
switch.

Ground the Instrument To minimize shock hazard, the instrument chassis and cover must be connected to an 
electrical protective earth ground. The instrument must be connected to the ac power 
mains through a grounded power cable, with the ground wire firmly connected to an 
electrical ground (safety ground) at the power outlet. Any interruption of the protective 
(grounding) conductor or disconnection of the protective earth terminal will cause a 
potential shock hazard that could result in personal injury.

Do Not Operate in an
Explosive Atmosphere

Do not operate the instrument in the presence of flammable gases or fumes.

Do Not Remove the
Instrument Cover

Operating personnel must not remove instrument covers. Component replacement and 
internal adjustments must be made only by qualified personnel. 

Instruments that appear damaged or defective should be made inoperative and secured 
against unintended operation until they can be repaired by qualified service personnel.

http://www.keysight.com
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Safety Symbols

Table 1  Safety Symbol

Symbol Description

Indicates warning or caution. If you see this symbol on a 
product, you must refer to the manuals for specific 
Warning or Caution information to avoid personal injury 
or damage to the product.

Frame or chassis ground terminal. Typically connects to 
the equipment’s metal frame.

Indicates hazardous voltages and potential for electrical 
shock.

Indicates that antistatic precautions should be taken.

Indicates hot surface. Please do not touch.

Indicates laser radiation turned on.

CSA is the Canadian certification mark to demonstrate 
compliance with the Safety requirements.

CE compliance marking to the EU Safety and EMC 
Directives.
ISM GRP-1A classification according to the 
international EMC standard.
ICES/NMB-001 compliance marking to the Canadian 
EMC standard.
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Compliance and Environmental Information

Table 2  Compliance and Environmental Information

Safety Symbol Description

This product complies with WEEE Directive (2002/96/EC) marking requirements. 
The affixed label indicates that you must not discard this electrical/electronic 
product in domestic household waste.

Product Category: With reference to the equipment types in WEEE Directive Annex I, 
this product is classed as a “Monitoring and Control instrumentation” product.

Do not dispose in domestic household waste.

To return unwanted products, contact your local Keysight office, or see
http://about.keysight.com/en/companyinfo/environment/takeback.shtml for more 
information.
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About This Guide
Here is how the information in this document is organized.

Introduction

This chapter provides an overview of this manual.

Know Your Hardware

This chapter provides an information on the various modules of M8020A/M8030A, their 
setup and the provided accessories.

Exploring M8070A User Interface

This chapter describes the M8070A user interface and the functionality provided by its 
common GUI elements.

Configuring Your System

This chapter describes how to configure the M8020A/M8030A system using the Module 
View, Group View and System View.

Setting up Generator

This chapter provides information on settings provided by the M8020A/M8030A 
Generator.

Setting up Analyzer

This chapter provides information on settings provided by the M8020A/M8030A Analyzer.

Setting up Patterns

This chapter describes the functionality provided by the M8070A Pattern Editor and 
Sequence Editor.

Working with Measurements

This chapter describes the setup, execution, monitoring and results of the measurements 
supported by M8070A system software.

Utilities

This chapter describes the utilities provided by the M8070A system software.

Licenses

This chapter provides information on the M8020A/M8030A and M8070A licenses and 
their installation procedure.

Troubleshooting

This chapter provides information that can help you to troubleshoot M8020A/M8030A in 
case any problem occurs.
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1 Introduction
 

Overview

J-BERT M8020A high-performance BERT 

The Keysight J-BERT M8020A high-performance BERT enables fast, 
accurate receiver characterization of single-and multi-lane devices 
running up to 16 or 32 Gb/s.

With today’s highest level of integration, the M8020A streamlines your test 
setup. In addition, automated in situ calibration of signal conditions 
ensures accurate and repeatable measurements.

Figure 1 Typical base M8020A instrument configuration

Key Features

• Data rates up to 8.5 and 16 Gb/s expandable to 32 Gb/s

• 1 to 4 BERT channels in a 5-slot AXIe chassis

• Integrated and calibrated jitter injection: RJ, PJ1, PJ2, SJ, BUJ, 
sinusoidal level interference (common-mode and differential-mode), 
SSC (triangular and arbitrary, residual) and Clock/2

• 8 tap de-emphasis, positive and negative

• Integrated and adjustable Intersymbol Interference

• Interactive link training for PCI Express

• Built-in clock recovery and equalization

• All options and modules are upgradeable
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M8020A Applications

The J-BERT M8020A is designed for R&D and test engineers who 
characterize and verify compliance of chips, devices, boards and systems 
with serial I/O ports up to 16 Gb/s and 32 Gb/s in the consumer, 
computer, mobile computing, data center and communications industry.

The J-BERT M8020A can be used to test popular serial bus standards, 
such as PCI Express®, SATA/SAS, DisplayPort, USB Super Speed, MIPI 
M-PHY, SD UHS-II, Fibre Channel, QPI, memory buses , backplanes, 
repeaters, active optical cables, Thunderbolt, 10/40 GbE/SFP+/QSFP, 
100 GbE/CFP2.

M8030A Multi-Channel BERT

The M8030A Multi-Channel BERT extents the J-BERT M8020A platform to 
a real multi-channel BERT solution supporting up to 10 pattern generators 
and 10 error detectors (EDs) to allow multi-channel application tests like, 
PCIe and PON. Wherever multi-channel measurements are required in 
order to speed up throughput or test under real application conditions, the 
M8030A is a perfect solution.

Figure 2 Typical base M8030A instrument configuration
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Key Features

• Data rates up to 8.5 and 16 Gb/s

• 1 to 10 BERT pattern generator and analyzer and channels in a 14-slot 
AXIe chassis

• Clock synchronization between all modules

• 8 tap de-emphasis, positive and negative

• Integrated and adjustable ISI

• Built-in clock recovery and equalization

M8030A Applications

The M8030A multi-channel BERT is designed for R&D and test engineers 
who characterize and verify compliance for electronic chips, devices, 
boards, systems with multiple I/O ports (up to 16 Gb/s) in various industry 
segments dealing with basic consumer goods, computer devices, 
communication equipments, etc. Typical applications are:

• PCIe multi-channel test

• PON applications

• XAUI and GAUI multi-lane test

Document History

Table 3  Document History

Edition Description

Edition 1.0, June 2014 Edition 1.0 of the M8070A user guide is in accordance to the 
M8070A version 1.0.

Edition 2.0, October 2014 Edition 2.0 of the M8070A user guide is in accordance to the 
M8070A version 1.5.

Edition 3.0, March 2015 Edition 3.0 of the M8070A user guide is in accordance to the 
M8070A version 2.0.

Edition 4.0, August 2015 Edition 4.0 of the M8070A user guide is in accordance to the 
M8070A version 2.5.

Edition 4.1, September 2015 Edition 4.1 of the M8070A user guide is in accordance to the 
M8070A version 2.6.
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Related Documents

Table 4  Related Documents

Abbreviations used in this Document

Table 5  Abbreviations

Edition 4.2, January 2016 Edition 4.2 of the M8070A user guide is in accordance to the 
M8070A version 2.7.

Edition 5.0, February 2016 Edition 5.0 of the M8070A user guide is in accordance to the 
M8070A version 3.0.

Edition 5.1, March 2016 Edition 5.1 of the M8070A user guide is in accordance to the 
M8070A version 3.1.

Edition Description

Document Part No. Document Title

M8000-91010 Tips for Preventing Damage to M8020A and M8030A

M8000-91020 M8020A Start Here Document

M8020-91010 M8020A and M8030A Installation Guide

M8020-91020 M8020A and M8030A Getting Started Guide

M8020-91040 M8070A Programming Guide

M8070-91010 Getting Started with Keysight M8070A Plug-ins

Abbreviation Extended Form

AXIe AdvancedTCA Extensions for Instrumentation and Test

AWG Arbitrary Waveform Generator

BER Bit Error Ratio

CDR Clock Data Recovery

CTLE Continuous-Time Linear Equalizer

DUT Device Under Test

ESD Electrostatic Discharge

ESM Embedded System Module
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GB Gigabyte

GUI Graphical User Interface

J-BERT Jitter-Bit Error Ratio Tester

LED Light-Emitting Diode

MB Megabyte

MIPI Mobile Industry Processor Interface

PC Personal Computer

PCIe Peripheral Component Interconnect Express

PLL Phase Locked Loop

PRBS Pseudorandom Binary Sequence

PXI PCI eXtensions for Instrumentation

R & D Research & Development

SAS Serial Attached SCSI

SATA Serial Advanced Technology Attachment

SCPI Standard Commands for Programmable Instruments 

SMA SubMiniature Version A

SSC Spread Spectrum Clock

TCP Transmission Control Protocol

USB Universal Serial Bus

VCO Voltage Controlled Oscillator 

Abbreviation Extended Form



Keysight M8070A System Software for M8000 Series of 
BER Test Solutions

User Guide

 

2 Know Your Hardware

M8020A Overview   /  28
M9505A AXIe Chassis   /  29
M8030A Overview   /  31
M9514A AXIe Chassis   /  32
M8020A / M8030A Modules   /  35
Host Computer   /  51
ESD Protection   /  52
M8020A Module Setup   /  56
M8030A Module Setup   /  58
Accessories   /  60
General Characteristics   /  62



28 Keysight M8070A User Guide

2 Know Your Hardware
 

M8020A Overview

The Keysight’s J-BERT M8020A High-Performance BERT is a modular 
instrument which supports the following modules:

• M8041A high-performance BERT generator-analyzer-clock 8/16 Gb/s.

• M8051A high-performance BERT generator-analyzer 
8/16 Gb/s.

• M8061A multiplexer 2:1 with de-emphasis 32 Gb/s.

• M8062A 32Gb/s Front-end for J-BERT M8020A High-Performance 
BERT

• In addition to above J-BERT modules, it also supports M8195A 
65 GSa/s Arbitrary Waveform Generator. Details of this module can be 
found at www.keysight.com/find/m8195a.

M8020A being a modular product includes different sets of modules which 
are hosted in an AXI chassis. Each module and its features have their own 
license. You need to install these options in your instrument in order to use 
the modules or features. For details, refer to the chapter Licenses on 
page 433. However, if you have ordered M8020A-BU1, no license is 
required.

The M8041A module must be installed in slots 1 through 3 in the AXIe 
chassis unless the M9536A AXIe Embedded Controller is installed. The 
following configurations are possible in an M9505A 5-slot chassis:

• 1 or 2-channel, 16 Gb/s - (1) M8041A

• 3 or 4-channel, 16 Gb/s - (1) M8041A + (1) M8051A

• 1-channel, 32 Gb/s (Pattern Generator only) - (1) M8041A + 
(1) M8061A

• 1-channel, 32 Gb/s (Pattern Generator only or full BERT) - (1) 
M8041A + (1) M8062A

• M8195A module can more or less arbitrarily be added into the 5 slot 
module

Additionally, the M8061A, M8062A and M8195A modules can be installed 
and operated in a 2 slot frame.

For details on the features and hardware components of each of the 
above-mentioned modules, refer to M8020A / M8030A Modules on 
page 35.
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M9505A AXIe Chassis

The M9505A AXIe Chassis is a modular instrument chassis that supports 
complex and high density testing. The chassis provides slots for installing 
multiple AXIe based instrument modules such as the M8041A, M8051A, 
M8061A and M8062A modules. Besides providing a frame for the 
installation of these instrument modules, the M9505A AXIe Chassis also 
provides power, a cooling system, a PCIe Gen2 local data bus, a Gigabit 
LAN interconnect, and a cabled USB (USB option required) and PCIe 
connection for external host computer connectivity. 

The following model of the M9505A AXIe Chassis supports the M8020A 
modules:

• M9505A - a 5-Slot AXIe chassis 

Refer to the Keysight M9505A AXIe Chassis Startup Guide to get detailed 
information about the AXIe chassis.

NOTE
The USB connection is recommended when using a laptop or desktop PC 
as an external controller. The PCIe connection is recommended for use 
with a desktop PC as an external controller only.
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M9505-00230 AXIe Embedded System Module (USB ESM)

The bottom slot of the AXIe chassis is reserved for the M9505-00230 
Embedded System Module (ESM) which is factory-installed. The ESM has 
a USB 2.0 interface as well as a PCIe x8, Gen1 and Gen2 compliant 
interface to connect an external host computer to the chassis. The 
following figure shows the PCIe Port and USB Port in ESM.

The ESM:

• runs the chassis embedded operating system which manages all 
internal tasks and communications.

• tracks inserted modules and manages power requirements.

• monitors chassis temperature and controls variable-speed chassis fans.

• monitors module sensors and reports component failures to a system 
log.

• acts as a Gigabit Ethernet switch; forwards frames along the backplane.

• connects an external host computer to the chassis.

• synchronizes timing across all modules through the Keysight Trigger 
Bus, using an internal or external clock source.

• LAN connector on AXIe ESM is not used. Only use LAN connection on 
the host computer.

• Either the PCIe (desktop only) or USB (desktop or laptop) port can be 
used in this ESM but not both simultaneously. When you use the PCIe 
port, the USB port is automatically disabled until the PCIe port is no 
longer in use. 
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M8030A Overview

The M8030A is a modular instrument which supports the following 
modules.

• M8041A high-performance BERT generator-analyzer-clock 8/16 Gb/s

• M8051A high-performance BERT generator-analyzer 8/16 Gb/s

• M8092A Multi-channel synchronization module

The modules must be installed in the M9514A AXIe 14-slot chassis in the 
following way:

Table 6  M8030A Modules Arrangement

For details on the features and hardware components of each of the above 
mentioned modules, refer to M8020A and M8030A Getting Started Guide. 

Slot Number Module

# 1 M8030A-BU1 AXIe embedded controller. For M8030A-BU2 this slot is empty 
and covered with filler front-plane

# 2, 3 & 4 M8041A module

# 5 & 6 M8051A module

# 7 M9521A AXIe system module, always included in M8030A-BU1 or 
M8030A-BU2, must be in this slot

# 8 & 9 M8051A module

# 10 & 11 M8051A module

# 12 & 13 M8051A module

# 14 M8192A multi-channel synchronization module, always required in this slot
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M9514A AXIe Chassis

The Keysight M9514A AXIe 14-slot chassis (one slot for the AXIe System 
Module plus 13 instrument module slots) is a modular instrument chassis 
fully compatible with the AXIe 1.0 Hardware specifications. It allows 
multiple application-specific instrument modules to share a common 
chassis frame, power supply, cooling system, PCI Express (PCIe) Gen 2 
data bus, Gigabit LAN hub, local bus for module-to-module signaling, and 
host PC connections.

Multiple chassis may be interconnected for scalability. The chassis 
provides 13 general purpose peripheral slots that accept 1U AXIe 
instrument modules. Each module slot has a Gen 2 x4 link (maximum of 
2 GB/s data rate per module) to the chassis primary data ‘fabric’ hub—a x8 
PCIe switch and data bus.

The chassis requires a full module height AXIe System Module (ASM) such 
as the Keysight M9521A, to manage chassis functions.

.

Refer to the Keysight M9514A AXIe Chassis Startup Guide to get detailed 
information about the AXIe chassis.

NOTE
The USB connection is recommended when using a laptop or desktop PC 
as an external controller. The PCIe connection is recommended for use 
with a desktop PC as an external controller only.

NOTE
PCIe connectivity between the M9514A AXIe Chassis and an external 
desktop PC controller is recommended when full channel plus large 
patterns need to be downloaded.
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M9521A AXIe System Module (ASM) 

The M9521A AXIe System Module (ASM) is installed in the system slot of 
the M9514A (slot 7). It provides the system communication and 
synchronization functions required in an AXIe chassis including:

• Trigger bus and clock routing.

• Managing clocks, including internal or external reference sources.

• Gigabit LAN switching with front panel RJ45 LAN connections.

• AXIe Fabric 1 switching (Gen 2 x4 lanes to each module slot).
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Keysight M9536A AXIe Embedded Controller Module

The M9536A AXIe Embedded Controller is a one slot module that you can 
install in the M9505A AXIe Chassis like any other instrument module. This 
module acts as a host computer when installed in the M9505A AXIe 
Chassis. It may be installed in any slot in the of the M9505A AXIe chassis 
except for Slot 7 which is reserved for the ASM. However, to eliminate 
interference with the local bus used for E-Keying (if your AXIe modules use 
E-Keying), you should install the controller in one of the outside slots; e.g., 
1 or 14 first, then 2 or 13, etc.

The following figure displays this module.

The ESM:

• runs the chassis embedded operating system which manages all 
internal tasks and communications.

• tracks inserted modules and manages power requirements.

• monitors chassis temperature and controls variable- speed chassis 
fans.

• monitors module sensors and reports component failures to a system 
log.

• acts as a Gigabit Ethernet switch; forwards frames along the backplane.

• connects an external host computer to the chassis.

• synchronizes timing across all modules through the Keysight Trigger 
Bus, using an internal or external clock source.

LAN connector on AXIe ESM is not used. Only use LAN connection on the 
host computer. 

Either the PCIe (desktop only) or USB (desktop or laptop) port can be used 
in this ESM but not both simultaneously. When you use the PCIe port, the 
USB port is automatically disabled until the PCIe port is no longer in use.
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M8020A / M8030A Modules

The M8020A/M8030A modules are recognized by the model number and 
name located on their front panel. 

Each BERT module can be configured for 8 Gb/s or 16 Gb/s operation, as 
generator-only or as full BERT. Some upgraded features/components of a 
module are licensed and are only available when you purchase a license 
for that option. The M8062A module supports 32 Gb/s and the M8195A as 
a BERT module can support higher speeds than 16 Gb/s. The M8195A 
cannot be used as a full BERT. It has no analyzer.

The following sections describe each of the M8020A/M8030A instrument 
modules in detail.

J-BERT M8041A Generator-Analyzer-Clock Module

The J-BERT M8041A is a BERT module that can be installed into an 
Keysight M9505A 5-slot AXIe chassis. This module occupies three slots.

The M8041A is a two channel bit error ratio tester with built-in clock and 
data generator for performing compliance and characterization 
measurements. The second channel requires a license.

M8041A Features

The M8041A module provides the following features:

• Two channel pattern generator (option 0G2) and two channel error 
detector (option 0A2)

• Data rate from 256 Mb/s to 16.2 Gb/s (option G16 or C16) for pattern 
generation and error detection

• Built in jitter injection (option 0G3)
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• Adjustable ISI offered for M8041A and M8051A (option 0G5), software 
2.0 and serial number >= DE55300500

• Built in 8 tap de-emphasis (option 0G4)

• Built in receiver equalization (CTLE, option 0A3)

• Built in reference clock multiplier for pattern generator (option 0G6)

• Simultaneous common mode and differential mode level interference 
(option 0G7)

• Interactive link training (option 0S1, Software 1.5)

• Four universal control inputs with adjustable threshold

• Three universal control outputs with adjustable levels

• 2 Gb pattern memory per channel (requires software 1.5)

M8041A Module Components

The following figure displays the front panel of the M8041A module with its 
various components labeled.
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The M8041A module has the following components.

Table 7  Insertion/Extraction and Retaining

Table 8  Front Panel LEDs

Component Description

Retaining screws The screws on both ends of the module are used to retain the module tightly inside the M9505A AXIe 
Chassis slot once you have fully placed it inside the chassis. To remove the module, you first need to 
loosen these screws ensuring that these screws disengage completely.

Module Insertion/Extraction
Handles

The handles on both sides of the module to insert or eject the module from the slot of the M9505A AXIe 
Chassis.

Connector Name Active when... Color

Fail power-up fault condition red

Access power-up ready state green

Data In x input is overloaded red

Data Out x output is overloaded red

Data Mod In x input is active green

Ctrl In A/Ctrl In B logic level is detected green

Ctrl Out A output is active green

Clk In signal is detected green

Ref Clk In signal is detected green

Ref Clk Out output is active green

Aux In not used n/a

Clk Out output is active green

Trig Out output is active green

Clk Mod In input is active green

Sys Out A/Sys Out B output is active green

Sys Ctrl In A/Sys Ctrl In B logic level is detected green
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M8041A Front Panel Connector Inputs/Outputs

Table 9  Channel x Data Inputs/Outputs

Table 10  Clock Inputs/Outputs

CAUTION
The inputs of the M8041A module are sensitive to static electricity. 
Therefore, take necessary anti-static precautions, such as wearing a 
grounded wrist strap, to minimize the possibility of electrostatic damage.

Component Description

Data Out and /Data Out Differential data outputs (3.5 mm, female).

Data In and /Data In Differential data inputs (3.5 mm, female).

Data Mod In Accepts an external source for data out delay modulation (SMA, female).

Component Description

Clk In External clock input in the range of 8.1 to 16.2 GHz. This input is used as a direct clock for all 
channels in forwarded clock applications (SMA, female).

Ref Clk In Reference clock input for applications that provide a host reference clock in the range of 10 MHz to 
16 GHz. The clock signal may be SSC modulated and is used as the reference for the system clock of 
all Tx and Rx channels. A SSC tolerant PLL is used to multiply the reference clock to the system clock 
(SMA, female).

Ref Clk Out The reference clock output is used to provide a 10 MHz or 100 MHz reference clock to the DUT or 
other test equipment (SMA, female).

Clk Out and /Clk Out Differential clock output (3.5 mm, female).

Trig Out and /Trig Out This output is used to send a trigger signal to another connected device, such as an oscilloscope (3.5 
mm, female). It can also be used as a sub rate clock.

Clk Mod In Input for delay modulation of the Trig Out and Clk Out channel. Both outputs are always affected 
(SMA, female).
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Table 11  Sync In/Sync Out

Table 12  System Inputs/Outputs

Table 13  Control Inputs/Output

Component Description

Sync In This input is used to synchronize two or more modules to a common system clock. It is connected to 
the Sync Out of the other module.

Sync Out This output is used to synchronize two or more modules to a common system clock. It is connected 
to the Sync In of the other module.

Component Description

Sys Out A/Sys Out B System level control outputs used to signal events to the DUT or external instruments (SMA, female).

Sys In A/Sys In B System level control inputs used to generate sequencer events (SMA, female).

Component Description

Ctrl In A/Ctrl In B The module has two control inputs at the font panel each with the following selectable functionality 
(SMA, female):
Error Add Input
Every rising edge at the input generates a single error in the output data stream by flipping a single 
bit. The maximum repetition rate is data rate divided by 4 times the vector size.
Output Blanking
If the input level is above the threshold level the pattern generator stops and only 0’s are sent on 
data output. Normal operation resumes when the input level is below the threshold.
Electrical Idle
If the input level is above the threshold level the output amplifier enters electrical idle. Normal 
operation resumes when the input level is below the threshold.
Gating Input
If a logical high is applied to the gating input the error detector will ignore the incoming bits during a 
BER measurement. The ignored bit sequence is always a multiple of the vector size. For measuring 
data in bursts of bits, rather than a continuous stream of bits, a special operating mode is used. This 
mode is the burst sync mode. In this case, the signal at the gating input controls the synchronization 
and the error counting for each burst.

Ctrl Out A The module has one control output at the front panel with the following functionality (SMA, female):
Error Output
This signal can be used to trigger an external instrument to help in error analysis. If an error occurs, 
a single RZ pulse is generated. Continuous errors will result in a clock signal.
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J-BERT M8051A Generator-Analyzer

The J-BERT M8051A is an instrument module that can be installed into 
the M9505A 5-slot AXIe Chassis. This module occupies two slots and 
requires the M8041A module for proper operation. 

The M8051A is a two channel Generator and two channel Analyzer for 
performing compliance and characterization measurements.

M8051A Features 

The main M8051A features are the same as the M8041A features. For 
details, refer to J-BERT M8041A Generator-Analyzer-Clock Module on 
page 35.

M8051A Module Components

The following figure displays the front panel of the M8051A module with its 
various components labeled.
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The M8051A module has the following components.

Table 14  Insertion/Extraction and Retaining

Table 15  Front Panel LEDs

M8051A Front Panel Connector Inputs/Outputs

Component Description

Retaining screws The screws on both ends of the module are used to retain the module tightly inside the M9505A AXIe 
Chassis slot once you have fully placed it inside the chassis. To remove the module, you first need to 
loosen these screws ensuring that these screws disengage completely.

Module Insertion/Extraction Handles The handles on both sides of the module to insert or eject the module from the slot of the M9505A AXIe 
Chassis.

Connector Name Active when... Color

Fail power-up fault condition red

Access power-up ready state green

Data In x input is overloaded red

Data Out x output is overloaded red

Data Mod In x input is active green

Ctrl In A/Ctrl In B logic level is detected green

CAUTION
The inputs of the M8051A module are sensitive to static electricity. 
Therefore, take necessary anti-static precautions, such as wearing a 
grounded wrist strap, to minimize the possibility of electrostatic damage.
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Table 16  Channel x Data Inputs/Outputs

Table 17  Sync In

Table 18  Control Inputs/Output

Component Description

Data Out and /Data Out Differential data outputs (3.5 mm, female).

Data In and /Data In Differential data inputs (3.5 mm, female).

Data Mod In Accepts an external source for data out delay modulation (SMA, female).

Component Description

Sync In This input is used to synchronize two or more modules to a common system clock. It is connected to 
the Sync Out of the other module or to the clock distribution module if more than two modules are 
installed. The sync cable is required if M8051A is connected with M8041A module. 

Component Description

Ctrl In A/Ctrl In B The module has two control inputs at the font panel each with the following selectable functionality 
(SMA, female):
Error Add Input
Every rising edge at the input generates a single error in the output data stream by flipping a single 
bit. The maximum repetition rate is data rate divided by 4 times the vector size.
Output Blanking
If the input level is above the threshold level the pattern generator stops and only 0’s are sent on 
data output. Normal operation resumes when the input level is below the threshold.
Electrical Idle
If the input level is above the threshold level the output amplifier enters electrical idle. Normal 
operation resumes when the input level is below the threshold.
Gating Input
If a logical high is applied to the gating input the error detector will ignore the incoming bits during a 
BER measurement. The ignored bit sequence is always a multiple of the vector size. For measuring 
data in bursts of bits, rather than a continuous stream of bits, a special operating mode is used. This 
mode is the burst sync mode. In this case, the signal at the gating input controls the synchronization 
and the error counting for each burst.

Ctrl Out A The module has one control output at the front panel with the following functionality (SMA, female):
Error Output
This signal can be used to trigger an external instrument to help in error analysis. If an error occurs, 
a single RZ pulse is generated with the width of half a vector length. Continuous errors will result in 
a clock signal.
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M8061A 32 Gb/s Multiplexer with De-emphasis Module

The M8061A is an instrument module that can be installed into the 
M9502A 2-slot or M9505A 5-slot AXIe Chassis. This module occupies two 
slots.

The M8061A is used to characterize serial interfaces of up to 32 Gb/s. The 
M8061A provides four calibrated de-emphasis taps, which can be 
extended to eight taps, built-in superposition of level interference, and 
Clock/2 jitter injection.

M8061A Features 

• Expands data rate of M8041A and M8051A generators up to 32 Gb/s 
enabling accurate and complete receiver stress testing

• Integrated and calibrated 4-tap de-emphasis, expandable to 8 taps

• Internal superposition of interference for common mode and differential 
mode 

• Transparent to jitter generated by the J-BERT M8020A, Clock/2 jitter 
can be added

• Supports electrical idle 

• Control from J-BERT M8020A user interface via USB.

M8061A Module Components

The following figure displays the front panel of the M8061A module with its 
various components labeled.
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The M8061A module has the following components.

Table 19  Insertion/Extraction and Retaining

Table 20  Front Panel LEDs

Component Description

Retaining screws The screws on both ends of the module are used to retain the module tightly inside the M9505A AXIe 
Chassis slot once you have fully placed it inside the chassis. To remove the module, you first need to 
loosen these screws ensuring that these screws disengage completely.

Module Insertion/Extraction Handles The handles on both sides of the module to insert or eject the module from the slot of the M9505A AXIe 
Chassis.

Connector Name Active when... Color

Fail power-up fault condition red

Access power-up ready state green
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M8061A Front Panel Connector Inputs/Outputs

Table 21  Electrical Idle Input

Table 22  Clock Inputs/Output

Table 23  DMI/CMI Inputs

Table 24  Data Inputs/Outputs

CAUTION
The inputs of the M8061A module are sensitive to static electricity. 
Therefore, take necessary anti-static precautions, such as wearing a 
grounded wrist strap, to minimize the possibility of electrostatic damage.

Component Description

Electrical Idle In This input is used to enable/disable the output signal by an external control signal. If the input level 
is above the threshold level the module enters electrical idle. Normal operation resumes when the 
input level is below the threshold (SMA, female). 

Component Description

Clk Out Reference clock output used in clean clock mode to provide the synthesizer signal to the J-BERT 
without external splitter (3.5 mm, female). 

Clk In Reference clock input used in clean clock mode, the synthesizer should be connected to this port 
(3.5 mm, female). 

Aux Clk In External clock input in the range of 150 MHz to 14.2 GHz. This input is used with the J-BERT’s 
internal clock. In presence of jitter, this provides the same jitter as the data outputs (3.5 mm, 
female). 

Component Description

DMI In Differential mode interference input independent of ground (SMA, female).

Clk In Common mode interference input relative to ground (SMA, female).

Component Description

Data Out and /Data Out Differential or single-ended data output (2.4 mm, female).

Data In x Single-ended data input (3.5 mm, female).
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M8062A 32Gb/s Front-end for J-BERT M8020A High-Performance BERT

The M8062A extends the data rate of the J-BERT M8020A Bit Error Ratio 
Tester to the speeds required for testing devices with lane rates in the 
25-28 Gb/s range. When combined with a two channel M8041A, the 
system provides data pattern generation and full-rate error analysis for 
users and systems with lane rates up to 32.4 Gb/s.

M8062A Features

• Extends maximum data rate of J-BERT M8020A up to 32.4 Gb/s

• Seamless control of pattern generator and error analyzer

• Integrated 8-tap de-emphasis

• Built in ISI generator for channel emulation

• Analyzer equalization eliminates errors resulting from closed eyes in 
loop back path

• Built in CDR for data rates up to 32 Gb/s

Refer to the Online Help installed and integrated into the M8070A 
software to learn about how to use this module.

NOTE
The CDR license (M8062A-0A4) is required to enable the CDR feature. 
M8062A modules with serial numbers < MY55400300 may also require a 
hardware upgrade in order to enable this feature.

NOTE
Phase-matched cables must be used when connecting the M8041A data 
and clock outputs to the M8062A data and clock inputs. The provided 
cable set, Keysight M8062-61643, meets this requirement. 
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M8062A Module Components

The following figure displays the front panel of the M8062A module with its 
various components labeled.

The M8062A module has the following components.

Table 25  Insertion/Extraction and Retaining

Table 26  Front Panel LEDs

Front Panel LEDs

Sync In

Retaining Screws

Clean Clk Out
M8062A Front 

Panel Error 
Analyzer Connectors M8062A Front 

Panel Pattern 
Generator  
Connectors

Component Description

Retaining screws The screws on both ends of the module are used to retain the module tightly inside the M9505A AXIe 
Chassis slot once you have fully placed it inside the chassis. To remove the module, you first need to 
loosen these screws ensuring that these screws disengage completely.

Module Insertion/Extraction Handles The handles on both sides of the module to insert or eject the module from the slot of the M9505A AXIe 
Chassis.

Connector Name Active when... Color

Fail power-up fault condition red

Access power-up ready state green

CAUTION
The inputs and outputs of the M8062A module are sensitive to static 
electricity. Therefore, take necessary anti-static precautions, such as 
wearing a grounded wrist strap, to minimize the possibility of 
electrostatic damage.
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Table 27  Sync In/Clean Clk Out

M8062A Front Panel Pattern Generator Connectors 

Table 28  Electrical Idle Input

Table 29  Pattern Generator Clock Inputs/Output

Table 30  DMI/CMI Inputs

Connector Name Description

Sync In This input is used to synchronize two or more modules to a common system clock. It is connected to the Sync 
Out of the other module. The sync cable is required if M8062A is connected with M8041A module. 

Clean Clk Out Half-rate, or divided, clock output with no applied jitter. 

Component Description

Electrical Idle In This input is used to enable/disable the output signal by an external control signal. If the input level is above the 
threshold level the module enters electrical idle. Normal operation resumes when the input level is below the 
threshold (SMA, female). 

Component Description

Clk Out Half-rate Pattern Generator clock output. Carries the same jitter as the full-rate data output. 

Clk In Pattern Generator clock input (half-rate). Connect to clock output of M8041A.

Aux Clk In Alternate Pattern Generator clock input (half-rate). Typically unused.

Component Description

DMI In Differential Mode Interference input. Applies a single-ended, external interference source differentially to the 
data output (SMA, female).

CMI In Common Mode Interference input. Applies a single-ended, external interference source to both the normal and 
complement data output signals (SMA, female).
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Table 31  Pattern Generator Data Inputs/Outputs

M8062A Front Panel Analyzer Connectors 

Table 32  Error Analyzer Data Inputs/Outputs

Table 33  Error Analyzer Clock Inputs/Output

M8195A 65 GSa/s Arbitrary Waveform Generator

The In addition to above J-BERT modules, it also supports M8195A 
65 GSa/s Arbitrary Waveform Generator (AWG) which can be accessed 
through the M8070A system software. Currently, it just supports M8195A 
Revision 1. 

The Keysight M8195A Arbitrary Waveform Generator comes with the 
highest combination of speed, bandwidth and channel density. Flexible 
signal generation at up to 32 Gbaud. Clean and distorted signal to stress 
the device to the limits.

Component Description

Data Out and /Data Out Differential or single-ended, full-rate data output to the device under test. Unused outputs must be 
terminated into 50 . (2.4 mm, female).

Data In 1 and Data In 2 Single-ended, half-rate data inputs from the M8041A module (3.5 mm, female).

Ω

Component Description

Data In and /Data In Differential or single-ended, full-rate data input from the device under test. Unused input should be terminated 
into 50 . (2.4 mm, female). These ports are AC coupled.

Data Out 1 and Data Out 2 Single-ended, half-rate data outputs to the M8041A module (3.5 mm, female).

Ω

Component Description

Clk Out Half-rate Error Analyzer clock output, synchronous with analyzer sampling. 

Clk In Half-rate, Error Analyzer clock input. Allows external clocking of the Error Analyzer.
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High speed AWG with up to 65 GSa/s sample rate and 20 GHz bandwidth 
on up to 4 channels per module. The M8195A arbitrary waveform 
generator offers an output amplitude of up to 2 Vpp(diff.) and adjustable 
DC offset. Multi-channel operation with up to 16 channels per 5-slot AXIe 
chassis is supported. 

In 5 slots per 4 channels the maximum number of channels is 20. This is 
valid for channels which are not synchronized across module boundaries. 
When adding an AWG synch module which also occupies a single slot, the 
AWG modules can be used synchronously in the future but then only 
4 modules can be inserted into the frame. But for the non-synchronous 
startup, 5 modules can be put into a single frame resulting in 20 channels.

Details of M8195A module can be found at 
www.keysight.com/find/m8195a.
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Host Computer

A host computer is used to:

• host all the software components of the instrument modules needed to 
control, configure, and use the modules.

• communicate with the ESM of the M9505A AXIe Chassis to allow you to 
monitor and control the chassis.

A host computer can be:

• the M9536A AXIe Embedded Controller module.

• a laptop with a USB port or with PCIe port.

• a desktop PC with a USB port or x8 or wider PCIe slot for the cabled 
PCIe adapter card.

Keysight M9536A AXIe Embedded Controller Module

The M9536A AXIe Embedded Controller is a one slot module that you can 
install in the M9505A AXIe Chassis like any other instrument module. This 
module acts as a host computer when installed in the M9505A AXIe 
Chassis. It is always installed in slot 1 of the M9505A AXIe Chassis.

The following figure displays this module. 
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ESD Protection

Electrostatic discharge (ESD) can damage or destroy electronic 
components. All work on electronic assemblies should be performed at a 
static-safe work station. The following list and figure shows an example of 
a static-safe work station using two types of ESD protection. Purchase 
acceptable ESD accessories from your local supplier.

• Conductive table-mat and wrist-strap combination.

• Conductive floor-mat and heel-strap combination.

CAUTION
Electrostatic discharge (ESD) can damage the circuits of the components 
on M8020A/M8030A modules (M8041A, M8051A, M8061A and 
M8062A). Avoid applying static discharges to the front-panel 
connectors. Before connecting any coaxial cable to the connectors, 
momentarily short the center and outer conductors of the cable together. 
Avoid touching the front-panel connectors without first touching the 
frame of the instrument. Be sure the instrument and all connected 
devices (DUT, etc.) are properly earth-grounded (to a common ground) to 
prevent buildup of static charge and electrical over-stress. Take 
necessary anti-static precautions, such as wearing a grounded wrist 
strap, to minimize the possibility of electrostatic damage.
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 Both types, when used together, provide a significant level of ESD 
protection. Of the two, only the table-mat and wrist-strap combination 
provides adequate ESD protection when used alone. To ensure user safety, 
the static-safe accessories must provide at least 1 MW of isolation from 
ground. 

WARNING
These techniques for a static-safe work station should not be used when 
working on circuitry with a voltage potential greater than 500 volts. 
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Discharging Cables

Loose cables are like a capacitor and can hold electrostatic charges. The 
free end of a cable touching surfaces that have voltage levels will cause 
product damage. Before connecting any cable to product connector, short 
the center and outer conductors of the cable together to ground 
momentarily.

You should use the cable discharger provided with the initial product 
shipment and shown in the following figures.
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While discharging a cable, make sure to ground the box appropriately, via 
the “GND” connector of the box, to the ground connector of the AXIe 
chassis as shown in the figure.

That is either directly using the accessories provided with the discharger 
like the grounding cable, or via an ESD mat, which is connected to the 
ground connector of the AXIe chassis.

Discharge your cables using the matching connector e.g. 2.40 mm (also 
for 1.85 mm), 3.50 mm (also for 2.92 mm) and Mini-Coax. You may stick 
the cable discharger box to your instrument/AXIe chassis e.g. using the 
fastener tape provided.

Fixture made of plastic can store charges, and probing powered devices 
can subject inputs to damaging voltage and power levels. Poor AC power 
supply connected to product or DUT may create AC transients, insufficient 
grounding, floating neutral lines which cause damaging currents to flow 
into or out of the instrument.

For more information about electrostatic discharge, contact the 
Electrostatic Discharge Association www.esda.org.
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M8020A Module Setup

M8020A being a modular product includes different sets of modules which 
are hosted in an AXI chassis. It comprises of exactly one M8041A 
generator-analyzer-clock module and optionally one additional M8051A 
generator-analyzer module. The M8041A generator-analyzer-clock 
module is a true superset of the M8051A generator-analyzer module.

Setting up a Single Channel System

The single channel system is the smallest configuration consisting of one 
M8041A generator-analyzer-clock module within a 5-slot frame. You can 
upgrade it to a 2 channel system by adding the two channel options 
(second channel generator and second channel analyzer).

Setting up a Multi-Channel System

The multi-channel system is comprised of exactly one clock / data module 
and one or more data channels mounted in an AXIe frame.

The multi-channel system can be:

2-Channel System 

A two-channel system consists of one clock/data module.

The following figure illustrates a two-channel system.
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4-Channel System 

A four-channel system consists of one clock module and one data 
modules.

The following figure illustrates a four-channel system.

For more details on how to establish connections between the M8020A 
modules, refer to the M8020A/M8030A Installation Guide.



58 Keysight M8070A User Guide

2 Know Your Hardware
 

M8030A Module Setup

The M8030A is a modular test solution which can be tailored to your 
specific needs from two channels with one M8041A to up to 10 channels. 
The modules must be installed in the M9514A AXIe 14-slot chassis as 
described in Table 34 on page -58:

Table 34  M8030A Modules Configuration

Slot Number Module

# 1 M8030A-BU1 AXIe embedded controller. 

# 2, 3 & 4 M8041A module

# 5 & 6 M8051A module

# 7 M9521A AXIe system module

# 8 & 9 M8051A module

# 10 & 11 M8051A module

# 12 & 13 M8051A module

# 14 M8192A multi-channel synchronization module
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M8030A Modules Arrangement Example

The following figure shows the M8030A modules arrangement in the 
M9514A AXIe 14-slot chassis:
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Accessories

Default Accessories

The M8020A/M8030A modules comes with the following default 
accessories:

Table 35  M8020A/M8030A Default Accessories

M8041A module Eight 50  terminations, commercial calibration report ("UK6"), 
certificate of calibration, ESD protection kit.

M8051A module Four 50  terminations, clock synchronization cable, commercial 
calibration report ("UK6"), certificate of calibration

M8061A module See M8061A data sheet. 

M8062A module Two 50  terminations, two individual semi-rigid cables, one set of 
three phase matched semi-rigid cables, clock synchronization cable, 
commercial calibration report ("UK6"), certificate of calibration.

M8020A-BU1 M9505A AXIe chassis with embedded controller, USB cable, getting 
started guide, AXIe filler panel, power cord

M8020A-BU2 M9505A AXIe chassis, USB cable, getting started guide, AXIe filler 
panel, power cord

M8030A-BU1 M9514A AXIe chassis with embedded controller, USB cable, getting
started guide, AXIe filler panel, power cord

M8030A-BU2 M9514A AXIe chassis, USB cable, getting started guide, AXIe filler
panel, power cord

M8070A CD-ROM with M8070A system software

Ω

Ω

Ω
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Recommended Accessories

The following are the recommended accessories for M8020A/M8030A 
modules.

Table 36  Recommended Accessories

Matched cable pair, 2.92 mm (m) to 2.92 mm (m), 0.85 m 
(recommended for each data output of M8041A/51A. This 2.92 mm cable is 
compatible with 3.5 mm front panel connectors of M8041A/51A.)

M8041A-801

Bandpass filter 11.4 to 15.6 GHz, SMA 
(for use with M8061A in clock path to minimize intrinsic RJ of M8061A
for data rate of 25.78 Gb/s)

M8061A-802

Bandpass filter 11.1 to 17.5 GHz, SMA 
(for use with M8061A in clock path to minimize intrinsic RJ of M8061A
for data rates from 25.0 to 32.0 Gb/s)

M8061A-803

Cable kit for connecting M8061A with M8020A, 3x 3.5 mm, 0.6 m M8061A-804

Matched cable pair, 2.4 mm (m) to 2.4 mm (m), 0.85 m
(recommended for full-rate data output and input of the M8062A)

N4910A

DC block, 26 GHz, 3.5 mm N9398C

ISI channels, four short traces M8048A-001

ISI channels, four long traces M8048A-002

Short matched cable pair, SMA (m) to SMA (m) for cascading M8048A ISI 
channels

Four SMA cables, unmatched 15442A

Rack-mount kit for AXIe 5-slot chassis M9505A Y1226A
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General Characteristics

The general characteristics of the modules included in M8020A/M8030A 
system are listed in Table 37 on page -62.

Table 37  General Characteristics

For general characteristics of M8195A, refer to data sheet. Visit the 
web-page www.keysight.com/find/m8195a.

  Instrument Models

M8041A M8051A M8061A / M8062A

Operating temperature 5 °C to 40 °C (41 °F to 104 °F)

Storage temperature -40 ºC to +70 ºC (modules) (-40 °F to + 158 °F)

Operating humidity 15% to 95% relative humidity at 40ºC 
(non-condensing)

15% to 95% relative 
humidity at 35ºC 
(non-condensing)

Storage humidity 24% to 90% relative humidity at 65ºC (non-condensing)

Power requirements 350 W 250 W 90 VA

Warm-up time 30 minutes

Cooling requirements Slot airflow direction is from right to left. When operating the 
M8041A/51A/61/62A choose a location that provides at least 80 mm 
of clearance at rear, and at least 50 mm (2 “) of clearance at each 
side. See also start-up guide for M9502A chassis.

Recommended 
recalibration period

1 year

Warranty period 3 years return to Keysight
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Overview

The M8070A system software for the M8000 Series of BER Test Solutions 
is required to control M8020A/M8030A modules (M8041A, M8051A, 
M8061A, M8062A and M8195A Revision 1). It provides a user-friendly 
experience that can be used with standard or touchscreen enabled 
computers. It is fully supported by the Microsoft Windows 7 (64 bit) SP1, 
Windows 8 (64 bit) and Windows 8.1 (64 bit) operating system. The 
M8070A software also supports an off-line version, that does not require 
any license to operate.

The M8070A user interface provides an interactive graphical display in 
multiple windows containing controls, that enable you to perform the 
tasks. The GUI components include menus, tool bars, dialog boxes, toggle 
buttons, standard windows buttons, drop-down lists, sliders, and many 
more which are further discussed in this manual.

NOTE
Depending upon the M8020A/M8030A bundle with of chassis/controller 
pre-installation, you may have to install the M8070A software. Refer to 
M8020A and M8030A Installation Guide and follow the given 
instructions to install the M8070A software.
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Launching M8070A User Interface

To launch the M8070A user interface, go to Start menu and then click 
All Programs > Keysight M8070A > Keysight M8070A. 

The splash screen will be displayed as shown in the following figure:

Load Setting

Before the M8070A software is launched, a Load Setting dialog will appear 
which allows you to load settings.
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The Load Setting dialog provides the following settings:

• Last Used: Launches the M8070A user interface with the last used 
settings.

• Factory Preset: Launches the M8070A user interface with factory 
default settings. 

• Select...: Opens the Recall Instrument State dialog which allows you 
to load the M8070A user interface with the stored settings. For details, 
refer to Recall Instrument State on page 103.

• Exit Application: Terminates the M8070A application.

Once the settings are loaded, the M8070A software launches. The 
following figure shows the M8070A user interface when there is only one 
module connected to the M8020A/M8030A system.

NOTE
The Load Setting dialog will appear each time the M8070A software is 
launched.

NOTE
A warning message will appear on the top of Load Setting dialog if the 
modules are offline. In this case, the results are simulated.
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However, if there are two modules connected to the M8020A/M8030A 
system, the M8070A user interface will appear as shown in the following 
figure:
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You can get the module information that is connected to

the M8020A/M8030A by clicking the  icon present at the right side of 
each module. If properly connected, the module information will be shown 
as depicted in the following figure:

It provides the following information about the module:

• Address - Address of module, e.g. USB-PXIO::11::0::INSTR

• Product Number - Product no. of the module, e.g. M8041A
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• Serial Number - Serial no. of the module, e.g. DE53C00061

• Hard ware Revision - Hardware revision of module, e.g. 0

However, if you unable to get the module information, we suggest you to 
restart the M8070A software.

In the off-line mode, the  icon will appear in the M8070A GUI.
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Exploring M8070A User Interface

The M8070A user interface consists of the following GUI elements:

• Title Bar

• Menu Bar

• Main Window

• Status Bar

The detailed information on these GUI elements are described in the 
following sections.

Title Bar

The title bar contains an application icon, title, a context-sensitive help 
icon and standard buttons to minimize, maximize or to close the window.

The  context-sensitive help icon provides information about the 
M8070A user interface relative to the task a user performs.

The title bar is shown in the following figure.

Menu Bar

The menu bar consists of various drop-down menus which provide access 
to different functions, and launch interactive GUI controls.

The menu bar includes the following drop-down menus: 

• File 

• Application

• System

• Clock

• Generator

• Analyzer

• Patterns
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• Measurements

• Utilities

• Window 

• Help 

• Increase/Decrease Splitter Size

Each drop-down menu and their options are described in the following 
sections.

File Menu

The File menu provides the following selection: 

• Preset Instrument State... - Opens the Preset Instrument State dialog.

This dialog allows you to:

• Soft Preset - For a Soft Preset, select the check box and then click 
Preset button. This option resets the instrument state to factory 
default settings. However, it retains current symbol width, opened 
windows and data stored in current setting such as patterns, 
templates and scripts.

• Preset - Resets the parameters to their default values. 
You can also perform a soft preset/preset to the instrument by 
sending *RST command in the SCPI panel. For details on *RST 
command, refer to M8070A Programming Guide.

• Recall Instrument State... - Opens the Recall Instrument State dialog 
which allows you to retrieve the user-defined settings or the factory 
settings.
For more details, refer to Recall Instrument State on page 103.
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• Save Instrument State... - Opens the Save Instrument State dialog 
which allows you to save the current instrument state.
For more details, refer to Save Instrument State on page 104.

• Exit - Closes the M8070A user interface.

Application Menu

The Application menu allows you to select application specific features for 
the following:

• PCI Express

• USB

• SATA

• C-PHY (Included in separately available MIPI plug-in)

• D-PHY (Included in separately available MIPI plug-in)

On selecting any of these standards from the Application menu, a 
standard specific dialog or plug-in interface will appear. 

System Menu

The System menu allows you to launch the various display views provided 
by M8020A/M8030A. It provides the following selections:

• Module View - Opens the Module View user interface as shown in the 
following figure:
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The Module View is a graphical representation of the input/output 
ports that are present on the front panel of the modules, connected to 
the M8020A/M8030A. You can use the Module View to configure the 
properties of a single port or a group (combination of multiple ports). 
For details, refer to Module View on page 107.

• System View - Opens the System View user interface as shown in the 
following figure:

The System View displays the block representation of the currently 
selected channel of the M8020A/M8030A. In addition, it also allows 
you to interactively modify the configuration settings for each channel. 
For details, refer to System View on page 119.
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• Groups View - Opens the Group View user interface as shown in the 
following figure:

The Group View allows you to create a group of ports and re-program 
their properties. For details, refer to Group View on page 136.

• Ctrl In/ Ctrl Out - Opens the Module View with the Ctrl In/Ctrl Out 
ports selected and the corresponding parameters are reflected in the 
Properties window.

• Sys In/Out A/B - Opens the Module View with the Sys In/Out ports 
selected and the corresponding parameters are reflected in the 
properties window.

Clock Menu

The Clock menu provides the following selections: 

• Clock Generator - Allows you to configure Clk Gen port. 

• Clock Output - Allows you to configure Clk Out port.

Once you make a selection, the Module View appears with the Clk 
Gen/Clk Out ports selected and the corresponding parameters are 
reflected in the Properties window. 
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The following figure shows the Module View with the Clk Gen port 
selected:

The generator's output ports are used to supply a clock signal and trigger 
for another device (for example, analyzer), and an arbitrary data signal for 
testing your device. For details, refer to Setting up Generator on page 157.

To change bit rate, go to the Properties window and then click on the 
Synthesizer function block. 

Generator Menu

The Generator menu provides the following selections: 

• Data Output - Allows you to configure Data Out port. 

• Trigger Out - Allows you to configure Trig Out port. 

Once you make a selection, the Module View shows the Data Out/Trig 
Out ports selected and the corresponding parameters are reflected in the 
Properties window. 
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The following figure shows the Module View with the Data Out port 
selected:

The generator's ports are used to set the clock frequency and the output 
signal with respect to jitter, error insertion and signal output. For details, 
refer to Setting up Generator on page 157.

To change amplitude/offset, go to Properties window and then click the 
Amplifier function block.

Analyzer Menu

The Analyzer menu provides the following selections: 

• Data Input - Allows you to configure Data In port. 

Once you make a selection, the Module View shows the Data In ports 
selected and the corresponding parameters are reflected in the Properties 
window. 
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The following figure shows the Module View with the Data In port 
selected:

The analyzer’s ports are used for running tests and for connecting external 
equipment. For details, refer to Setting up Analyzer on page 197.

Patterns Menu

The Patterns menu provides the following selections: 

• Select Pattern... - Opens the Select Sequence Pattern dialog. It allows 
you to override all sequences with a single block loop. For details refer 
to Pattern Editor on page 250.

• Pattern Editor - Opens the Pattern Editor user interface as shown in 
the following figure:
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The pattern editor provides an interactive user-interface for creating, 
editing and importing patterns. For details, refer to Pattern Editor on 
page 250.

• Sequence Editor - Opens the Sequence Editor user interface as shown 
in the following figure:
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The Sequence Editor allows you to create and maintain sequences. In 
addition to this, it also allows you to edit the memory patterns. For details, 
refer to Sequence Editor on page 227.

Measurements Menu

The Measurements menu provides the following selections:

• Error Ratio - Opens the Error Ratio measurement user interface as 
shown in the following figure:

The error ratio measurement allows you to collect measurement data 
over a specific period. This can be used to create test scenarios that 
are reproducible and comparable. Also, you can let tests run over long 
times and then evaluate the results afterwards. For details, refer to 
Error Ratio Measurement on page 301.

• Output Timing - Opens the Output Timing measurement user interface 
as shown in the following figure:
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The output timing measurement is used to measure the timing and jitter 
behavior for a device under test (DUT). It uses a bit error rate (BER) 
measurement to evaluate the shape of the eye for the output signal of the 
DUT. It also analyzes the jitter, separates the random jitter and 
deterministic jitter components, and estimates the total jitter. For details, 
refer to Output Timing Measurement on page 309.

• Output Level - Opens the Output Level measurement user interface as 
shown in the following figure
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The Output Levels measurement allows you to characterize the 
behavior of the output levels of a device under test (DUT). The 
sampling delay is fixed. The analyzer's decision threshold is 
automatically swept within a user-defined range.

For details, refer to Output Level Measurement on page 325.

• Jitter Tolerance - Opens the Jitter Tolerance measurement user 
interface as shown in the following figure:
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Jitter Tolerance measurement is used to determine the ability of a 
device or system to maintain communication quality in the presence of 
jitter. It comes in two varieties:

• Jitter Tolerance Characterization determines the jitter levels where 
the device under test can no longer maintain a desired bit error ratio 
(BER).

• Jitter Tolerance Compliance verifies that the device under test is 
able to maintain a BER level at pre-defined jitter levels and jitter 
frequencies, as defined by a standard.

For details, refer to Jitter Tolerance Measurement on page 338.

• Eye Diagram Measurement - Opens the Eye Diagram measurement 
user interface as shown in the following figure:
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 The M8070A System Software provides quick design analysis with the 
Eye Diagram capability. The Eye Diagram allows a quick check for the 
DUT’s signal output, and determines the signal quality. The eye 
contour lines display the measured eye at a deeper BER level, for 
accurate results. 

For details, refer to Eye Diagram Measurement on page 355.

Utilities Menu

The Utilities menu provides the following selections:

• Script Editor - Opens the Script Editor user interface as shown in the 
following figure:
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The Script Ed itor provides flexibility to the programmers to automate 
their plug-ins thus allowing them to do everything they want in the 
measurements. For details, refer to Script Editor on page 367.

• SCPI Editor - Opens the SCPI Ed itor user interface as shown in the 
following figure:
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• The SCPI Editor lists all SCPIs that can be used to program 
M8020A/M8030A and also provides a platform to execute them. For 
details, refer to SCPI Editor on page 411.

• Self Test - Opens the Self Test utility user interface as shown in the 
following figure:

The Self Test utility checks the specific system information of the 
hardware components for basic functionality. On execution, the 
following results are displayed:

• System related information such as connected modules, serial no. 
and hardware revision.

• Module related information such as calibration, power supplies and 
memory controller.

For details, refer to Self Test Utility on page 416.

• Licenses... - Opens the Licenses window user interface as shown in the 
following figure:
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The Licenses window displays the license information currently 
installed in the modules or host. For details, refer to Licenses Window 
on page 421.

• Settings... - Opens the Settings window which allows you to set the 
display and channel settings in the user interface. For details, refer to 
Settings Window on page 422.

• Logger - The Logger window displays errors, warnings and information 
messages along with their respective descriptions, applications from 
where they are generated and their time stamps. For details, refer to 
Logger Window on page 424.

• Plug-in Manager - The Plug-in Manager simplifies all the tasks related 
to plug-in management. It displays list of plug-ins that are installed in 
the software. In addition, the Plug-in Manager also allows you to 
install, uninstall and update the plug-ins. For details, refer to Plug-in 
Manager on page 426.
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Window Menu

The Window menu allows you to change the layout/arrangement of 
various open windows. It includes the following selections:

• Cascade - Arranges the multiple opened windows in a docked view so 
that you can see all or part of each window; consisting of individual 
tabs for each window.

The following figure shows the docked/tabbed view of three different 
windows.

• Tile Horizontally - Aligns the multiple opened windows in a horizontal 
sequence. The following figure shows the horizontal sequence of three 
different windows.
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• Tile Vertically - Aligns open windows in a vertical sequence. The 
following figure shows the vertical sequence of three different windows.
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 • Focus Center Content - Minimizes or hides additional dialog boxes or 
property sheets of the multiple open windows to focus on the center 
content. 

• Close All - Closes all the open windows. 

Help Menu

The Help menu includes the following selections:

• View Help - Opens the online help that provides you with the 
information you need for working with the Keysight M8070A GUI.

• About - Shows product information of M8070A including version 
number, build date, build info and web links for M8070A information 
and support. 
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Increase/Decrease Splitter Size

The  Splitter option allows you to either increase or decrease the 
divided space between the windows forms used in the user interface. This 
icon is located on the right side of the menu bar. The splitter functionality 
provides an easy navigation to the users who are using a touchscreen 
interface.

Main Window

The main window refers to the middle area of the M8070A user interface 
that allows you to launch different display views (e.g. Module View, Group 
View, System View, etc.). You can use the menu bar to launch these views 
on the main window. Each view can be configured through the Parameters 
window. The detailed description of different views, their parameter 
settings, controls and dialogs are described in the subsequent sections in 
this manual.

When you launch the M8070A software, by default, it shows the Module 
View on the main window. 

The following figure shows how the main window appears:
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Status Bar

The status bar is located at the bottom of the M8070A user interface. The 
status bar is shown in the following figure:

It provides the following functions:

• Toggle icon to open/close the Status Ind icator window. For details, 
refer to Status Indicators Window on page 92.

• Toggle icon to open/close the Logger window that displays errors, 
warnings and information messages which are generated from the 
M8020A/M8030A system. For details, refer to Logger Window on 
page 93.

• Toggle icon to open/close the Show Link Training Log window. For 
details, refer to Link Training Log Window on page 94.

• Error indicators for the current GUI state and clock loss. When the 
current GUI is stopped or there is any clock loss, the respective 
indicator turns red.

• Toggle buttons to enable/disable the Output, Jitter and SSC state. 
Once these features are enabled, the buttons turn green. 
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• Progress Ind icator to visualize the progression of multiple GUI 
operations and/or background operations in a single bar. However, if 
the process takes too long to complete, you have an option to 
terminate that process by clicking on the Abort button which appears 
on the Status Bar. 

• Insert Error button to insert a single bit error on each Data Out location 
of the connected modules.

• Preset All button opens the Preset Instrument dialog that allows to 
reset the instrument state to factory default settings. 

Status Indicators Window

The Status Indicators window displays the status indicators for the 
generator and analyzer ports of each channel of the connected modules. 
This includes:

• Setup information such as Bit Rate for each channel of the connected 
module.

• Generator port information such as:

• Data information that shows the name/type of the pattern 
downloaded to that data block and its indicator shows which data 
block is currently transmitting the sequence. 

• State information of generator such as Output, Jitter and SSC 
(indicated by green LED).

• Analyzer port information such as:

NOTE
The behavior of progress indicator depends upon the number of process 
involved in any operation. It displays progress of each individual process 
in a single bar. Time for each operation may vary and sometimes may be 
very quick. Therefore, at some instance, it may display a progress to be 
complete (100%) and then suddenly switch to incomplete (50%).

WARNING
You will see a warning sign on the status bar if the “Global Output State” 
is off. In this case, all data outputs will be disabled until the “Global 
Output State” is turned on. Click the “Output” button present on the 
status bar to turn on the “Global Output State”.
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• Data information that shows the name/type of the pattern 
downloaded to that data block and its indicator shows which data 
block is currently transmitted the sequence.

• State information of analyzer such as BRM (indicated by green LED).

• Error indicators of analyzer such as CDR Unlock, Data Loss, Symbol 
Loss and Sync Loss (indicated by red LED).

• Calculated BER

• Alignment BER Threshold  button to start BER threshold 
auto alignment.

The Status Indicator window always appears whenever you launch the 
M8070A user interface. However, you can open/close this window by 
clicking on the  Status Indicator icon, present on the status bar. 

Logger Window

The Logger window displays errors and warnings messages along with 
their respective descriptions, applications from where they are generated 
and their time stamps. 

The Logger window always appears whenever you launch the M8070A 
user interface. However, you can open/close this window by clicking on 
the  Logger icon, present on the status bar. 
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The Logger window allows you to: 

• Message Selection - Use this option to choose whether you want to 
view errors, warnings or information message. 

• Copy - Use this option to copy a message. You need to select a 
message in order to enable copy feature.

• Select All - Use this option to select all messages. It also enables 
copying all messages.

• Clear Messages - Use this option to delete all messages. 

• Auto Scroll - Use this option to enable/disable auto scroll option. 
When the Auto Scroll option is enabled, it will automatically scroll you 
to the new message without using the scroll bar. 

• Open On Message - Turn this button OFF if you don’t want the Logger 
window to automatically pop-up whenever a message is received. 

• Search Messages - Use this option to search messages by providing an 
input in the Search Messages search box.

Link Training Log Window

The Link Training Log window displays the logs for link training PCIe 3.0. 

You can open/close the Link Training Log window by clicking on the Link 
Training Log icon present in the status bar. The Link Training Log  
icon with orange background indicates an update or new entry in the link 
training log.

The following figure shows the Link Training Log window:
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The Link Training Log window provides the following options:

• Export Log - Click the  Export Log icon to save the link training log.

• Clear Logs - Click the  Clear Logs icon to delete all link training logs.

For more details on link training, refer to Interactive Link Training on 
page 285.
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Other GUI Features

Following are the GUI elements that make the M8070A user interface 
interactive.

Tooltip

The tooltip is a small pop-up window that concisely describes the object 
being pointed to, such as descriptions of toolbar controls, icons, graphics, 
links, menu items and taskbar buttons. 

The following example shows the tooltip providing a description of toolbar 
buttons.

Here is another example where the tooltip provides information to the user 
on the minimum and maximum values the parameter can hold.

Toggle Button

The toggle button allows you to toggle between the two features. For 
example, in the following figure, we are using the toggle button to either 
expand or collapse the parameter list.
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ON/OFF Switch

The ON/OFF switch enables or disables a given feature.

The following figure shows how a ON/OFF switch is used to turn the state 
feature ON.

However, at some instances in the GUI, the ON/OFF switch will be enabled 
when you select the corresponding check box.

Execute Button

The Execute button allows you to perform an activity, once you click on it. 

The following figure shows an Execute button that is used to perform 
pattern synchronization. 

Drop-Down List

The drop-down list allows you to choose either one or sometimes multiple 
selections from the provided list.

The following shows the drop-down list to choose the Re-Sync mode.



98 Keysight M8070A User Guide

3 Quick Tour with M8070A User Interface
 

Numeric Entries

Most numeric entries have a pre-defined maximum, minimum, and default 
value displayed in their corresponding pop-up menu.

Numeric values in numeric entries can be changed using the on-screen 
numeric keypad. For details, refer On-Screen Numeric Keypad on 
page 100.

Window Option

The window options allow you to float or dock anywhere in the application 
window. It provides quick access to logically grouped features from one 
location. For example, you can select and generate various layouts from 
the single window.

You can move a window anywhere on the screen or to a different monitor. 
You can also use the auto-hide feature of the windows to show or hide 
them on the desktop. You can also close the floating windows.

Auto Hide Feature

The automatic hiding functionality gives you the ability to imitate the 
behavior of the dock windows in the M8070A user interface. When it's 
enabled for a dock panel, this panel is automatically hidden when the 
mouse pointer leaves its area. Dock panels are hidden at the nearest 
form's edge. For example, if a panel is docked to the right edge of the 
form, it will be hidden at the right edge.

End-users can enable the automatic hiding functionality by clicking the 
auto hide button displayed within the panel's caption.
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The image below illustrates how the automatic hiding functionality can be 
enabled and how to show the hidden dock panel.

Copying Parameter Window

The copying feature creates a replica of parameters window to enhance 
the usability. It allows you to work on two different instances of the 
application. The changes you make in one window display immediately in 
the other window. 

The following figure shows the copied parameters window. 
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Once copied and then enabling the auto hide feature, the cloned 
parameters window is docked to the right edge of the main user interface. 
The copied parameters window pops up once you click on it.

The following figure shows the copied parameters window docked to the 
right edge of the main user interface.

On-Screen Numeric Keypad

The on-screen numeric keypad makes it easier to enter the numbers, units, 
etc., specially if you are using a touchscreen monitor. The on-screen 
numeric keypad pops up whenever you tap mouse pointer or touch (in 
case of touchscreen) in a text field or other area where user inputs are 
required.

The following screen shows how to use an on-screen numeric keypad to 
provide a value to a parameter.

The on-screen numeric keypad contains the following buttons:

NOTE
Remember to unselect the Disable Keypad option in the Settings 
window in order to enable the on-screen numeric keypad. For details, 
refer to Settings Window on page 422.
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Table 38  On-screen numeric keypad

Button Name Description

Number 
Buttons

Press these buttons to enter a numeric value. The 
acceptable range of a parameter is shown at the top 
of the keypad. 

Decimal 
Button

Press this button to enter a decimal numeric value.

Function 
Button

Press this button to toggle between the addition (+) 
and subtraction (-) function.

UP/DOWN 
Button

Press these buttons to increase or decrease the 
numeric values, respectively. 

Backspace 
Button

Press this button to delete any character before the 
current position of the pointer.
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LEFT/RIGH
T Button

Press these buttons to move the pointer one 
position left or right, respectively.

Exponent 
Button

Press this button to enter exponents. 

Enter 
Button

Press this button to apply the value.

Units 
Button

Press this button to assign units to the numeric 
value. Please note that the units may change 
depending on the parameter.

Clear Field 
Button

Press this button to clear the text field.

Minimum/
Default/
Maximum 
Button

Press this button to insert either minimum, or 
default, or maximum numeric value of the 
parameter.

Button Name Description
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Recall/Save Instrument State

Recall Instrument State

To recall an instrument state, do the following:

• Go to File menu and then click Recall Instrument State.... The Recall 
Instrument State dialog will appear as shown in the following figure.

1 Select the folder (User or Factory) to view the files. 

2 Select the file which is to be recalled.

3 Click Recall. 

4 To rename a file, select the file and click Rename. The filename will 
become editable.

5 To delete a file, select the file and click Delete.

6 To add new folder, select location you want to create your folder and 
then click New Folder. 

7 To rename a folder, select the folder and click Rename. The folder 
name will become editable.

8 To delete a folder, select the folder and click Delete.
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Save Instrument State

To save an instrument state, do the following:

1 Go to File menu and then click Save Instrument State.... The Save 
Instrument State dialog will appear as shown in the following figure.

2 Enter a file name and click Save. The current settings will be saved 
under the filename.

3 To rename a file, select the file and click Rename. The filename will 
become editable.

4 To delete a file, select the file and click Delete.

5 To add new folder, select location you want to create your folder and 
then click New Folder. 

6 To rename a folder, select the folder and click Rename. The folder 
name will become editable.

7 To delete a folder, select the folder and click Delete.
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Overview

The M8070A system software provides the following types of views:

• Module View

• System View

• Group View

• Adjustable Intersymbol Interference

• Controlling M8195A AWG from M8070A User Interface for Generating 
PAM-4 Signals
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Module View

The Module View is a graphical representation of the input/output ports 
that are present on the front panel of the modules, configured into the 
M8020A/M8030A. The M8020A/M8030A supports the M8041A (8.5/16G 
Generator, Analyzer, Clock Module), M8051A (Generator-Analyzer), 
M8061A (32 Gb/s Multiplexer with De-emphasis) and M8062A modules 
that are installed into an Keysight M9505A 5-slot AXIe chassis. These 
modules have a different set of input/output ports depending upon their 
functionality e.g. generator, analyzer or clock. Each module consists of two 
channels (channel 1 and channel 2) depending upon the licenses, you 
have ordered. Each channel contains Data Out (Generator) and Data In 
(Analyzer) ports.

The modules are identified as M1, M2, M3 so on in the GUI. 

You can use the Module View to configure the properties of a single port 
or a group (combination of multiple ports). For details, refer to System 
View on page 119.

How to Launch Module View

The Module View is launched by-default whenever you launch the 
M8070A user interface. However, if it is not available or is closed, you still 
can launch it. 
To do so:

• Go to the Menu Bar > System and then select Module View.

The following figure shows an example of Module View when M8041A 
(M1) and M8051A (M2) modules are connected: 
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The left side shows the connected modules and the right side shows the 
Parameters window. Each module has input and output ports which can 
be configured through the Parameters window. For details on inputs and 
output ports, refer to Input and Output Ports on page 109. When you click 
on the port, the respective configurable parameters are displayed in the 
Parameters window. For details, refer to Parameters Window on 
page 115.

The following figure shows an example of Module View when M8041A 
(M1), M8051A (M2) and M8061A(M3) modules are connected:
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Input and Output Ports

M8041A and M8051A Modules

The M8041A (8.5/16G Generator, Analyzer, Clock Module) and M8051A 
(Generator-Analyzer) modules can have the following input and output 
ports:

• Clock Gen: Clock can be generated from the internal oscillator or an 
external source. 

• Data Out: Data Out acts as the output port for the Generator which 
may be connected to the DUT. The data outputs serve as device stimuli 
and can be set up so that they are compatible with a variety of logic 
families.

• Data In: Data In acts as the input port for the Analyzer. This port is 
connected to the data signal which is the output of the DUT. Here the 
signal received and the signal generated internally is compared for 
calculating the bit error ratio.
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• Ref Clk Out: The reference clock output is used to provide a 10 MHz or 
100 MHz reference clock to the DUT or other test equipment (SMA, 
female).

• Clock Out: The clock out port serves as frequency (bit rate) references. 
If we want to operate the external device at the system clock frequency 
then the device operating frequency can be set up using the clock out. 

• Trig Out: Trig Out serves as an output port of the Generator. It allows 
you to connect a trigger for another device which can be used to 
provide a 10 MHz or 
100 MHz reference clock to the DUT or other test equipment.

• Sys Out A/Sys Out B: System level control outputs used to signal 
events to the DUT or external instruments.

• Ctrl Out A: The module has one control output at the front panel with 
the following selectable functionality of Error Output. 

• Sys In A/Sys In B: System level control inputs used to generate 
sequencer events.

• Ctrl In A/Ctrl In B: The M8041A and M8051A modules has two control 
inputs at the front panel each with the following selectable functionality 
of Error Add Input, Output Blanking, Electrical Idle and Gating Input.

M8061A Module

The M8061A (32 Gb/s Multiplexer with De-emphasis) module has the 
following input and output ports:

• Data In - Data In acts as the input port for the Analyzer. This port is 
connected to the data signal which is the output of the DUT. Here the 
signal received and the signal generated internally is compared for 
calculating the bit error ratio.

• Data Out: Data Out acts as the output port for the Generator which 
may be connected to the DUT. The data outputs serve as device stimuli 
and can be set up so that they are compatible with a variety of logic 
families. Unused outputs must be terminated into 50 . (2.4 mm, 
female).

• Clk Gen: Clock can be generated from the internal oscillator or an 
external source. 

• Elect Idle In: This port is used to enable/disable the output signal by an 
external control signal. If the input level is above the threshold level the 
module enters electrical idle.

M8061A Configuration

The M8061A Configuration dialog provides configuration settings for 
M8061A. To open the M8061A Configuration dialog:

Ω
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• Go to Menu Bar > System and then click Module View.

• Locate the M8061A module.

• Click Configuration... button. 

The M8061A Configuration dialog will appear as shown in the 
following figure:

This dialog provides the following setting options:

• Integration Mode: Allows you to select the integration mode. The 
default mode is Standalone Mode. The other modes you can select 
are Mux Only mode, Demux Only mode and Mux and Demux mode.

• Data Module: Allows you to specify the data module to which the 
M8061A module is connected.
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• Demux Visa Resource: Allows you to provide the visa resource string 
for N4877A. This is required to connect N4877A instrument with 
M8020A.

In addition, this dialog displays the connection diagram and 
connection instructions for each mode.

• Click Apply. Depending upon the configuration settings, the ports 
which in which settings can be done do not ayou will see the 
changes in the Module View. Some ports that are used by the data 
module and M8061A modules will be disabled. For the block 
diagram representation and interactively modify the settings of the 
currently mode, switch to System View. For details, refer System 
View with M8061A Integration on page 125.

M8062A Module

The M8062A (32Gb/s Front-end for J-BERT M8020A High-Performance 
BERT) module has the following ports on its front panel:

On Pattern Generator Side

• Data In 1 and Data In 2 (Half Rate) - Single-ended, half-rate data 
inputs from the M8041A module (3.5 mm, female).

• Data Out and /Data Out - Differential or single-ended, full-rate data 
output to the device under test. Unused outputs must be terminated 
into 50 . (2.4 mm, female).

• DMI In - Differential Mode Interference input. Applies a single-ended, 
external interference source differentially to the data output (SMA, 
female).

• CMI In - Common Mode Interference input. Applies a single-ended, 
external interference source to both the normal and complement data 
output signals (SMA, female).

• Clk Out - Half-rate Pattern Generator clock output. Carries the same 
jitter as the full-rate data output.

• Clk In - Pattern Generator clock input (half-rate). Connect to clock 
output of M8041A.

• Aux Clk In - Alternate Pattern Generator clock input (half-rate). 
Typically unused.

• Electrical Idle In - This input is used to enable/disable the output 
signal by an external control signal. If the input level is above the 
threshold level the module enters electrical idle. Normal operation 
resumes when the input level is below the threshold (SMA, female).

Ω
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On Analyzer Side

• Data In and /Data In - Differential or single-ended, full-rate data input 
from the device under test. Unused input should be terminated into 
50 . (2.4 mm, female). These ports are AC coupled.

• Data Out 1 and Data Out 2 - Single-ended, half-rate data outputs to 
the M8041A module (3.5 mm, female).

• Clk Out - Half-rate Error Analyzer clock output, synchronous with 
analyzer sampling.

• Clk In - Half-rate, Error Analyzer clock input. Allows external clocking 
of the Error Analyzer.

M8062A Configuration

The M8062A Configuration dialog provides configuration settings for 
M8062A. To open the M8062A Configuration dialog:

• Go to Menu Bar > System and then click Module View.

• Locate the M8062A module.

• Click Configuration... button. 

The M8062A Configuration dialog will appear as shown in the 
following figure:

Ω
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• Click Enable. In the 32G mode, access to some M8041A user 
controls are disabled to facilitate software control of this 
configuration. For the block diagram representation and to 
interactively modify the settings of the currently 32G mode, switch 
to System View. For details, refer System View with M8062A 
Integration on page 132.

Show Module Information

You can get the module information that is connected to

the M8020A by clicking the  icon present at the right side of each 
module. The module information will be shown as depicted in the following 
figure:
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It provides the following information about the module:

• Address - Address of module, e.g. USB-PXIO::11::0::INSTR

• Product Number - Product no. of the module, e.g. M8041A

• Serial Number - Serial no. of module, e.g. DE53C00061

• Hardware Revision - Hardware revision of module, e.g. 0

Selecting Single/Multiple Ports

You can select either single or multiple ports by pressing the toggle 
button, available on the top of the main window. It provides the following 
modes selection:

 Single Selection Mode - allows you to select only one port at a time 
from the connected modules.

 Multiple Selection Mode - allows you to select multiple ports from 
the connected modules.

Parameters Window

The Parameters window displays the functional blocks of the selected 
port/port groups. Each functional block has a set of parameters. The 
Parameters window also allows you to set the parameters of the selected 
port/port groups.

The Parameters window is shown in the following figure:
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The Parameters window has the following sections:

• Tool bar

• Display Grid

• Parameters Description Pane

The Parameters window tool bar includes the following icons:

•  Expand/Collapse All Group: Click this icon to expand or collapse 
the functional blocks.

•  Show Search Option: Allows you to filter and customize your 
results by using the following options:

• By Location

• By Functional Block

• By Property

•  Copying Parameter Window: Creates a replica of Parameters 
window to enhance the usability. It allows you to work on two different 
instances of the application. The changes you make in one window 
display immediately in the other window. The  icon present on the 
copied parameter window loads all properties of the module. The 
following figure shows the copied Parameters window.



Keysight M8070A User Guide 117

User Interface - M8020A Display Views 4

 

Once copied and then enabling the auto hide feature, the copied 
parameters window is docked to the right edge of the main user 
interface. The copied parameters window pops up once you click on it.

The following figure shows the copied parameters window docked to 
the right edge of the main user interface.

• Display Grid: Displays the parameters of the selected port/port groups 
within a grid. The left column contains the parameter names; the right 
column contains the parameter values.

In addition, it also allows you to set the parameters of the selected 
port/port groups. 
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The naming convention used for the port/port group is explained with 
the help of following example:

M1.DataIn1 

Where, 

• M1 stands for Module1

• DataIn stands for DataIn port

• 1 for channel 1

The functional blocks use the different color schemes to represent 
different channels. You can set the color schemes of each channel from 
the Setting window. For details, refer to Settings Window on page 422. 

• Parameter Description Pane: Provides the description of the currently 
selected port.

Creating Groups in the Module View

The Module View allows you to create a group of available ports and 
simultaneously allows you to configure their parameters.

To create a group:

• Switch to Multiple Selection Mode by pressing  Single Selection 
Mode icon.

• From your keyboard, hold the Ctrl key and select the ports from the 
modules. You need to select at least two ports in order to create a 
group. 

• Right-click on the selected ports and click Create Group option or

alternatively you can select the ports and click  Create Group of 
Selection icon. A Create New Group dialog will appear as shown in the 
following figure:

• Provide a group name and press Create.

A new group will be created in the Group View. 
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System View

The System View displays the block diagram representation of the 
currently selected channel of the M8020A/M8030A. In addition, it also 
allows you to interactively modify the settings for each channel. 

The System View user interface is shown in the following figure.

The principal parts are represented by blocks which are connected by 
lines/arrows to show the relationship of the blocks. These blocks are 
highlighted by the blue lines around block on mouse focus and the 
corresponding parameters are displayed in the Parameters window. The 
block may contain feature elements (for example, LF Jitter contain PJ and 
rSSC). You can click on the respective button to enable the feature 
elements. Once enabled, the feature elements are highlighted in blue 
color. 
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Channels

Displays the channels that are connected to the module. You can select 
the channel on which you want to configure channel settings. You can 
assign a different color to each channel so that they are easily identified. 
For details, refer to Settings Window on page 422.

Using the Zoom Tool

The following figure shows the options provided by the zoom tool.

The zoom tools provide the following functionality:

• The  Zoom In button allows you to enlarge the block diagram to 
view more details. 

• The  Zoom Out button allows you to reduce the block diagram. 

• The Zoom Slider allows you to zoom in or zoom out the block diagram. 

The mouse wheel also provides a quick alternative to the zoom control. 
To zoom in and out using the mouse, hold down the [Ctrl] key while 
you turn the mouse wheel. Each click, up or down, increases or 
decreases the zoom factor by 25%.

• The  Fit to View button fits the width of the block diagram so that 
the user does not have to scroll the block diagram to the right or to the 
left.
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Understanding the System View

To understand the System View, let's divide it into the following sections:

Generator

The following section of the System View represents the generator 
function:

It allows you to apply settings on the Data Out port or location (data 
generator). 

It includes the following blocks:

• State - Click on the  button to enable the outputs of Data Out for 
the selected channel. Once the outputs are enabled, the button 
changes to “ON” . If you press the button again, it will turn the state 
“OFF”.

• Jitter - Use this block to enable the jitter source of High Frequency 
Jitter, Low Frequency and Sweep. For more details on jitter, refer to 
Jitter Setup on page 186.

• Intersymbol Interference - 

• Interference - Use this block to enable the interference (CMI or DMI). 
For details refer to Interference on page 184.

• Amplifier - This block represents the current value of Data Out's 
amplitude parameter. You can change the value by clicking on this 
block and modify the respective parameter in the Parameters window.

• Delay - Set the delay of the active edge of the data output.

• Data Generation - Acts as the output port for the generator which may 
be connected to the DUT. 
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Trigger

The following section of the System View represents the trigger function:

It allows you to apply settings on the Trigger Out port or location.

It includes the following blocks:

• State - Click on the  button to enable the output of Trigger Output 
for the channel. Once the output is enabled, the button changes to 
“ON” . If you press the button again, it will turn the state “OFF”.

• Amplifier - Use this block to set the parameters related to amplifier of 
the trigger output.

• Output Timing - Use this block to set the delay of the active edge of the 
trigger output.

Clock

The following section of the System View represents the clock function:
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The clock function allows you to apply settings on the Clock Out port or 
location. It includes the following blocks:

• State - Click on the  button to enable the output of Clock Source. 
Once the output is enabled, the button changes to “ON” . If you 
press the button again, it will turn the state “OFF”.

• Jitter - Use this block to enable the elements of High Frequency Jitter, 
Low Frequency. For more details on jitter, refer to Jitter Setup on 
page 186.

• Amplifier - Use this block to set the parameters related to amplifier of 
the clock output.

• Clock Divider - Use this block to set a factor on which the output signal 
will be divided.

• PLL Synthesizer - This block represents the currently selected clock 
source. You can change the clock source by clicking on this block and 
the modify the respective parameter in Parameters pane. To enable the 
SSC state jitter source, click on the  button. Once the SSC state is 
enabled, the button changes to “ON” . This is how the bit rate is set. 
For example, 5 GHz sets the bit rate to 5 Gb/s. If you press the button 
again, it will turn the state “OFF”.

Analyzer

The following section of the System View represents the analyzer function:

The Analyzer function allows you to apply settings on the Data In port or 
location (analyzer). It includes the following blocks:
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• State - Click on the  button to enable the CDR state. Once the CDR 
state is enabled, the button changes to “ON” . For more details, 
refer to CDR Setup on page 208. If you press the button again, it will 
turn the state “OFF”.

• Threshold - Use this block to set the threshold of the input comparator. 

• Input Timing - Use this block to set input timing delay.

• Data Analysis - Use this block to set input threshold and sampling point 
delay.



Keysight M8070A User Guide 125

User Interface - M8020A Display Views 4

 

System View with M8061A Integration

This section describes the block diagrams provided by the System View 
when M8061A is integrated with other modules of M8020A. 

Channels

Displays the channels that are connected to the M8020A. The following 
figure shows M1 (2 channels of M8041A), M2 (2 channels of M8051A) and 
M3 (M8061A) modules connected to the instrument. 

When you select the channel, the corresponding block diagram of that 
channel appears which allows you to interactively configure channel 
settings. You can also assign a different color to each channel so that they 
are easily identified. For details, refer to Settings Window on page 422.

Integration Modes

The System View with M8061A integration provides the following modes:

• Standalone Mode

• Mux Only Mode

• Demux Only Mode

• Mux and Demux Mode

Standalone Mode

The Standalone mode is used to set the parameters of the Data Out port 
of M8041A module and Data In and Clk Gen ports of M8061A module. 

The following figure shows the block diagram of M8041A module in 
Standalone mode:



126 Keysight M8070A User Guide

4 User Interface - M8020A Display Views
 

The following figure shows the block diagram M8061A module in 
Standalone mode:
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Mux Only Mode

The Mux Only mode is used to multiplex the signal in 2:1 ratio. In this 
mode, M8061A receives the non-inverted signal from the two Data Out 
ports of M8041A module and multiplex them in one channel in 2:1 ratio. 
Using this mode, you can set the parameters of Data Out port of M8061A 
module.

The following figure shows the connection diagram of Mux Only mode:

The following figure shows the block diagram M8041A module in Mux 
Only mode:

USB

Channel (CH) Receiver (RX)

RX latch

CDR

Channel

DUT
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The following figure shows the block diagram M8061A module in Mux 
Only mode:

Demux Only Mode

The Demux Only mode is used to de-multiplex the signal in 1:2 ratio. In 
this mode, the M8061A module provides the output to CDR module 
(N4877A) which de-multiplex the received signal in 1:2 ratio. Using this 
mode, you can set the parameters of Data Out and Data In ports of 
M8061A module.

The following figure shows the connection diagram of Demux Only mode:
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The following figure shows the block diagram M8041A module in Demux 
Only mode:

The following figure shows the block diagram M8061A module in Demux 
Only mode:
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Channel (CH) Receiver (RX)
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CDR

Channel

DUT
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The Mux and Demux mode is use to multiplex the signal in 2:1 ratio and 
again de-multiplex the signal in 1:2 ratio. Using this mode, you can set the 
parameters of Data Out and Data In ports of M8061A module. 

The M8061A expands the data rate up to 32 Gb/s and provides integrated 
and calibrated 4-tap de-emphasis (expandable to 8 taps).

The following figure shows the connection diagram of Mux and Demux 
mode:
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The following figure shows the block diagram in Mux and Demux mode:
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DUT
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System View with M8062A Integration

This section describes the block diagrams provided by the System View 
when M8062A is integrated with other modules of M8020A. 

M8062A Configuration

The following steps describe the procedure for M8062A configuration:

• Launch the M8070A software.

• If the Modules View is not already opened, go to Menu Bar > System 
and then click Module View.

• Locate the M8062A module. The following figure shows an example of

Module View when an M8062A (M2) and an M8041A (M1) are installed in 
the M8020A system:

• Click the Configuration... button present on the M8062A module.

NOTE
The M8062A module cannot be used standalone. It must be used in 
combination with an M8041A module.
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The M8062A Configuration dialog will appear as shown in the following 
figure:

• Make the connections as described in the above figure. 

• Click Enable. 

• For the block diagram representation and interactively modify the 
settings of the currently mode, switch to System View. To do so, go to 
Menu Bar > System and then click System View.

NOTE
System view for M8062A is available only when 32G mode is enabled.
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The following figure shows the System View of the M8062A module:

In the M8062A System View, the principal parts are represented by blocks 
which are connected by lines/arrows to show the relationship of the 
blocks. These blocks are highlighted by blue lines around the block on 
mouse focus. Parameters corresponding to the selected block are 
displayed in the Parameters window, on the right. The block may contain 
feature elements (for example, LF Jitter contains PJ and rSSC). You can 
click on the respective button to enable the feature elements. Once 
enabled, the feature elements are highlighted in blue color. For more 
details, refer to System View on page 119. 

In addition to the blocks that are described in the section System View on 
page 119, the M8062A System View has the following new blocks:

NOTE
In 32G mode, access to some M8041A user controls are disabled to 
facilitate software control of this configuration.
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• Clean Clk Out - Half-rate, or divided, clock output with no applied 
jitter.

• Clk In - Pattern Generator clock input (half-rate). Connect to clock 
output of M8041A.

• Clock Source - Selects the clock source (CDR, System Clock or Clock 
In) for the M8062A DataIn port (Analyzer). 

• CDR - Selecting "CDR" as the M8062A DataIn clock source enables the 
Analyzer CDR, so that incoming data is sampled using the recovered 
clock.

• Auto Re-Lock - When this feature is enabled (the default setting) the 
CDR will automatically re-lock when there is a loss of lock. When it is 
disabled, the CDR will only attempt to re-lock when manually initiated 
by clicking on the arrow next to the Auto Re-Lock On/Off button. It may 
be necessary to perform a manual re-lock after a pattern change.

• High Transition Density - For data patterns with high transition 
density, such as 1010 pattern, the CDR may have trouble gaining lock. 
Enabling the High Transition Density setting reduces the CDR's internal 
gain to allow it to better lock on patterns with high transition densities. 
It may be necessary to perform a manual CDR re-lock after a change in 
the High Transition Density setting.

• Optimize - After the CDR has gained lock, certain condition changes, 
such as increasing applied jitter levels, can cause the analyzer to begin 
to measure errors. Executing the Optimize function causes the CDR to 
perform a finer alignment adjustment, which may result in a return to 
an error-free measurement.

NOTE
When using the Analyzer CDR, it may take a longer time to lock and 
achieve BER=0 after a frequency change than with the other clock 
sources.
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Group View

The Group View allows you to:

• Add/remove ports of a group.

• Set the properties of functional block of a group. 

How to Launch Group View

The Group View is automatically launched when you create a group from 
the Module View. For details, refer to Creating Groups in the Module View 
on page 118. 
However, you also launch the Group View from the main GUI. To do so:

• Go to the Menu Bar > System and then select Group View.

The Group View will appear as shown in the following figure:

The Group View includes the following elements:

• Tool bar

• Group View
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Tool bar

The tool bar includes the following elements to perform specific functions:

Table 39  

Group View

The Group View allows you to create, edit and delete a group. In addition, 
it also allows you to set the properties of functional block of the group. 
These features are further described in the upcoming sections of this 
chapter. 

Elements Name Description

Create New 
Group

Opens the System Group Ed itor which allows you to 
create a new group. For more details, refer to 
Create New Groups in Group View on 
page 138.

Show 
Functional 
Block in Group

Use this toggle button to show functional blocks or 
locations in a group.

Show Edit 
Options

Use this toggle button to show/hide the group edit 
options.

Edit Existing 
Group

Opens the System Group Ed itor which allows you to 
edit the group. For details, refer to Edit Existing 
Group on page 140.
This icon is only visible when the group is in the edit 
mode.

Delete Group Deletes the group.
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Create New Groups in Group View

To create a group in Group View:

• Click New Group icon available on the tool bar. This will open the 
System Group Editor.

• Select the ports or locations from the left side the System Group Editor 
and the preview of selected ports or locations will appear on right side. 
See the following figure:

Provide a group name and

• Type a group name in the provided field and click Create. A new group 
will be created under that name.

Show Function Block/Location in Groups

The Group View allows you to set the group properties either through 
functional blocks or through locations in the group. 

You can click  icon to switch to show functional blocks in the group. 
See the following figure:
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The group is represented in the form of functional blocks available in the 
group. Once you click on the function block, the respective properties of 
the functional block are visible in the Parameters window. You can now set 
the properties of each functional block.

You can click  icon to switch to show locations in the group. See the 
following figure:
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The group is represented in the form of ports or locations available in the 
group. Once you click on the port or location, the respective properties of 
the port or location block are visible in the Parameters window.

The main advantage of the Group View is that it allows you to set the 
properties patterns/sequence of similar ports at once.

However, if you set the properties of the similar ports or locations that 
exists in different channels of a group, the properties of the ports or 
locations will not be applied. If you try to group the properties by clicking 
on the header of Group View, the corresponding value in the Parameters 
window will either be blank or show “?”. 
See the following figure:

In this situation, you have to specify the property’s value which will be later 
applied to both ports or locations.

Edit Existing Group

To edit an existing group;

• Click on the  Edit Existing Group icon. This will open the System 
Group Editor window.
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• Select the ports or locations from the left side of the System Group 
Editor and the preview of selected ports or locations will appear on 
right side. See the figure below:

Provide a group name and

• Click OK. The group will be edited. However, if you provide a new group 
name in the provided field and click OK, a new group will be created 
under that name. 

Delete a Group

You can also delete a group. To do so:

• Click on the  Delete Group icon. It will open a Delete Group 
message box.

• Click Delete. The group will be removed from the view.
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Adjustable Intersymbol Interference

The M8070A system software provides integrated and adjustable 
Intersymbol Interference (ISI) capability to test next-generation 
high-speed digital designs. 

The adjustable and programmable ISI function allows emulating channel 
loss for characterizing and compliance testing of high-speed digital 
receivers. This function is integrated in each pattern generator channel of 
the M8020A/M8030A which streamlines test setup by eliminating the need 
for external cabling and switching of external ISI traces.

As data rates continuously increase, channel loss between transmitter and 
receiver becomes more important. Channel loss is caused by printed 
circuit board traces, connectors, and cables in the signal path; resulting in 
ISI which depends on the channel material and dimensions, the data rate, 
and bit pattern. All high-speed digital receivers are specified to tolerate a 
certain amount of total jitter, which typically includes some ISI caused by 
channel loss. During receiver characterization and compliance test, this 
loss needs to be emulated. 

The built-in ISI functionality is programmable for each pattern generator 
channel. It simplifies receiver test automation for data rates up to 16 Gb/s. 

The new adjustable ISI option offers the following advantages:

• Streamlines receiver test setup by providing the highest level of 
integration.

• Provides accurate and repeatable results for receiver characterization 
and compliance test by supporting a wide range of loss up to 25 dB and 
16 GHz with linear loss curves and fine step resolution.

• Fits into the fully scalable and upgradeable receiver test solution with 
an upgrade option.

Using System View for ISI Configuration 

You can use the System View to configure the ISI parameters for a 
selected ‘Data Out’ location. When you select ISI in the Jitter block of the 
System View, the corresponding parameters are loaded on the 
Parameters window. You can create your own preset or manipulate 
frequency and insertion loss for the selected preset. 
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However, the System View does not provide flexibility to graphically 
manipulate the ISI parameters. This can be achieved using the Adjustable 
ISI window.

How to Launch Adjustable ISI Window:

To launch the Adjustable ISI window

• Go to the Menu Bar > System and then select Adjustable ISI.

The Adjustable ISI window will appear as shown in the following figure:
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It includes the following elements:

• Toolbar

• Adjustable ISI Graph

• ISI Parameters

Toolbar

The toolbar provides the following convenient adjustable ISI functions:

Table 40  

Elements Name Description

Open SnP File Click this button to open an s-parameters file (S2P). 
Currently, the M8070A GUI supports two port (S2P) and 
four port (S4P) s-parameters files. The s-parameters 
(also known as scattered parameters) are displayed 
when the scattered pattern file is loaded. S-parameters 
are complex matrix that show insertion loss at certain 
frequency. The two-port device displays four data points 
while the four-port device displays sixteen data points.

Channel 
Selection

Use this drop-down list for channel section for which the 
graph is plotted for the corresponding values.
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Adjustable ISI Graph

The following figure illustrates an ISI graph for 4-port system:

The ISI graph shows the insertion loss for a 2-port or 4-port system. The 
values on the graph represents insertion loss with respect to frequency. 
You can select the data points according to which you want to generate 
the loss and then manipulate points graphically (mouse drag) or by 
parameter window to draw the data point graph. Please note that if you 
manipulate the points of the linear graph to the values which are not in the 
defined limits of Slope and Offset, the pointer will change to  icon. In 
this case, the linear graph will switch to last set values. However, if you 
manipulate the points of the linear graph to the values which are not in the 
defined limits of Slope and Offset, the pointer will change to  icon. In 
this case, a message will appear at the bottom of the graph along with the 
undo option to revert the graph changes.

ISI Parameters

The ISI parameters are summarized in the following list:

• State - Enables/disables the ISI state.

• Preset - Allows you to select preset for specific applications 
representing a typical loss characteristic.
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• Mode - Controls the ISI as one point or two points. For each point you 
can specify frequency and insertion loss at that frequency. The 
calculated values are displayed in the Parameters window.

• One Point: In this mode, one point of the linear graph is fixed while 
the another point can be moved graphically to manipulate insertion 
loss/frequency values. 

• Two Points: In this mode, both points of the linear graph can be 
moved graphically to manipulate insertion loss/frequency values.

• Slope - Shows the calculated slope value (Insertion Loss/frequency, 
dB/ GHz).

• Insertion Loss Offset - Shows the Insertion Loss Offset (at frequency=
0 Hz).

Intersymbol Interference (ISI) Setup

The following steps describe the procedure for ISI setup:

1 Connect the DUT in loopback mode. For connection details, refer to 
M8020A and M8030A Getting Started Guide. 

2 From the M8070A software, launch Adjustable ISI window.

3 Select M1.DataOut1 channel from drop-down list. 

4 From the Parameters window, select the Preset from the provided list. 
It will show the linear graph.

5 Select the mode as ‘Two Points’. 

6 Manipulate insertion loss/frequency values either graphically or by 
Parameters window.

7 Alternatively, you can also open a S2P or S4P file and graphically 
manipulate loss and frequency parameters according to data points. 

8 Click the toggle button to enable the ISI state.
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Controlling M8195A AWG from M8070A User Interface for Generating PAM-4 Signals

The M8070A system software (Rev 2.5.0.0 or above) allows to control 
M8195A along with the M8020A/M8030A modules. This feature is enabled 
by license M8070A-1TP or M8070A-1NP. Once the M8195A AWG module 
is installed into an AXIe chassis, it can be accessed via the M8070A 
software. Ensure that you have latest version of M8070A (Rev 2.5.0.0 or 
above) and M8195A (Rev 1.3.1.1 or above) software installed in your 
system. 

For complete details on M8195A Arbitrary Waveform Generator, visit 
www.keysight.com/find/m8195a. 

M8195A AWG in Module View

Once the M8195A AWG integration is done, you will see a M8195A module 
entry in the Module View and Status Indicator as shown in the following 
figure:
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M8195A Memory Configuration

1 Click the Memory Configuration button. Depending upon the available 
channels in M8195A, the M8195A Memory Configuration will appear. 
The following figure shows the M8195A Memory Configuration dialog 
when four channels in M8195A are available:

2 Click on the radio button to select the memory mode. The following 
memory modes are available:

• One Channel Deep Memory: The DataOut location of one channel 
will be sourced from extended memory and the other channels will 
be sourced from module internal memory. The data range in this 
mode is 256 Mb/s ... 65 Gb/s.

• Two Channels Deep Memory: The DataOut location of two channels 
will be sourced from extended memory and the other channels will 
be sourced from module internal memory. The data range in this 
mode is 256 Mb/s ... 32.5 Gb/s.

• Four Channels Deep Memory: The DataOut location of all four 
channels will be sourced from extended memory. The data range in 
this mode is 256 Mb/s ... 16.250 Gb/s.

3 Click Enable.
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Configuring M8195A Parameters

The M8195A AWG has the Data Out and Clk Gen ports. You can use the 
Parameters window to configure these ports.

• Embedding - Sets the S-Parameter for embedding.

• Amplifier - The Amplifier function has the following components:

• Amplitude - Sets the amplitude of the output signal.

• Offset - Sets the offset voltage of output signal.

• High - Sets the high voltage of output signal.

• Low - Sets the low voltage of output signal.

• Transition Time - Sets the transition time (20%/80%) of data output 
signal.

• Output Timing - Sets the delay of the output data signal.

• HF Jitter- Enables and sets the high frequency jitter.

• De-Embedding - The De-Embedding function has the following 
components:

• Standard Cable - Defines whether the signal should be 
pre-distorted considering the properties of the standard cable set.

• S-Paramter State - Enables/Disables S-Parameter compensation.

• S-Paramter Profile - Selects the S-Parameter profile. It also allows 
you to import and export a S-Parameter profile.

• S-Paramter Output Port - Selects the output port in S-Parameter 
profile.

• S-Prameter Input Port - Selects the input port in S-Parameter 
profile.

• Clk Gen - The Clk Gen port has the following components:

• Synthesizer - Used to set data rate frequency and period. For NRZ 
line coding frequency may be set up to 32 GHz, and for PAM-4 the 
value may be set up to 16 GHz. The corresponding output for NRZ 
line coding will be up to 32 Gb/s, and for PAM-4 it will be up to 32 
Gbaud/s.

NOTE
In case the AWG module is configure with 2 or 4 deep memory channels 
the output signal will contain artefacts if not used with a transition time 
converter/low pass filter in the range of 16 GHz for 2 deep memory 
channels or 8 GHz for 4 deep memory channels.
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System View with M8195A Integration

This section describes the block diagram provided by the System View 
when M8195A module is integrated in M8070A. The System View for 
M8195A varies on the number of channels available on M8195A.

The following figure shows system view of M8195A when all four channels 
are available.

NOTE
The global Jitter button located on the M8070A status bar is presently 
inactive for M8195A as jitter injection for M8195A is not supported in the 
M8070A software version 2.5. 
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The M8195A System View shows four Data Out channels in the same 
window. The principal parts of the System View are represented by blocks 
which are connected by lines/arrows to show the relationship of the 
blocks. These blocks are highlighted by blue lines around the block on 
mouse focus. On clicking these blocks, the mostly used parameters are 
available which can be configured using the on-screen numeric keypad. 
However, parameters corresponding to the selected block are displayed in 
the Parameters window, on the right. The block may contain feature 
elements (for example, HF Jitter contains PJ1, PJ2 and RJ). You can click 
on the respective button to enable the feature elements. Once enabled, 
the feature elements are highlighted in blue color. For more details, refer 
to System View on page 119. 

Signal Generation in AWG

For detailed information about signal generation on arbitrary waveform 
generators of the M81XX class can be found in the document named 
"Fundamentals of Arbitrary Waveform Generation" which can be 
downloaded from here: www.keysight.com/find/awg-apps
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Selecting Line Coding

You can define the line coding for M8195A Data Out port through the 
Parameters window. The M8195A Data Out port supports the NRZ and 
PAM-4 line coding.

Creating Patterns in M8195A

The M8070A software provides Pattern Editor for M8195A module as well. 
The functionality of the Pattern Editor is same as for other modules. You 
can create, edit, load patterns and perform the pattern settings in the 
same way as done for other modules. For more details, refer to Pattern 
Editor on page 250.

However for bit coded patterns, the Pattern Editor allows you to view the 
symbols in the PAM-4 No Coding and PAM-4 Gray Coding. These options 
are available in the Settings > Data View Mode.

The following figure shows an example of bit symbol, viewed in the PAM-4 
Gray Coding. 

NOTE
Make sure to use the similar line coding for all Data Out ports of 
M8195A. An "Auto Correction" window will appear if you select different 
line coding for Data Out ports. Clicking on the "Allow" button, present on 
this window applies same line coding on all Data Out ports.
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In the PAM-4 No Coding mode, the bit sequence 00 maps to symbol 0, 10 
maps to symbol 2 and 11 maps to symbol 3.

In the PAM-4 Gray Coding mode, the bit sequence 00 maps to symbol 0, 
00 maps to symbol 0, 01 maps to symbol 1, 11 maps to symbol 2 and 
10 maps to symbol 3.

Sequence Settings in M8195A

The M8070A software provides Sequence Editor for M8195A module as 
well. The functionality of the Sequence Editor is same as for other 
modules. You can create, edit, load patterns and perform the sequence 
settings in the same way as done in M8070A sequence editor. You can 
change pattern type as static, clock, PRBS, memory pattern, in single 
block with infinite loop. For more details, refer to Sequence Editor on 
page 227.

However, in the M8195A Sequence Editor, PAM-4 patterns are generated 
by encoding digital pattern streams (PRBS, Memory Patterns) into PAM-4 
Symbol streams.

The following figure shows the M8195A Sequence Editor:
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You can use the Sequence Settings window to reprogram the values of 
M8195A parameters. 

Parameters that are not applicable for M8195A module will be disabled.

The M8195A Sequence Editor has the following capabilities:

• A single block can be looped infinitely

• Supports following block types:

• PRBS (all M8020A/M8030A polynomials that fit into AWG memory)

• Memory

• Static 0 or 1

• Single pulse per block

• Clock
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Jitter Setting in M8195A

The M8195A integration into the M8070A software supports sinusoidal 
jitter, random jitter and spread spectrum clocking (SSC).

Sinusoidal jitter and random jitter can be turned on and off per channel 
while SSC can only be activated per module.

Periodic Jitter (Valid for PJ1, PJ2 and SSC)

When defining a sequence referencing a specific pattern it will 
automatically be generated containing the specified jitter. For example in 
case the given pattern has a duration of 1 µs for the selected baud rate 
and the jitter period is 2 µs it would not be possible for this jitter to 
correctly appear inside the pattern. To handle this a second iteration of the 
pattern is appended giving the memory segment a total duration of 2 µs. 
With this it is possible for the resulting waveform to contain the selected 
jitter.

A side effect of this procedure is that the required sample memory for a 
selected pattern changes depending on the selected jitter components.

In case the jitter cannot be mapped to the available memory while 
adhering to the jitter accuracy defined in the data sheet a warning 
message will be displayed to make the user aware of this shortcoming.

Measuring Periodic Jitter

When measuring periodic jitter on an oscilloscope it is important to note 
that the jitter period will always be rounded in a way that the effective 
pattern length (which may contain multiple iterations of the user defined 
pattern) is a multiple of this jitter period.

Another thing to note is that for short pattern, high jitter frequency and the 
case where the data rate is an integer multiple of the jitter frequency the 
effective pattern can become maximally short. This will be observable by a 
relatively fast start of waveform playback but can have an impact on the 
measured jitter histogram.

For the above mentioned cases the number of distinct edge deviations 
from their un-jittered positions can be limited which leads to a histogram 
containing only a low number of lines. 

To tweak the quality of the jitter histogram it is possible to use a larger 
pattern e.g. by repeating the shorter pattern multiple times in the pattern 
file or using an odd number for the jitter frequency.
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Random Jitter (RJ)

The given pattern will be generated with the selected random jitter 
parameters. Definable are thereby a low pass and high pass frequency 
which limits the contained jitter components.

Measuring Periodic Jitter

As the waveform is completely pre-calculated it is not possible to generate 
truly random jitter with this approach.

Similar to the periodic jitter case it is also true for random jitter that short 
patterns will not lead to a realistic looking jitter histogram. If a better jitter 
quality is desired it is therefore necessary to use a longer pattern. In case 
the actual pattern needs to be short it is possible to have it repeat multiple 
times in the pattern file and thereby obtain different edge deviations on a 
single symbol.
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Overview

The M8020A/M8030A generator generates an output signal based on a 
data pattern. It has the following possibilities for generating an output 
signal:

• Providing a wide range of clock frequencies

You can use the generator's internal clock or an external clock for 
defining the frequency of the outgoing stream.

• Distorting the signal by adding jitter

You can connect an external delay control device (for example a 
function generator) to add jitter to the generated signal.

• Adding errors to the output stream

The M8020A/M8030A can be set up to insert errors into the outgoing 
stream either internally, according to an external signal, or manually 
(from the operator).

• Run-time switching between two patterns

You can set up two patterns and switch between them during runtime 
either automatically, according to an external signal, or manually.

• Suppressing the output stream

The output signal can be suppressed according to an external signal. 

The M8020A/M8030A generator also provides output ports that let you 
connect an external instrument, such as an oscilloscope.
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M8020A/M8030A Generator Ports

The M8020A/M8030A generator ports are used to set the generator's 
clock frequency and to define the output signal with respect to jitter, error 
insertion and signal output. In addition, the generator's output ports are 
also used to supply a clock signal and trigger (for example, analyzer), and 
an arbitrary data signal for testing your device.

The M8020A/M8030A provides a high level of integration with built-in 
clock synthesizer, de-emphasis, jitter and level interference. It allows you 
to set the parameters for the built-in generator parameters such as 
amplifier, de-emphasis, HF and LF jitter, common mode interference and 
differential mode interference.

The following figure shows the M8020A/M8030A generator’s ports.

The M8020A/M8030A generator’s ports include the following:

• Ref Clock In

The Ref Clk In input can be used as reference frequency or as external 
system frequency directly for the instrument. An external provided 
signal can be measured at that input. This input is tightly involved in the 
system frequency generation. 

• Data Out and Data Out

The differential data output serve as device stimuli and can be set up so 
that they are compatible with a variety of logic families. With respect to 
Data Out, Data Out has inverted logic.

• Clock Out and Clock Out

The differential clock output serve as frequency (bit rate) reference and 
can be set up so that they are compatible with a variety of logic 
families. With respect to Clock Out, Clock Out has inverted logic.
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• Trigger Out and Trigger Out

This port allows you to trigger another device (for example, an 
oscilloscope) and can be set up so that they are compatible with a 
variety of logic families. Trigger Out has more modes, e.g. sub rate 
clock to be used as ref clock for a DUT. With respect to Trigger Out, 
Trigger Out has inverted logic.

• Sys Out A/B

The system level control outputs used to trigger events to the DUT or 
external instruments. 

• Ctrl Out A

The control output port provides the Error Output functionality.

The complementary outputs can be used when:

• additional output capability is needed for an instrument such as an 
oscilloscope or digital communication analyzer.

• your device requires differential inputs.

Understanding the Output Protection Circuit

The M8041A and M8051A J-BERT modules offers a huge flexibility for 
external termination schemes and external termination voltages to address 
common technologies. For details, please refer to the M8020A Data Sheet.

An internal protection circuit continuously monitors the voltages of clock, 
data and trigger output. It becomes active and turns off the output(s) if the 
externally applied termination voltage does not match the respective 
setting (any longer).

NOTE
The Generator's Data Out, Clock Out, Trigger Out and ports must be 
terminated with 50  if they are not connected.Ω

NOTE
The M8020A/M8030A output port groups (Data, Clock and Trigger Out) 
have their own protection circuit. As a consequence, if an output voltage 
violation occurs at any of the output port(s), then the respective output 
port group gets disabled or stops working. The output(s) needs to be 
actively (via GUI or remotely) re-enabled after the fault condition has 
been removed.
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If an output voltage violation occurs, the output(s) is switched off, which 
means to a "high impedance" condition. When it gets switched on again 
(manually by the user) it again follows the standard enabling procedure 
with termination voltage(s) & impedance checks. 

A warning icon appears in the Status Window as shown in the following 
figure:

Understanding the Output Level Parameters

The following figure shows the parameters of a Data, Clock, or Trigger 
output signal.

As shown in this figure, the signal output levels have the following 
components:

• High voltage is the upper voltage level of the signal.

• Low voltage is the lower voltage level of the signal.

• Offset voltage is the offset of the average voltage level from 0 V.

• Amplitude of the signal.
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When adjusting the output levels, it is important to understand the 
concept of how the M8020A/M8030A handles voltages.

Changing the Amplitude

Typically, during tests, when you adjust the amplitude, you want to keep 
the offset constant. This keeps the ideal sampling point within the eye. The 
M8020A/M8030A handles this by keeping offset voltage constant when 
amplitude is changed.

Changing the Output Levels

On the other hand, you may want to adjust the output voltage level 
without changing the amplitude. The M8020A/M8030A handles this by 
keeping amplitude constant when offset voltage is changed and high/low 
voltage are accordingly adjusted.

Voltage Level Restrictions

The M8020A/M8030A cannot generate a signal that has voltage levels out 
of range. If you try to enter a value for one parameter that would put 
another parameter out of limits, the M8020A/M8030A rejects the change. 
This could happen, for example, if low voltage is already at the minimum, 
and you try to lower either of high voltage or low voltage, or increase 
amplitude.

Understanding Delay and Crossover

The M8020A/M8030A provides the possibility of modifying the output data 
signal by varying the signal's delay to the clock signal, and the signal's 
crossover.

Delay

The exact time delay through a test setup can vary. The delay function 
allows you to compensate for this by adjusting the active edge of the 
trigger output relative to the clock/data outputs. This varies the phase 
relationship of the data and clock outputs (causes the data to have a 
certain time delay after the clock pulse). The higher the delay, the greater 
the time difference between the clock signal and the data signal. The delay 
can be adjusted by the generator’s Data Out 1 and Data Out 2 ports.
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Crossover

Crossover is the voltage level where the overlapped rising and falling 
edges of the logic levels intersect. This adjustment varies the widths of the 
logic highs and lows.

The following figure shows examples of crossover at 50 %, 80 %, and 20 %:

Why Incorrect Terminations Could Damage Your Device

Choosing wrong terminations may cause your device to output voltage 
levels that are not as expected. It may also cause excessive current or 
current flow in the wrong direction, which can damage your device.

Note that an internal protection circuit becomes active if the termination 
voltage is wrongly adjusted. The protection circuit sets the output voltages 
to safe levels, typically:

Vhi = Vlo = Vterm = externally measured termination voltage.

If you adjust the termination voltage, and try to enter value(s) which are 
outside of the currently allowed window, the Auto Correction 
Confirmation message box will pop up with respective apply and discard 
options as shown in the following figure:
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AC Coupling and Bias Tees

The generator's outputs are always internally DC-coupled; even when AC 
termination is selected. For this reason, caution must be taken when 
connecting your instrument to a device or test setup.

The diagram below shows a device that is AC coupled. Note that the 
capacitor is part of the test setup.

You can use an external bias to power your device. You must ensure, 
however, that the network is oriented correctly. If it is not, your device or 
instrument may get damaged.

The following diagram shows a bias tee that is positioned correctly. Notice 
that the generator's outputs are protected by the blocking capacitor.

50 Ohm

OutputM8041A 
or
M8051A  

V Term

DUT

AC Coupled
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The following drawing is an example of the external DUT connected to the 
generator output for the different possible settings.
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For AC-coupled mode (see red box above), the instrument actually cannot 
and does not need to distinguish between these two termination schemes. 
Therefore the drop-down box Termination Model is not shown and active 
within the GUI when the AC coupled mode is selected.

There are certain impedance/voltage limits you need to keep in order to be 
able to turn on (enable) the output(s).

Whenever an output amplifier is turned on, the external DC resistance as 
well as the external termination voltage is measured and calculated.

These are the impedance/voltage limits for various modes / 
configurations:

• DC Coupling Unbalanced: The measured externally connected 
resistance should be within the allowed range which is between 40 to 
60  here. Also, if an external termination voltage is detected that is 
not within the allowed ±100 mV tolerance window, the output(s) will 
not turn on.

• DC Coupling Balanced: The measured externally connected resistance 
should be within the allowed range which is between 80 to 120  here. 
In this DC Coupling Balanced mode there is an exception implemented, 
that allows the output(s) to drive high impedance (‘into open’). For this, 
the set maximum amplitude should be below 300 mv, and the offset 
setting should be between 0-370 mv.

• AC Coupling: You can use the AC coupled mode as long as you apply 
an external DC blocking capacitor. Here the external resistance should 
be equal or greater than 300 .

Setting up Terminations

Before you can start sending signals to your device, you have to choose 
the proper termination mode. To do so:

1 Go to the Menu Bar > Generator and then select Data Out.

2 Select Amplifier functional block from the Parameters window.

3 Provide the DUT's termination settings.

4 Provide termination voltage.

5 Connect the DUT's input ports to the M8020A/M8030A's output ports.

Ω

Ω

Ω

CAUTION
Selecting the wrong termination may damage your device.
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Adjust Output Levels (optional)

Data, Clock and Trigger Out offset and voltage levels can be adjusted. This 
is typically done when you want to tune your BER measurement or stress 
the device.

You can adjust the related parameters of the data and clock amplitudes 
and offsets on the GUI.

To enter specific values for the outputs from the keyboard:

1 Go to the Menu Bar > Generator and then select Data Out and Trigger 
Out ports. Once more, go to the Menu Bar > Generator and then select 
Clock Out port.

2 Select Amplifier functional block from the Parameters window. 

3 Select coupling as DC.

4 Select termination model as Unbalanced. 

5 Enter the desired termination voltage. 

CAUTION
Do not apply external voltages to the generator outputs. 

Output ports of the generator that are not connected to another device 
must be terminated with 50  to prevent the M8020A/M8030A from 
damage.

If outputs are disconnected they are usually not turned on because the 
output enable check detects the misconfiguration. If outputs are 
disconnected after they have been turned on the protection circuit might 
get triggered depending on the specific configuration. In this case the 
output will be switched off. This is an emergency scenario and should 
never be a normal habit. It can be switched on again (manually by the 
user) after removing the fault condition, it again follows the standard 
enabling procedure with termination voltage(s) & impedance checks. 

Ω

NOTE
If the standard enabling procedure with termination voltage(s) and 
impedance checks fails the output(s) will stay off. In this state the output 
resistance is "high impedance". It can be switched on again (manually by 
the user) after removing the fault condition, it again follows the standard 
enabling procedure with termination voltage(s) and impedance checks. 
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De-Emphasis Signal Generator

The M8020A/M8030A has a built-in de-emphasis signal generator that 
can be connected between the Data Out port of the generator and the 
DUT. 

De-emphasis is a method that reduces the voltage of a digital signal if the 
generated level is high or low for more than one clock period. The principle 
is illustrated in the following figure.

The de-emphasis amplitude is specified as a fraction of the output 
amplitude (in percent or dB).

Post-cursor de-emphasis

The figure above refers to a so-called post-cursor de-emphasis. You may 
wish to know how that is generated.

• One branch has a programmable amplifier to produce the desired 
output voltage (Peak to Peak Voltage).

• The other one has an adjustable delay (automatically set to one signal 
clock period) and a programmable inverting attenuator/amplifier to 
produce the delayed signal with a lower voltage swing.

Finally, the signals of both branches are added. This means, the delayed 
signal voltage is subtracted from the specified peak-to-peak amplitude.

Pre-cursor de-emphasis

It is also possible to convert the input signal to a pre-cursor deemphasized 
signal.
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This can be done by setting the output voltage swing to the desired 
deemphasis amplitude and specifying a negative amplitude ratio (an 
amplification). This inverts the roles of the two branches. The delayed 
signal has now a larger amplitude than the direct signal. A waveform 
example is illustrated in the following figure.

When pre-cursor de-emphasis is generated this way, the complementary 
Output of the De-Emphasis Signal Converter becomes the normal output 
and vice versa.

De-emphasis on 2 pre-cursor and 5 post-cursors

The following example illustrates the output of the differential signal with 
variable de-emphasis on 2 pre-cursor and 5 post-cursors generated by 
M8020A/M8030A De-Emphasis.

CAUTION
Be very careful if you set the de-emphasis ratio to amplification! In this 
case, there is no indication of the peak-to-peak voltage applied to the 
DUT.

You need to calculate or measure the output signal voltage precisely. 
Otherwise you might damage your device.
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Controlling the De-Emphasis 

To control the de-emphasis function:

1 Go to the Menu Bar > Generator and then select Data Out.

2 Select De-Emphasis function block from the Parameters window.

For M8020A/M8030A, you have two (pre–cursor) and five (post–cursor) 
and the corresponding unit.
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Set the values as following:

• Pre-Cursor2: 0 dB to 6.02 dB

• Pre-Cursor1: 0 dB to 12.04 dB

• Post-Cursor1: 0 dB to 20 dB

• Post-Cursor2: 0 dB to 12.04 dB

• Post-Cursor3: 0 dB to 12.04 dB

• Post-Cursor4: 0 dB to 6.02 dB

• Post-Cursor5: 0 dB to 6.02 dB

You can toggle between dB (decibel) and % (percent). Toggling does not 
change the value. The De-Emphasis function block also allows you to set 
the “Positive” or “Negative” polarity for de-emphasis.
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Setting Up Data Out Port Parameters

The generator produces clock and data outputs that serve as frequency 
reference and device stimulus for the device under test.

To set the Data Out parameters:

1 Go to the Menu Bar > Generator and then select Data Out port.

2 Select Amplifier functional block from the Parameters window. 

3 Set the parameters as described in this section.

Amplitude

This text field allows manual entry of the voltage amplitude and displays 
the current value.

To modify the value, click inside the text field and enter the desired value.

NOTE
The M8020A/M8030A will not allow you to adjust a voltage beyond its 
limits. The limit is determined by the M8020A/M8030A's internal 
hardware. If a limit is encountered, the M8020A/M8030A sends a 
message to the System Error. For more information about voltage limits, 
see the M8020A Data Sheet.
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You can even click Auto Range option which will automatically select the 
amplitude range according to amplitude.

High Voltage

This text field allows manual entry of the logic high voltage level and 
displays the current value.

To modify the value, click inside the text field and enter the desired value.

Offset Voltage

This text field allows manual entry of the voltage level halfway between 
logic high and logic low (the offset) and displays the current value.

To modify the value, click inside the text field and enter the desired value.

Low Voltage

This text field allows manual entry of the logic low voltage level and 
displays the current value.

To modify the value, click inside the text field and enter the desired value.

Delay

This text field allows manual entry of Data and Aux Data output delay and 
displays the current value in picoseconds.

Crossover

This text field allows manual entry of the data's crossover percentage, and 
displays the current value. 

NOTE
If you may want to adjust the output voltage level without changing the 
Amplitude, the J-BERT M8020A handles this by keeping Amplitude 
constant when Offset voltage is changed and High and Low voltages are 
accordingly adjusted.

Similarly, if you want to adjust the output voltage level without changing 
the Offset, the J-BERT M8020A handles this by keeping Offset constant 
when Amplitude is changed and High and Low voltages are accordingly 
adjusted.
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Clk/2 Jitter

This text field allows manual entry of the Clk/2 Jitter at the Data Out port 
in units of seconds. It provides half rate clocking; the clock at the clock 
output runs at half the bit rate. 

Data Polarity Inverted

Use this option to invert the logic of the data outputs (Data Out, Trigger 
Out and Clock Out).

Transition Time

Use this option to control the transition time of the output signal. The 
choices are smooth, moderate and steep.
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Bit Rate

Bit rate is defined as bits per second. The Generator's clock rate sets the 
bit rate and serves as the frequency reference for the Data, Clock and 
Trigger outputs, your device, and the Analyzer (if it receives its clock from 
the Generator). It can be generated internally or supplied from an external 
source.

When to Use an External Clock Source?

The M8020A/M8030A's internal clock can be used for most testing 
purposes.

There are some circumstances, however, when an external clock source is 
required:

• Synchronization with an external clock

The M8020A/M8030A can be connected to an external clock to allow it 
to run as part of a larger external system.

• Use of a modulated clock

A frequency- or delay-modulated clock can be used to provide a small 
amount of jitter to the clock signal.

• Use of a precision clock

A precision clock with very low phase noise can be used to enhance the 
instrument's performance. This is especially interesting for longterm 
measurements.

Bit Rate Range

The M8020A/M8030A provides bit rates from 256 Mbit/s up to 16.2 Gbit/s, 
depending on the instrument's options.

However, several specific properties and limitations need to be taken into 
account when working at low bit rates. The limitations apply to the 
instrument according to the following hysteresis curve:

• If the bit rate falls below 615 Mbit/s, the limitations apply.

• If the bit rate exceeds 620 Mbit/s, the limitations no longer apply.

The following figure clarifies the behavior in the range between 615 Mbit/s 
and 620 Mbit/s:
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For the generator the following rules apply:

• Below 620 Mbit/s, the Generator can only be operated with an external 
clock source, because the internal clock source can only produce 
signals higher than 620 Mbit/s.

• The trigger output cannot be set up to trigger on certain pattern 
positions or pattern sequences. If this option is enabled (for example in 
the user interface), the trigger is sent once for each pattern, but the bit 
position cannot be specified.

The option to trigger on the divided clock signal is supported as usual.

• There are restrictions to the available clock to data delay values.

The Generator can vary the clock to data delay only within a range of 10 
ns (relative to the clock signal). For frequencies above 666 Mbit/s, this 
range is sufficient to cover the complete clock cycle (= 1 unit interval).

For lower frequencies, the valid data delay range is smaller than the 
clock cycle. The Generator cannot generate signals with a delay outside 
this range. Therefore, the data delay cannot be set to all values within 
the clock cycle.
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Spread Spectrum Clocking

A Spread Spectrum Clock (SSC) is widely used for reducing the peak 
electromagnetic radiation at the nominal clock frequency. With SSC, the 
clock pulse is modulated with a relatively low-frequency triangle 
waveform. This broadens the clock signal spectrum and reduces the peak 
energy. The M8020A/M8030A allows to emulate such SSC on the data, 
trigger and clock output signals.

The M8020A/M8030A has a built-in SSC generator.

For the SSC settings, go to Menu Bar > Clock > Clock Generator and then 
select SSC function block from the Parameter window.
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Setting the Bit Rate

You can use an external clock source or the M8020A/M8030A's internal 
clock to control the bit rate.

To set the bit rate:

1 Go to Menu Bar > Clock and then Clock Generator.

2 Select Synthesizer function block from the Parameter window.

3 Select the appropriate clock source:

• Internal

This setting uses the internal clock oscillator.

• Reference

This locks the clock generator to an external 10/100 MHz reference.

• Direct 

This connects the external clock directly to the clock generator at 
8.1 GHz to 16.20 GHz.

• Clock Multiplier

This enables error counting and error analysis of devices using 
half-rate clocking.

4 For Direct clock source, click Execute button to measure the incoming 
clock’s clock rate.

5 Select a clock rate:

• For Internal Clock Source, you can enter a clock rate in the Value 
and Units field.

• For 10/100 MHz Ref Clock Source, the clock connected to the 
10/100 MHz Ref In port must be 10/100 MHz.

The selected clock rate applies to the generator. This is also the clock rate 
generated at the generator's Clock Out port.

The analyzer internally receives its clock from the generator, it runs at the 
same clock rate.

External Clock Divider

The internal clock (i.e. the bitrate) is the external clock divided by the value 
specified in the clock divider field. The external clock divider field is 
available if you have close an external clock source.
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External PLL Clock Divider and Multiplier

The internal clock (i.e. the bitrate) is the external PLL divided by the value 
specified in the divider field and multiplied with the value specified in the 
multiplier field. The external PLL clock divider and multiplier field are 
available if you have chosen a clock source.

Clock Rate Indicators

The Bit Rate indicators are shown in the Status Indicators display their 
current bit rate.

The analyzer bit rate is measured from the incoming clock signal or derived 
from the data signal.
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Trigger Output

The generator's Trigger Out port can be used to send a trigger to external 
devices like an oscilloscope or digital communication analyzer.

In pattern mode, the generator sends a trigger signal that is at least 32 bits 
long.

In sequence mode, the generator can send a trigger signal whenever a 
block of the sequence starts or restarts.

Several options are available for the trigger signal. As an example, you can 
send the trigger as a divided clock signal or as an indicator when the data 
pattern starts.

Setting Up Trigger Output

To set up the generator's Trigger Output port:

1 Connect the external instrument to the Trigger Out port.

2 Go to Menu Bar > Generator > and then select Trigger Out. 

3 Provide the necessary configuration.

You can always generate a divided clock signal at the Trigger Out port. 

The alternate trigger signals refer to patterns and are not generated in 
sequence mode.

To support the generation of a trigger spike at the beginning of a sequence 
block, the Trigger Output can be put into Sequence mode.

Clock Divided by n

Select this option to send a trigger signal from the Trigger/Ref Clock Out 
port at every nth clock pulse. Note that the trigger signal itself consists of 
n/2 bits high followed by n/2 bits low. For example, Clock divided by 8 
works as shown below.
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Sequence Trigger

This function becomes available after a user-defined sequence has been 
downloaded to the generator.

Click this function to switch the Trigger Out port to Sequence mode.

In Sequence mode, the Trigger Out can generate a spike whenever the 
execution of a block starts or restarts. Whether that happens for a 
particular block or not is defined for each block individually in the 
sequence expression. 

NOTE
If the Divider Factor n is uneven (For example 3), the clock's duty cycle 
will not be 50%, but the signal will stay high for (n+1)/2 and low for 
(n-1)/2. This results in a Duty Cycle Distortion (DCD) of 0.5 UI.
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Error Insertion

To test error correction algorithms, alarms and other functions that are 
embedded in the data pattern, you can insert logic errors (flipped bits) into 
the pattern.

For the error insertion, go to Menu Bar > Data Out and select Error 
Insertion function block from the Parameters window.

The instrument provides several options for inserting error bits manually or 
automatically. You have the following options for inserting errors into the 
output data stream:

Insert Single Bit Stream

To insert single bit stream:

• Click the slide switch to turn on the Error Insertion state.

• Select the supported mode from the drop-down list.

• Select the error ratio from the drop-down list.

Insert Single Bit Error

• To manually insert a single bit error into the output stream:

• Click the Data Out port.
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• Select Error Insertion functional block and enable the Insert Single Bit 
Error state.

• Click Execute.

NOTE
TIP - To find out how your DUT reacts on very small bit error rates, set up 
the pattern generator to enter errors once every 10-12 bits and run a 
longer accumulative test. 

You can then find the DUT's true error rate by calculating the difference 
between the bit error rate set up in the Generator and the accumulated 
bit error rate found by the Analyzer.

NOTE
If you set up too high an error rate, the Analyzer will not be able to 
synchronize to the incoming pattern. When setting up an error rate, 
always make sure that the synchronization threshold is higher than the 
bit error rate.



184 Keysight M8070A User Guide

5 Setting up Generator
 

Interference

The M8020A/M8030A supports the following two types of interference:

• Common Mode Interference (CMI) 

• Differential Mode Interference (DMI)

Common Mode Interference (CMI)

Common Mode Interference (asymmetrical mode) relates to ground (CMI). 
It has the following characteristics:

• State: Enables / disables common mode interference (CMI).

• Amplitude: Specifies the amplitude of the common mode interference 
(CMI).

• Frequency Source: Specifies the frequency source for common mode 
interference (CMI). It can be high frequency source or low frequency 
source.
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Differential Mode Interference (DMI)

Differential Mode Interference (DMI) - Differential Mode Interference 
(symmetrical mode) is independent of ground (DMI). It has the following 
characteristics:

• State: Enables / disables differential mode interference (DMI).

• Amplitude: Specifies the amplitude of the differential mode 
interference (DMI).

• Frequency Source: Specifies the frequency source for differential mode 
interference (DMI). It can be high frequency source or low frequency 
source.

• High Frequency: Specifies the frequency of the high frequency source.

• Low Frequency: Specifies the frequency of the low frequency source. 
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Jitter Setup

The Jitter Setup function is used for composing the total jitter in a defined 
and calibrated way.

The M8020A/M8030A supports the following types of jitters:

• High Frequency Jitter (HF Jitter)

• Low Frequency Jitter (LF Jitter)

High Frequency Jitter (HF Jitter)

The High Frequency Jitter is a composition of the following types of jitters:

• Periodic Jitter 1

• Periodic Jitter 2

• Bounded Uncorrelated Jitter

• Random Jitter

• Spectrally Distributed Random Jitter

• External Jitter Source (Connected to the Delay Ctrl input)

Low Frequency Jitter (LF Jitter)

The Low Frequency Jitter is a composition of the following types of jitters:

• Residual Spread Spectrum Clock

• Periodic Jitter

Global Jitter State On/Off Switch

The Jitter On/Off switch allows you to globally enable or disable the jitter 
generation.
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How to Enable Global Jitter State

You can enable the global jitter state by pressing the Jitter button, present 
on the status bar of the GUI. When this global jitter is enabled, the button 
turns green indicating the jitter active state.

Set Jitter Configuration

In this section, an example of Periodic Jitter 1 is shown to specify the jitter 
components.

To specify the jitter components:

• Set Unit: Defines the unit of jitter amplitude value in either seconds or 
UI.

• Set Delay: Enter a value to define the jitter delay on clock and data.

• Enable Jitter: Enable the jitter source (press the corresponding button).

• Set Parameters: Set the most commonly used parameter (typically 
Amplitude and Frequency) directly.

Spread Spectrum Clock

The Spread Spectrum Clocking setting controls the generator's spread 
spectrum (SSC) clocking feature. When the SSC is enabled, it impacts the 
Data Out, Clock Out, and Trigger Out ports.
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The spread spectrum clock is characterized by:

• Deviation

• Frequency

• Type

• Profile

• Shape

• Deviation 

If the deviation type Center Spread is selected, the deviation can be 
changed in two different ways:

• Change the Center Spread value: the bit rate remains unchanged, 
while the upper and lower frequency changes according to the 
selected deviation. The deviation value specifies ½ p-p value.

• Change the Down Spread value: the upper frequency remains 
unchanged, while the bit rate is adjusted. The deviation value 
specifies the p-p value.

For some setups, the I/Q modulator’s range limitations require to use 
Center Spread instead of Down Spread and adjust the bit rate (and 
deviation) accordingly.

If the upper or lower frequency is change, the bit rate will be adjusted 
according to the selected deviation. The center frequency corresponds 
to the configured bit rate.
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Please note that both the upper and lower frequency and the 
frequency adjustment of all three frequencies are not reflected in the 
firmware. The GUI just calculates the resulting bit rate and writes it to 
the firmware.

The Deviation of the clock rate. The ranges of SSC deviation are as 
follows:

• Down Spread with deviation of 0% … 1%

• Center Spread with deviation of 0% … 1%

• Up Spread with deviation of 0% … 1%

• Frequency: The deviation Frequency. The SCC provides the frequency 
range of 100 Hz – 200 kHz.

• Type: You can click the drop-down list to choose among Down Spread, 
Center Spread and Up Spread deviation type.

• Profile: Controls the profile of the spread spectrum clocking. You can 
use the drop-down list to choose between the Triangular and Arbitrary 
profile.

• Shape: For Arbitrary profile, you need to specify the Arbitary Waveform 
file. It is a simple text file that contains the data points which define the 
arbitrary waveform of the SSC profile. 

Periodic Jitter 1

The Periodic Jitter 1 is characterized by:

• Amplitude

• Frequency

NOTE
The deviation in Upspread and Downspread is the p-p value while in 
Centerspread it is 1/2 p-p.
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• Amplitude: Controls the amplitude of periodic jitter 1.

• Frequency: Controls the frequency of the periodic jitter 1.

Periodic Jitter 2

The Periodic Jitter 2 is characterized by:

• Amplitude

• Frequency

• Amplitude: Controls the amplitude of periodic jitter 2.

• Frequency: Controls the frequency of the periodic jitter 2.

Specify the Components for Jitter Sweep

The Periodic Jitter 2 has the following modes:

• Constant Amplitude Sweep

• Variable Amplitude Sweep

To specify the components of jitter sweep select Jitter Sweep functional 
block from the Parameter window and then select the Mode from the 
drop-down list to specify components the jitter sweep.

Periodic Jitter 2 – Constant Amplitude Sweep Parameters

The Periodic Jitter 2 – Constant Amplitude Sweep is characterized by:

• Amplitude

• Frequency Range

• Sweep Time

• No. of Steps
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• Amplitude: The maximum peak-to-peak Amplitude is limited by the 
free capacity of the chosen delay line.

• Frequency Range: The stop frequency has to be higher than start 
frequency and the range should be in accordance with the selected 
waveform.

• Sweep Time: You can specify the duration for sweeping the specified 
frequency range once.

• No. of Steps: You can specify the number of steps to fulfill a complete 
sweep. The start and stop values are included. The valid range is 
between 2 to 100.

Periodic Jitter 2 – Variable Amplitude Sweep Parameters

The Periodic Jitter 2 – Variable Amplitude Sweep is characterized by:

• Standard
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• Sweep Time

• No. of Steps

• Step Distance

• Standard: You can use this drop-down list to specify whether you want 
to select a pre-defined standard or a user-defined standard. All the 
available predefined standards will be shown in this list. However, if you 
select the user-defined standard, press Custom Profile button to locate 
the Jitter Tolerance standard. The user-defined standard uses the 
same file format like the Jitter Tolerance Compliance measurement.

NOTE
Selecting the Standard does allocate the required amount of jitter 
modulation on the delay line being used. To avoid errors when changing 
the selection, it is recomended to either select the corresponding bit rate 
first, or enable the PJ2 source after setting the correct bit rate.
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• Sweep Time: You can specify the duration for sweeping the selected 
jitter profile/standard once.

• No. of Steps: You can specify the number of steps to fulfill a complete 
sweep. The start and stop values are included. The valid range is 
between 2 to 100.

• Step Distance: You can use this drop-down list to specify whether the 
frequency steps are log equidistant (EQUidistant) along the periodic 
jitter curve or a frequency step matches a corner frequency on the 
periodic jitter curve.

Bounded Uncorrelated Jitter

Bounded Uncorrelated Jitter is characterized by

• Amplitude

• PRBS polynomial

• Data rate

• Filter type

• Amplitude: Controls the amplitude of the BUJ jitter source.

• PRBS polynomial: The PRBS polynomial can be chosen from a list. 
Available are eight polynomials, from 2^7-1 up to 2^31-1.

• Data Rate: Enter an appropriate Data Rate. 

• Filter Type: The bounded uncorrelated jitter source is equipped with 
three low-pass filters with cut-off frequencies at 50, 100, and 200 MHz. 
One of these filters is always active.
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Random Jitter

Random Jitter is characterized by:

• Amplitude

• Filter Settings

• Amplitude: The random jitter Amplitude must be entered as an rms 
(root mean square) value.

• Filter: The random jitter source is equipped with a 10 MHz high pass 
and a 100 MHz and 500 MHz low pass filter to limit the spectral range.

Spectrally Distributed Random Jitter

Spectrally Distributed Random Jitter is composed of two jitter sources: 
low frequency jitter and high frequency jitter. It is characterized by the 
amplitudes of the low and the high frequency jitter.

Spectral Distributed Random Jitter is characterized by

• Amplitude LF

• Amplitude HF
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It has the following parameters:

• sRJ State: Click this switch to enable the spectrally distributed random 
jitter.

• SRJ Amplitude 1 (RMS) LF: This is the low frequency jitter amplitude as 
rms value. 

• SRJ Amplitude 2 (RMS) HF: This is the high frequency jitter amplitude 
as rms value.

• sRJ Low Pass Filter: The spectrally distributed random jitter is 
equipped with a 100 MHz low pass filter to limit the spectral range, 
which can be enabled by pressing the corresponding switch.

External Jitter Source

To enable the external jitter source:

• From the Data Out port select HF Jitter functional block in the 
Parameters window.

• Click the External switch to enable external jitter.

NOTE
Even if the external jitter source is enabled, you can still add or change 
internal jitter components.





Keysight M8070A System Software for M8000 Series of 
BER Test Solutions

User Guide

 

6 Setting up Analyzer

Overview   /  198
M8020A/M8030A Analyzer Ports   /  199
Clock Setup   /  203
Sampling Point Setup   /  210
Pattern Synchronization   /  214



198 Keysight M8070A User Guide

6 Setting up Analyzer
 

Overview

The M8020A/M8030A Analyzer examines an incoming bit stream, 
compares it to the expected pattern, and locates any inconsistencies. The 
Analyzer requires the following settings to work correctly:

• The expected pattern

The Analyzer needs to "know" which data to expect so that it can detect 
bit errors. No expected patterns are required in BRM mode.

• Correct clock frequency

Required to recognize the bit rate in the data stream.

• Appropriate sampling point

The sampling point defines where the Analyzer tries to differentiate 
between 0s and 1s in the data stream. This is necessary so that the 
Analyzer recognizes the data bits correctly.

• Synchronization to the incoming pattern

The expected pattern must be synchronized to the incoming pattern so 
that the Analyzer can find any discrepancies.

The Analyzer provides the following functions to enable you to perform 
tests:

• Automatic pattern synchronization

The Analyzer shifts the incoming data stream bitwise to match it to the 
expected data pattern. A correct BER can only be measured with 
matching patterns.

• Error accumulation

You can specify whether a test runs for a specified time or until a 
specific number of errors has occurred. This lets you carry out longer 
tests while logging the results to a file.

• BER location mode

You can specify whether all errors are counted or only the errors that 
occurred on a particular bit position or range of positions.

• Trigger output for external measurement instruments

This allows you to connect other devices for further error analysis.
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M8020A/M8030A Analyzer Ports

The M8020A/M8030A analyzer’s ports are used for running tests and for 
connecting external equipment.

The following figure shows the J-BERT M8041A analyzer’s ports.

The M8041A analyzer’s ports include the following:

• Data In and Data In

This port is connected to the data signal and the inverted data signal.

Data In Port Termination

To ensure a valid setup and to protect the devices from damage, proper 
termination must be specified for both Data In connections. You can 
specify the termination by entering the termination voltage in the 
respective field.

Why Can Wrong Terminations Damage Your Device?

Choosing wrong terminations may cause your device to output voltage 
levels that are not as expected. It may also cause excessive current or 
current flow in the wrong direction, which can damage your device.

CAUTION
Selecting the wrong termination may damage your device.
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If you adjust the termination voltage, and try to enter value(s) which are 
outside of the currently allowed window, the Auto Correction Confirmation 
message box will pop up with respective apply and discard options as 
shown in the following figure:

Setting Up Termination 

To select the termination for the Analyzer:

1 Go to the Menu Bar > Analyzer and then select Data In.

2 Select Comparator functional block from the Parameters window.

3 In the Termination Voltage field, enter the termination voltage that is 
appropriate for the incoming data signal.

4 In the Polarity field, select Inverted if your device inverts data. 

You can now physically connect the DUT to the Analyzer.

NOTE
You must know the termination voltage of the data signal that your DUT 
sends to the Analyzer.

CAUTION
Selecting the wrong termination may damage your device.
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Compare Mode

The selection in this list defines how the signals arriving at the Data In and 
Data In connectors are interpreted. The following options are available:

• Differential

If differential mode is selected, both input ports need to receive a 
signal. The actual data signal is measured as the voltage difference 
between the two incoming signals.

• SE-Normal (Single Ended - Normal)

In normal mode, only the Data In port receives the data signal, the 
Data In port is inactive.

• SE-Complement (Single Ended - Complement)

In complement mode, only the Data In port receives the data signal, 
the Data In port is inactive.

The following drawing is an example how the instrument internal circuitry 
looks like for different settings.
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Data Inverted

To activate data inverted function, select the Polarity as Inverted in the 
Comparator functional block of the Analyzer. This function is required if 
your device inverts data.

Threshold

Enter a Threshold value for applications that do not provide a continuous 
data stream at the input (for example, any application using bursts), 
because the averaged threshold voltage will drift from the correct level 
when there is no input. 

Termination Voltage

In this field, enter the termination voltage that is appropriate for the 
incoming data signal. This selection should be made before the device is 
connected to the analyzer.

The Data In port is connected to a 50  load impedance (or termination) 
within the Analyzer. Data termination refers to the voltage level at the end 
of this load. The logic output from a device requires any connected 
equipment, including the Analyzer, to have a specific termination voltage.

Input Range

Before you can synchronize the Analyzer to the incoming data stream, you 
need to define the voltage range within which the eye is located.

Both the high and low level of the data signal must be within this range to 
find the eye.

CAUTION
Selecting the wrong termination may damage your device.

Ω

NOTE
The input voltage range is 2V. When you modify either the high or low 
voltage, the other voltage is automatically adjusted.
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Clock Setup

To measure the Bit Error Rate with the Analyzer, the bit rate of the data 
stream must be known. Depending on the options the instrument is 
delivered with, you could use either an external clock source for the 
Analyzer (for example, the clock from the generator), or extract the clock 
signal from the incoming data (CDR mode).

CDR mode does not work for all kinds of data patterns. For example, if the 
device under test sends only blocks of ones and zeros, there are no 
transitions in the data stream and the M8020A/M8030A cannot recover 
the clock.

Also, if you are testing bursts, there are some special considerations for 
setting up CDR.

How does Clock Data Recovery Work?

In CDR mode, the CDR has to recover the clock from the incoming data. To 
do this, the hardware has to decide whether the voltage at the input 
connector is a logical '1' or '0' and then recover the clock from the 
detected transitions.

Clock Data Recovery (CDR) is a special kind of Phase Locked Loop (PLL), 
which recovers clock signal of a data stream. It is a regulatory loop, which 
synchronizes the local oscillator with an external reference, in this case the 
incoming data stream.

Phase Locked Loop

A PLL has three parts: a phase detector, a loop filter, and a Voltage 
Controlled Oscillator (VCO). The phase detector has two inputs, and one 
output, which is proportional to the phase difference of the inputs. The 
loop filter is a low pass filter which attenuates the higher frequencies from 
the output of the phase detector. The VCO is an adjustable oscillator which 
changes the output frequency depending on its input voltage. The diagram 
below shows a simple PLL.
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One of the most important characteristics of a PLL is its loop transfer 
function.The loop bandwidth is defined as the integrated magnitude of the 
PLL’s frequency transfer function over the entire frequency spectrum. The 
loop bandwidth describes how the regulatory loop tracks the VCO to a sine 
wave FM modulated input signal. Above the bandwidth the loop cannot 
track such a modulation completely, and thus, the response to the 
modulation is attenuated.

The other loop parameter is peaking. This describes how much a 
modulation is exaggerated (mostly close to the loop bandwidth).

Data Rate and Loop Parameters

The data stream contains multiple frequencies, and the CDR needs to 
know the expected data rate. You can choose between 2 types of CDR; 1st 
order and 2nd order. 

The M8020A/M8030A has an internal CDR which has the following 
additional input parameters: 

• Loop Bandwidth: It is the input parameter to set the characteristics of 
the loop.

• Additionally, you can set the value for peaking in the provided field.

• Transition Density: It affects the loop parameters, and it must be either 
entered, or measured. Some standards define a loop bandwidth for a 
specific transition density.

• Peaking: It defines the second order CDR characteristics by defining a 
peaking value which is valid for jitter transfer function. The peaking 
parameter is only available for the second Loop Order. 
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Threshold

The regular threshold voltage is not only used to determine the optimum 
sampling for the data, but also to perform measurements.It is not possible 
to use it for the clock recovery.

For this reason, the clock recovery circuitry has its own comparator for the 
incoming data. This comparator also needs to know the threshold voltage.

The threshold voltage can be derived from the input signal via a lowpass 
filter. This will work fine for most applications. But applications that do not 
provide a continuous data stream at the input (for example, any 
application using bursts) cannot use this low-pass filter, because the 
threshold voltage will drift from the correct level when there is no input. In 
such cases, the threshold can be specified manually. It is then no longer 
derived from the input signal. The manually set threshold voltage must of 
course be within the input range.

The difference between the data path and the CDR path is that the 
comparator of the CDR is always single-ended. Thus, this comparator 
always needs a threshold voltage that lies between the high and low levels 
of the incoming signal.

The differential threshold of the data path comparator has no relation to 
the single-ended threshold of the CDR path comparator. This means that 
in differential mode, the two thresholds will be different and in 
single-ended mode (either normal and complement) they will/can be 
equal (except during measurements).

The following figure shows a simplified block diagram. It does not reflect 
the different input modes (especially the differential case), but it matches 
both single-ended cases.
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Bit Rate Range

The M8020A/M8030A provides bit rates from 256 Mbit/s up to 16.207 
Gbit/s, depending on the instrument's options.

For the Analyzer the following rules apply:

• For low frequencies, you cannot use the automatic data alignment 
functions (Auto Align and Data Center). Instead you need to align the 
Analyzer manually. You can also go to the Menu Bar > Analyzer or 
Module View, and then select Data In port. From the Properties 
window, select Analyzer functional block and then click Execute button 
for the Auto Alignment

• There are few restrictions to the available sampling point delay values.

The Analyzer can vary the sampling point delay only within a range of 
0.0 ps to 1.6129 ns (relative to the clock signal). For frequencies above 
620 Mbit/s, this range is sufficient to cover the complete clock cycle (= 
1 unit interval).

For lower frequencies, the maximum sampling point delay is smaller 
than the clock cycle. Therefore, the sampling point cannot be set 
everywhere within the clock cycle.
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If you cannot find the optimum sampling point in the valid range of 
sampling points, you can switch from the rising to the falling clock 
edge.

With this method you can still place the sampling point anywhere in 
the clock cycle to find the optimum sampling point, even at low 
frequencies.
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However, if the bit rate falls below approximately 
310 Mbit/s, even with this method gaps occur in the range of possible 
sampling points.

As a result, you might not be able to find the optimum sampling point, 
if it falls in one of the gaps.

CDR Setup

To perform the CDR Setup:

1 Go to the Menu Bar > Analyzer and then select Data In.

2 Select CDR functional block from the Parameters window.

3 Click CDR State switch to turn on the CDR state.

4 Specify the Loop Bandwidth within the range of 500 kHz to 20 MHz.

Transition Density

The transition density is defined by the number of transitions in the 
incoming data divided by the total number of bits transmitted. In this field 
enter the transition density in (%). 

This parameter affects the loop bandwidth, and thus must be entered 
correctly. Some standards specify the loop bandwidth for a given 
transition density. In such a case enter the value given in the specification, 
so that the CDR behaves according to the standard. If a standard from the 
preset list is selected, this field is also preset.

Loop Bandwidth

This is the range of the CDR loop bandwidth. In this field the user should 
enter the loop bandwidth value; the range is within 313 kHz to 20 MHz. 

When the M8020A/M8030A Analyzer is used to characterize a data stream 
instead of a receiver, the loop parameters should be set according to the 
used standard.
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If the CDR is used to recover the bit stream from a receiver to be 
characterized due to a lack of a clock output, choose the loop bandwidth 
significantly higher than the receiver’s bandwidth. To characterize a DUT’s 
CDR it is the best practice to use its recovered clock output instead of the 
J-BERT’s built in CDR. Choose a low loop bandwidth to measure the jitter 
on an incoming data stream as the CDR will track the incoming jitter up to 
the loop bandwidth and thus make it invisible to the Analyzer.

CDR Spread Spectrum Clocking

This control is used to adapt the CDR to an input bit stream with SSC.

Enabling SSC state widens the loss of lock detection window, and sets the 
peaking to optimum SSC performance. Enter the Expected Deviation and 
the type of deviation (Up-Spread, Down-Spread or Center-Spread) to set 
the locking window to an optimum.

SSC is mostly used Down-Spread which means, the clock signal is 
modulated to a lower frequency and back. Thus the average frequency is 
lowered by half of the maximum deviation. The CDR is adapted to that 
value. Enter the maximum deviation as specified in the standard.
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Sampling Point Setup

This section provides basic information on the sampling point setup.

How Does the Sampling Point Setup Work?

The sampling point of a data signal is defined by two values: a point in time 
and a voltage level. Each bit of the data signal is sampled at this point in 
time and in reference to this voltage level. The point in time (in reference to 
the clock signal) is referred to as the data input delay, and the voltage level 
is referred to as the threshold.

The location of the sampling point is the decision factor as to whether the 
incoming bits are identified as logic 0's or 1's. To measure the accurate bit 
error ratio at the input port, false readings of logic 0's or 1's must be 
avoided. Therefore, the sampling point must be set to the optimum 
location within the data eye.

The functions within the Sampling Point Setup window allow you to:

• Prepare the Analyzer for the incoming data signal regarding the 
connector termination.

• Graphically display the eye diagram in terms of voltage, input delay 
and a BER threshold.

• Adjust the location of the sampling point.

Auto Alignment

Use this option to automatically set the optimum sampling point.

To perform the Auto Alignment:

1 Go to the Menu Bar > Analyzer and then select Data In.

2 Select Analyzer function block from the Parameters window.

3 Click Execute button for the auto alignment.

This routine will not stop if the optimum sampling point cannot be found. If 
no optimum sampling point is found after a reasonable time, you can click 
Cancel. 

The following settings may affect the result of the auto align function:

• Polarity (Data Inverted)

• Threshold (BER Threshold)
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Threshold Center Alignment 

To perform the Threshold Center Alignment:

1 Go to the Menu Bar > Analyzer and then select Data In.

2 Select Comparator function block from the Parameters window.

3 Click Execute button for the threshold center alignment.

The threshold center alignment starts an auto-search function that sets 
the threshold to the optimum point of the incoming data eye on the 
vertical voltage axis without changing the data input delay. This function 
can be used for determining the optimum threshold for asymmetric data 
eyes, or for patterns with an unequal mark density.

Data Center Alignment

To perform the Data Center Alignment:

1 Go to the Menu Bar > Analyzer and then select Data In.

2 Select Input Timings function block from the Parameters window.

3 Click Execute button for the data center alignment.

This button starts an auto-search function that aligns the data signal with 
the clock signal so that the Analyzer samples at the optimum point of the 
data eye in the time axis. This automatically compensates for delays in the 
clock/data paths, preventing unnecessary errors. The decision threshold is 
not changed. 

NOTE
This function uses the alignment BER Threshold to determine the top and 
bottom eye edges.

NOTE
Ensure that the received clock frequency is stable before using Data 
Center.
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Canceling Auto Align

Click this button to cancel the Auto Align, Threshold Center, or Data 
Center functions while they are in progress. The following parameters will 
be returned to their previous value or status:

• Auto Align Canceled

• Data Delay and Threshold values returned to previous.

• Threshold Center Canceled

• Threshold value returned to previous.

• Data Center Canceled

• Data Delay value returned to previous.

Alignment BER Threshold

In this list, select an alignment BER threshold that is appropriate for your 
application.

The alignment BER threshold is the pre-defined threshold used by the 
Auto Align, Threshold Center, and Data Center functions to define the 
edges of the data input eye in the time and voltage axes. You may wish to 
change the threshold for the following reasons:

NOTE
The clock/data alignment process time is pattern dependent, and with 
some large user patterns the alignment can take several minutes. If you 
encounter such a long time with a user pattern, it may be possible to first 
perform clock/data alignment on a pure PRBS pattern. This generally 
does not affect alignment accuracy, and can minimize measurement 
time.

This tip does not apply in cases of severe pattern dependent jitter or with 
devices that do not work with PRBS patterns.

NOTE
This function uses the alignment BER threshold to determine the left and 
right eye edges.
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• Choosing smaller alignment BER thresholds will cause the auto-search 
functions to set more accurate sampling points. However, if the BER 
threshold is set lower than the residual BER of the measurement, the 
auto-search functions will fail. 1E-9 is the smallest BER threshold 
available.
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Pattern Synchronization

The M8020A/M8030A calculates bit error rates by comparing the received 
data with the expected data patterns. To do this, it needs to know where 
the start of the pattern is located in the data stream.

Introduction to Pattern Synchronization

Pattern synchronization (sync) refers to aligning the incoming data pattern 
with the internal reference pattern.

Hardware-Generated Patterns

For 2^n-1 PRBS patterns, bits from the incoming data pattern "seed" the 
Analyzer's Generator, causing it to generate a precisely aligned internal 
reference pattern.

Memory-Based Patterns

For software-generated and user patterns, a 48-bit pattern from the 
pattern is used as a detect word. Optimally, this detect word should be 
unique within the entire pattern. The Analyzer searches for this detect 
word within the incoming data stream, and uses the point in the data 
stream as a reference, and compares all following bits with the pattern. If 
the measured BER is better than the synchronization BER, the Analyzer 
will be synchronized.

There are thus three possible outcomes for a synchronization:

• Single instance of the detect word in the data stream
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• Multiple instances of the detect word with correct synchronization.

• Multiple instances of the detect word with false synchronization.
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BER will be unacceptably high, and, if automatic synchronization is 
selected, the Analyzer attempts another re-sync.

The detect word on which the Analyzer attempts to re-sync is chosen 
strictly by chance. So if there are two instances of the detect word in the 
pattern, the Analyzer has a 50% chance of selecting the correct one.

The more instances of the detect word exist in the pattern, the higher are 
the chances for incorrect synchronization. The software attempts in any 
case to identify a 48-bit pattern that occurs as seldom as possible in the 
pattern. For very large patterns, this can unfortunately take a very long 
time, and the software ends the search if it expects that it would take 
longer to find an adequate detect word than it would to attempt to 
synchronize. If the search for a detect word is ended, the most unique 
detect word identified is used.

Patterns must always be synchronized in order to do accurate BER testing. 
If patterns are out of alignment by just one bit, errors can be as high as 
50% (5E-1) for PRBS patterns, and 100% (1E+0) for custom patterns.
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By default, the Analyzer is in automatic sync mode with a sync threshold 
of 1E-3. This setting is recommended for most applications, and usually 
allows the synchronization function to be "transparent", requiring no 
attention. However, for special applications, changes can be made to the 
sync mode and sync threshold.

What Type of Synchronization Should You Use?

The type of synchronization you use affects how errors are measured and 
displayed. A Sync Loss is recognized when the BER is greater than the 
sync threshold. This can be caused by a high error rate, pattern 
misalignment, or clock loss. Choose the sync mode setting that is 
appropriate for the type of errors you anticipate.

• Automatic Sync with a sync threshold BER of 1E-3 is recommended for 
most applications.

With this mode selected, the synchronization algorithm starts 
whenever the BER exceeds the threshold. However, it is not possible to 
make accurate BER measurements higher than the sync threshold.

• Manual sync can be used for synchronizing once, confirming proper 
pattern alignment, and then measuring BERs higher than the sync 
threshold. This is useful for the following applications:

• To monitor the integrity of clock signals. You may wish to measure 
BERs that exceed the sync threshold to confirm clock slip.

• To collect data for constructing eye contour information. You may 
wish to move the sampling point to locations in the data eye that 
have BERs exceeding the sync threshold.

This mode doesn't allow the analyzer to automatically synchronize if 
the BER becomes greater than the sync threshold. For example, the 
analyzer will not re-synchronize after momentary clock loss.

• Burst sync mode is a special operating mode for measuring data in 
bursts of bits, rather than one continuous stream of bits.

NOTE
Adjusting the data input delay may cause momentary clock loss. If you 
select Manual Sync mode, this may also result in sync loss.



218 Keysight M8070A User Guide

6 Setting up Analyzer
 

What is False Synchronization?

For patterns other than PRBS, the Analyzer may gain sync at a point in the 
pattern that meets the sync threshold, but is not the correct point where 
the internal reference pattern and the received data pattern match. This is 
called false synchronization.

For example, consider a pattern of 1000 ones and 1000 zeros as shown in 
the following figure. With reference alignment 1 the patterns are totally 
out of phase and the Analyzer is measuring 100% errors.

But as the reference moves closer to optimum alignment, the percentage 
of errors gradually approaches zero (reference alignment 2 and 3). For 
exact alignment, the sync threshold must be set lower than the BER 
caused by a 1 bit misalignment, in this case 1E-3.

NOTE
If the Analyzer is in Manual Sync mode, it is recommended that you keep 
an eye on the Sync Loss indicator, present on the Status Ind icator. There 
are various actions that can lead to loss of synchronization. Check the 
sync loss every time you make changes to the instrument.

NOTE
False synchronization cannot occur with PRBS patterns because a 1 bit 
misalignment would cause a measurement of 50% or more errors. Thus, 
the BER during a misalignment would always be greater than the sync 
threshold BER.
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How Can You Tell if Your Synchronization is False?

You may suspect false synchronization under the following conditions:

• You are using a pattern other than PRBS and the Analyzer gains sync, 
but it measures a constant, fixed error ratio.

• You are using a pattern other than PRBS and the Analyzer gains sync, 
but auto-search functions (Auto Align, Clock/Data Center, Threshold 
Center) repeatedly fail.

In a false sync, the sync threshold BER of 1E-3 may be met, but eye 
edges at BER 1E-3 (required by an auto-search function) may not be 
found. This is because BERs less than 1E-3 do not exist within the data 
eye.



220 Keysight M8070A User Guide

6 Setting up Analyzer
 

If you suspect a false sync, try re-synchronizing at a sync threshold 
BER lower than the fixed error ratio. If sync is acquired without the 
problems listed above, then your previous sync was false. Your current 
sync should be on an exact pattern alignment.
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How to Synchronize an Incoming Pattern

To synchronize the incoming pattern to the expected pattern:

1 Go to the Menu Bar > Analyzer and then select Data In.

2 Select the Analyzer function block from the Parameters window.

3 Select Re-Sync. The choices are Automatic or Manual.

• Automatic Sync

When this option is selected, the Analyzer constantly tries to 
synchronize the patterns when the BER threshold is exceeded.

• Manual

Manual synchronization can be selected, for example, if the signal 
delay is very unstable, and you want to avoid that, the 
resynchronization process affects the measurement results.

NOTE
While auto-search functions are in progress, the sync threshold BER is 
changed to the same value as the alignment BER threshold. If you are 
using these functions and want to consistently re-synchronize at a lower 
sync threshold, you must set the alignment BER threshold to the same 
value as the sync threshold BER.
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Bit Recovery Mode

Understanding Bit Recovery Mode (BRM)

Traditionally, bit error rate testing compares the bits from a Device Under 
Test (DUT) against a reference data set, called the expected data. The user 
of Bit Error Ratio Tester (BERT) has to provide this expected data and load 
it into the M8020A/M8030A.

The M8020A/M8030A system then samples the incoming data signal with 
a sampling point that can be varied over time and voltage, to measure the 
BER. The M8070A system software is capable of creating graphics, such as 
the eye opening, from the information gathered during sampling. A 
compare circuit counts the differences between the bits of the incoming 
data stream and the expected data.

Now there is a mode that removes the need for the user to provide 
expected data, while still allowing one and two-dimensional 
measurements, such as the eye opening.

This is the Bit Recovery Mode (BRM).

This has two benefits: 

• the user does not need to worry about the expected bits, which makes 
a setup easier and faster. 

• the M8020A/M8030A system can measure non-deterministic data 
streams. This means it is no longer necessary to force a device into a 
specific test mode.

Bit recovery mode uses a second sampling circuit in the M8020A/M8030A 
analyzer to always sample at the sweet spot of the eye (typically at 50% of 
eye opening in time and voltage). The sampled data from this second 
sampling circuit acts as a reference and is passed to the compare circuitry, 
instead of the expected data.

This means the BER is now a relative figure. Taking the bit from the sweet 
spot of the eye cannot verify if this bit is correct in itself, it can just use it as 
a reference for any bit sampled in the border area of the eye. Bit recovery 
mode makes one and two-dimensional sweeps possible to sample in the 
border area of the eye and find out how the BER value increases. From this 
we can derive the random and deterministic (Rj and Dj) characteristics.

We can also take the eye opening with a known, deterministic test pattern 
and compare it with operational data, where a device idles or provides 
scrambled data, or there are asynchronous events like hand-shake signals.
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The Bit Recovery mode also has a limitation that it requires a minimum eye 
opening: an eye that is too narrow cannot be processed. Care also needs 
to be taken if there is a good eye opening but there is a finite BER inside 
the eye.

Setting up Bit Recovery Mode

To set up the Bit Recovery Mode mode:

1 Go to the Menu Bar > Analyzer and then select Data Input or if you are 
in Module View, then click on Data In location.

2 Select Analyzer functional block from the Parameters window.

3 Click Bit Recovery Mode switch to turn on the Bit Recovery Mode.

Once the Bit Recovery Mode is enabled, the BRM indicator on the Status 
Indicator turns green. See Status Indicators Window on page 92.

BRM can be used with all measurements supported by M8070A system 
software.

NOTE
The bit recovery mode can be enabled only when CDR state is on.
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Pattern Overview

The purpose of data patterns is to simulate the type of data that your 
device might receive in the real world. Different patterns present different 
data loads to your instrument, which can cause variations in the bit error 
ratio. A bit pattern is sent from the generator to your device. At the same 
time, the expected output pattern of your device is internally generated in 
the analyzer (to provide a reference).

Selecting a pattern is the first step in setting up a BER measurement. The 
M8020A/M8030A provides various patterns to fulfill most standard testing 
needs. It supports the following types of patterns:

• PRBS

• Pulse

• Clock

• Static

• Memory Patterns

Patterns consist of a sequence of symbols. A symbol can have the 
following type of coding:

• Binary (Bit)

• 8B/10B

• 128B/130B

• 128B/132B
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Sequence Editor

Overview

The sequence editor allows you to create and maintain sequences. In 
addition to this, it also allows you to edit the memory patterns. 

A sequence consists of up to 500 blocks that can be looped. Single or 
multiple blocks can be looped. The sum of the blocks and the counted 
loops must not exceed 500. An overall loop restarts the sequence after it 
has come to its end.

You can also upload predefined sequences for PCIe, USB and SATA using 
the Recall Setting dialog. For details, refer to Recall/Save Instrument 
State on page 103.

When to Use a Sequence

You may wish to test a device that uses a certain protocol for processing 
data.

For example, the device might expect synchronization data, a preamble, 
payload data, and a suffix.

All this can be provided by a user-defined sequence.

How a Sequence is Defined

The sequence is defined by a SequenceExpression which is formulated in 
its own language, checked by the Sequence Editor.

The SequenceExpression specifies:

• the sequence start (and break) conditions

• the blocks, their contents, and trigger output

• the loops
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How to Launch a Sequence Editor 

To launch the Sequence Editor:

• Go to the Menu Bar > Patterns and then select Sequence Editor.

The Sequence Editor will appear as shown in the following figure: 

The Sequence Editor user interface includes the following elements:

• Toolbar 

• Sequence Control Pane

• Sequence Settings Window

• Pattern Edit Pane

These GUI elements are described in the section that follows.
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Toolbar

The toolbar provides the following convenient sequence editing functions:

Table 41  

Elements Name Description

New Click this icon to create a new sequence. Refer to 
Creating New Sequence on page 230.

Download Click this icon to save the modifications that are done 
using the Sequence Settings window on the module. 

An  orange icon indicates that modifications are not 
yet applied on the module.
You can also apply the changes on either generator, or 
analyzer or both.

Reload 
Running 
Sequence

Click this icon to reload the running sequence settings. 
Reloading a sequence will discard the changes made in 
the sequence editor and will reload the current sequence 
with its factory settings.

Add Block 
Before

Click this icon to add a block before selected sequence 
block.

Add Block 
After

Click this icon to add a block after selected sequence 
block.

Loop Click this icon to create a loop in a sequence block. Refer 
to Creating a Loop on page 231.

Delete Click this icon to delete the selected block from the 
sequence. Deleting a block will also remove all loops that 
are associated with this block. 

<xml> Click this icon to toggle between the user interface and 
xml code. The changes made in user interface are also 
reflected in xml code and vice versa.

Show Patterns Shows the patterns in the Pattern Ed it Pane if the selected 
block has memory patterns.
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Creating New Sequence

To create a new sequence:

1 Click on the  Create New Sequence icon present on the toolbar. A 
sliding window will appear which allows you to create a new sequence. 
See the figure below:

2 Perform the following settings:

• Name - Provide a sequence name. 

• Description - Provide a description of the sequence.

• No. of Blocks - Enter the no. of blocks to be added. You can add 
upto 500 blocks in a sequence.

• Sequence Locations - Use the check-box to select the sequence 
location. You can either select a single sequence location or multiple 
locations.

3 Click Create to create a sequence. 

Break Click this icon to terminate an infinite loop that is set to 
"manual" break condition. Sequence execution continues 
with the next block.

Reset Click this icon to interrupt and re-initialize a running 
sequence.

Sync Click this icon to sync the sequences globally.

Elements Name Description
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Creating a Loop

To create a loop (if desired):

• Click the  Add Block Before icon to add the blocks before the 
selected sequence blocks.

• Click the  Add Block After icon to add the blocks after the selected 
sequence blocks.

• Click the  Create Loop icon. A Create Loop dialog will appear as 
shown in the following figure:

• Specify the start and end block of the loop for the specified sequence 
(for e.g. generator, analyzer or user-defined sequence). 

• Click Create to create a loop in the specified blocks.

• Click on the loop indicator. You will see a Loop Setting functional block 
in the Sequence Setting window where you can specify the loop count 
and enable the looping option.

Loop Within Sequences

A loop defines the transition from the end of a block to the beginning of 
the same or a previous block. It is not possible to jump into an existing 
loop. It is also not possible to specify loops within loops (except the default 
overall loop).

For information on how to create a loop, refer to Creating a Loop on 
page 231.

Deleting a loop - It is possible to delete a loop. To delete a loop, select the 
loop indicator and click  Delete icon.
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Modifying the Existing Sequences

By default, the Generator and Analyzer sequences already exist whenever 
you launch a Sequence Editor. You can however modify these sequences 
as per the requirements. Using these options, you can:

• Add and delete the blocks

• Add loops in the blocks

• Specify the settings for each block using the Sequence Settings 
window. For more details, refer to Sequence Setting Window on 
page 232.

Sequence Setting Window

The Sequence Setting window allows you to set the properties for the 
selected block and sequence. Using this window, you can specify the 
following settings:

• Instrument Configuration. For details, refer to Instrument 
Configuration on page 233.

• Sequence Configuration. For details, refer to Sequence Configuration 
on page 238.

• Block Data. For details, refer to Block Data on page 239.

• Block Settings. For details, refer to Block Settings on page 242.

• Block Branches. For details, refer to Block Branches on page 243.

• Block Controls. For details, refer to Block Controls on page 244.

Set to Default Check-Box

Most of the parameters in the Sequence Setting window contains a Set to 
Default check-box which gets highlighted when some modifications are 
done. You can click on this check-box to change the settings to their 
default values.

The following figure shows how the check-box gets highlighted when you 
modify the symbol width to 10.

NOTE
Please note that there should be at least one block in the sequence. 

Remember that you are not allowed to perform delete operation in the 
block if there is only one block in sequence.
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However, when you click on the Set to Default check-box, the value 
changes to 1 (default value). See the following figure.

Instrument Configuration

The instrument configuration section provides the following options:

• Symbol Width: Use this option to select the symbol width e.g, 1, 10, 
130 or 132 bit. Depending upon the symbol width you have selected, 
you can specify the coding configuration for that particular symbol 
width.

• Replicate: Select the replicate option (Serialized, Copy or Copy plus 
Phase Adjust).

If the symbol width is 10, you can specify the 8B/10B coding configuration. 
Using this, you can define alignment symbol, replacement symbol and 
filler primitives.
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The Alignment Symbol contains the K28.1, K28.5 and K28.7 symbols.

The Replacement Symbol contains the K28.0, K28.4, K28.7, K23.7, K27.7, 
K29.7 and K30.7 symbols.

Filler Primitives are inserted or deleted for clock tolerance compensation. 
These are not compared and therefore cannot be counted as errors. Filler 
Primitives contain symbols. A maximum of four alternative filler primitives 
can be used. Each filler primitive can consist of up to 4 filler symbols. Filler 
symbols are separated by comma (,). To add filler primitive;

• Click the Add Primitive button.

• Enter the Symbol. The filler primitive can consist of up to 4 filler 
symbols.
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Wild Cards for Filler Primitives

The wild cards allow you to set one or more out of the maximum of four 
symbols of a filler primitive as don’t care. In this case, all allowed D and K 
symbols will match and are removed from incoming DUT data.

For example:

K28.5,

Here the dot ( ) symbol will be treated as don't care.

Add Scrambler Configuration

Select the Scrambler Configuration check-box to add scrambler 
configuration to the sequence.

It allows you to:

• Reset Primitive

• Hold Primitive

• Pause Start Primitive

• Pause End Primitive

• Polynomial

• Reset After Filler Remove

• Reset Value

• Reset Value After Hold
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If the symbol width is 130, you can specify the 128B/130B coding 
configuration. Using this, you can define scrambler reset value. 

Link Training Configuration

If the symbol width is 130, you can configure the link training parameters 
to control LTSSM ((Link Training and Status State Machine). 

The following parameters can be configured as an attributes.

• DUT Type - Specifies which role the DUT should play during link 
training. It can either be an upstream device for testing a downstream 
port or vice versa. 
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• Lane - Specifies the lane number being used.

• Link - Specifies the link number being used.

• Link Equalization - Determines whether link equalization should be 
performed. It can either be aborted after phase 1 (Bypass) or fully 
executed. In the second case it can be determined whether only preset 
or all (i.e. individual cursor) requests should be accepted.

• Start Preset - Specifies the preset used by the J-BERT’s TX port after 
switching to Gen 3 operation and when operating as an upstream 
device.

• DUT Preset Hint - Specifies the preset hint being sent by the J-BERT to 
the DUT during phase 0 of the link equalization procedure. It is only 
used when the BERT operates as upstream device.

• DUT Initial Preset - Specifies the preset the J-BERT transfers to the 
DUT in phase 0 of the link equalization procedure. It is only used when 
the BERT operates as an upstream device.

• DUT Target Preset - Specifies the preset the J-BERT requests the DUT 
to switch to during link equalization. Depending on the role the J-BERT 
is playing, this is done in either phase 2 or 3 of the link equalization 
training.

• Speed Change Control - Specifies whether the speed change to Gen3 
(i.e. 8 Gbps) speed will be initiated by DUT or BERT during link training. 
It is only used when the BERT operates as a downstream device. 
If not specified DUT will initiate the speed change and will also request 
BERT for the same. It is only used for the DUT type as System Board.

• User Calibrated Presets - Specifies whether BERT's Data Out should 
use user-calibrated presets or standard presets during link training. 
Enabling it means that BERT’s Data Out will use 
de-emphasis/pre-shoot values that had been previously calibrated, 
otherwise it will use standard de-emphasis/pre-shoot values defined by 
the PCIe3 specification. By default this option is turned off which means 
that standard presets will be used.

For further details on link training for PCIe 3.0, refer to Interactive Link 
Training on page 285.
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Sequence Configuration

The sequence configuration section provides the following options:

• Sequence: Allows you to apply a sequence configuration on either 
Generator, Analyzer or user-created sequences.

• Name: Provide the sequence name.

• Locations: Specify the locations for the sequence. Use the button 
available to select the locations.

• Replicate: Select the replicate option (Serialized, Copy or Copy plus 
Phase Adjust).

• Description: Add a description to the sequence.

NOTE
Make sure not to use the unused location which are not being used in the 
test setup. However, if it is used, ensure that the 'Re-Sync' parameter of 
these locations is set to manual to reduce overall system load caused by 
unnecessary pattern re-sync attempts.
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Block Data

The Block Data section allows you to:

• Provide a block name.

• Provide a block length. 

• Select Block Type. The available options are Clock, Pulse, PRBS, 
Static, Memory Pattern and Link Training.

• For block type as Clock, you need to specify the Divider, Replicate 
and the Compare feature (refer Compare Feature on page 241).

• The Replicate feature shows how the serial patterns are split to 
multiple locations. It has the option options:
Serialize: In this a pattern is split and distributed to the locations. 
This is for the parallel side of a serial bus.
Copy: In this each location gets a copy of the pattern.
Copy Plus Phase Adjust: In this each location gets a copy of the 
pattern. Scrambler phases of the different locations are set 
differently. This is for the parallel side of a serial bus.

• For block type as Pulse, you need to specify the Width, Compare 
and Offset feature.

• For block type as PRBS, you need to specify the Polynomial, 
Replicate, Invert and Seed (Hex) feature.

The following table shows the PRBS polynomial that is used to 
generate the selected PRBS 2^n-1.
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Table 42  

• For block type as Static, you need to specify the Single Value and 
the Compare feature. 

• If you select Block Type as Memory Pattern, a Select Pattern 
window will open which allows you to load the memory patterns.

• For block type as Link Training, you need to specify the Direction.

• Click Select Location Specific Patterns. This opens with a drop-down 
selection where you can specify the ports or locations of specific 
patterns. 

PRBS Shift 
Register 
Length

Polynomial PRBS Length

 2^7-1 7 x7+x6+1 127

2^9-1 9 x9+x5+1 511

2^11-1 11 x11+x9+1 2047

2^13-1 13 X13 + X12 + X 2 + X 1 + 1 8191

2^15-1 15 x15+x14+1 32767

2^23-1 23 x23+x18+1 8388607

2^23p-1 23 x23+x21+x18+x15+x7+x2+1 8388607

2^31-1 31 x31+x28+1 2147483647

2^33-1 33 X33 + X20 + 1 8589934591 

2^35-1 35 X35 + X33 + 1 34359738367 

2^39-1 39 X39 + X35 + 1 549755813887 

2^41-1 41 X41 + X38 + 1 2199023255551 

2^45-1 45 X45 + X44 + X42 + X41 + 1 35184372088831 

2^47-1 47 X47 + X42 + 1 140737488355327 

2^49-1 49 X49 + X40 + 1 562949953421311 

2^51-1 51 X51 + X50 + X48 + X45 + 1 2251799813685247 
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• Select the ports or locations and then click Select. The settings 
option for each port or location will be added to the Block Data 
functional block.

• Click Clear if you want to remove port or location specific patterns 
and use single pattern for the block.

Compare Feature

The Compare feature allows you to compare the block data for a particular 
sequence. It provides you the freedom to modify the sequence without 
deleting the blocks. 

When to use/not use this feature

Suppose you created a sequence with multiple blocks. Now, if you want to 
exclude particular block(s) from that sequence while comparing, instead of 
deleting the whole sequence, just set the compare functionality “OFF” 
which in-turn will disable that particular block(s) from the sequence for 
comparison. 
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Block Settings

The Block Settings section allows you to:

• Click on the corresponding ON/OFF toggle button to turn on the 
following features:

• CDR

• Error Insertion

• Click on the ON/OFF toggle button to enable the block settings on the 
sequence.

• Click on the ON/OFF toggle button to turn on the Symbol Align 
feature.

• Select disparity whether positive, negative or unchanged.

• Click on the ON/OFF toggle button to turn on the Sync and Loop 
feature.

• Use the drop down option to specify whether you want to apply trigger 
on either Pulse or Pulse or PRBS Match. 

NOTE
The Sync feature will be automatically turned on once you turn on the 
Sync and Loop feature.

NOTE
The changes made in the Block Settings section are reflected on the 
selected block.
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Block Branches

The Block Branches are used to add the branches within the sequence. 
You can add up to two branches in a sequence.

To add a Block Branches, click on the Add Branch button. The Block 
Branches section will appear as shown in the following figure:

The Block Branches section provides the following settings:

• Source: Use the drop-down list to specify the source for the branch.

• Event: Specify the event for the branch.

• Go to Block: Specify the block name to jump.

• Enabled: Use the ON/OFF toggle button to enable the branching 
option.

• Click Add Branch if you want to add another branch. Up to two 
branches can be added within the same block.

• Click  Delete icon to delete the branch.

Once the branching is enabled in a block, the  Block Branches icon 
will appear on the sequence block as shown in the following figure:
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Block Controls

The Block Controls section allows you to provide sink value at Ctrl Out A 
and Sys Out A/B. These values help you to trigger the given sink at 
different values that are defined i.e. Low, High or Pulse. Press Add Control 
to add more block controls. You can add up to four block controls.

Editing a Pattern in a Sequence Editor

The Sequence Editor user interface contains Pattern Edit Pane that allows 
you to edit the memory patterns. 

Make sure to enable the Show Patterns option by clicking on the  
Show Pattern icon, present on the toolbar. This will display the Pattern 
Edit Pane, in case it is not visible in the Sequence Editor. 

To edit a pattern, you have to first load it in the sequence block. To do so:

1 Select the block on which the patterns are loaded.

2 Go to Sequence Setting window and then select Block Data functional 
block.

3 Select the Block Type as Memory Patterns. A Select Pattern window 
will open which allows you to load the memory patterns.

4 Select the desired patten and click Select.

5 The pattern will be loaded into the selected block as well as on the 
Pattern Edit Pane. See the following figure:
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6 Edit the patterns as explained in the section Pattern Edit Pane on 
page 266.

Sharing Sequences

The M8070A software currently does not allow the functionality to share 
the sequences. However, there is a workaround to share sequences.

Follow the given steps:

1 Go to File > and click Save Instrument State... Once you save the 
instrument state, the sequence settings are also saved in the Settings 
folder which is created at the following path:

“Documents\Agilent\M8070A\Workspaces\Default\User\Settings”

2 Share Settings folder. 

3 Copy the Settings folder at the same path on another system.

4 Go to File > and click Recall Instrument State.... The sequences will 
now appear in the Sequence Editor.
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User-Defined Sequences

This section describes the basics of user-defined sequences.

A sequence is created and maintained by means of the Sequence Editor. A 
sequence consists of up to 500 blocks that can be looped. Each block can 
generate a pause signal (constant 0 or 1), a divided clock signal, a 2^n -1 
PRBS, or a user pattern.

Single or multiple blocks can be looped. The sum of the blocks and the 
counted loops must not exceed 500. An overall loop restarts the sequence 
after it has come to its end.

Sequence Block Display

A new sequence consists of one block that is infinitely repeated (looped). 
By default, this block has a length of 512 bits and generates a Pause 0 
signal (a continuous stream of zeros). All this is shown on the display.

Sequence Block Parameters

The Sequence Setting window allows you to change the contents and the 
trigger generation of a sequence block.

Choices are:

• Block No. - Can be up to 500 blocks.

• Length - This is the length of the pattern in bits for a standard pattern 
of 128 bits.

• Block Type - Clock, PRBS, Pulse, Static or Memory Patterns. 

• PRBS - You can choose a PRBS of polynomial 2^n -1. The range of "n" 
is 7, 10, 11, 15, 23, or 31. You can change the block length, if desired.

• Divided Clock: You can use this option to generate the signal at every 
nth clock pulse.

• Memory Pattern: When you select pattern type as memory pattern, a 
Select Pattern dialog will appear. You have to locate the pattern file 
and then click OK. The patterns will be loaded in the sequence.
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Select Sequence Pattern Dialog

The Select Sequence Pattern dialog allows you to override all sequence 
with a single block loop. This operation will download the new sequences. 
If the Sequence Editor is already opened, then changes made in the 
Sequence Editor will not be saved.

This dialog allows you to select pattern for the block from the following 
options:

• Clock

• Pulse

• PRBS

• Static

• Memory

Select the check box if you wish to open the Sequence Editor with the 
selected patterns. 
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Click Apply to apply the changes. 

However, when the Memory option is selected the Apply button changes 
to Select Memory Pattern… button. 

When you click this button, the Select Pattern dialog will appear.   
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Once you select the pattern in Select Pattern dialog, click Create 
Sequence button to create the new sequences. 
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Pattern Editor 

The pattern editor provides an interactive user-interface for creating, 
editing and importing the patterns.

How to Launch Pattern Editor

To launch the Pattern Editor:

• Go to the Menu Bar > Patterns and then select Pattern Editor.

The Pattern Editor will appear as shown in the following figure:

The Pattern Editor user interface includes the following elements:

• Toolbar 

• Settings Window

• Pattern Edit Pane
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Toolbar

The toolbar provides the following convenient pattern editing functions:

Table 43  

Elements Name Description

New Click this icon to create a new pattern. For details, refer to 
Creating New Patterns on page 253

Open Click this icon to open a pattern from a file. For details, 
refer to Opening Existing Patterns on page 254

Save Click this icon to save the current pattern. For details, refer 
to Saving Patterns on page 256.

Save As Click this icon to change the properties of current pattern 
and then save it under different name. For details, refer to 
Saving Patterns on page 256.

Import Click this icon to open J-BERT Pattern dialog. You can 
import the patterns from J-BERT. For details, refer to 
Importing Patterns on page 259.

Export Click this icon to export patterns in the desired location. 
These patterns can be used by other instruments for it for 
testing and analysis. For details, refer to Exporting 
Patterns on page 260.
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The Pattern Editor allows you to perform following tasks on patterns:

• Create a new patterns. For details, refer to Creating New Patterns on 
page 253.

• Open and already existing patterns. For details, refer to Opening 
Existing Patterns on page 254.

• Save a patterns. For details, refer to Saving Patterns on page 256.

• Import supported patterns. For details, refer to Importing Patterns on 
page 259.

• Perform block edit operations. For details, refer to Interactive Link 
Training on page 285.

• Edit a patterns on Pattern Edit Pane. For details, refer to Pattern Edit 
Pane on page 266.

Copy These functions follow Microsoft Windows copy/paste 
functionality. You can perform the copy/paste operations 
in the following ways:
• Click on Copy/Paste icons
• Use keyboard shortcuts (Ctrl+C, Ctrl+V)
• Right click and use the context menu options
The Copy/Paste function allows you to:
• Select either the partial data or the complete symbols 

in a pattern and copy/paste it anywhere in the pattern.
• Use the copy/paste operations for the partial data 

across multiple instances of Pattern Editor, 
irrespective of the pattern coding.

• Use the paste operation to and from clipboard to 
Pattern Editor.

Please note that the paste operations for the complete 
pattern symbol is only allowed in the same pattern symbol 
coding.
This icon is only available when the partial data is copied 
from the pattern. Whenever a paste operation is done 
using this function, the underline data will be pasted. 

Paste as String

Paste as Data

Select All Click this icon to select all the symbols in the pattern.

Block Edit Click this icon to perform block edit operations on 
currently selected pattern. For details, refer to Block 
Edit Operations on page 261.

Elements Name Description
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Creating New Patterns

To create a new pattern:

1 Click the  New icon present on the tool bar. This opens with the 
Create New Pattern sliding window as shown in the following figure:

2 Select the coding type. The Pattern Editor currently supports the 
following types of coding:

• Bit (Binary)

• 8B/10B

• 128B/130B

• 128B/132B

3 Specify the number of symbols. Use the UP and DOWN button to 
increase or decrease the number of symbols.

4 Specify the fill patterns. 

5 Specify by using the ON/OFF toggle switch whether you want to use 
Mask and Squelch (Electric Idle). In Squelch, the amplifier output is 
zero. 

6 After you have entered these parameters, click Create. The newly 
created pattern will appear in the Pattern Editor pane.
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7 Click the  Save icon to save the pattern. For more details, refer to 
Saving Patterns on page 256.

Opening Existing Patterns

To open an existing user pattern:

1 Click the  Open icon present on the tool bar. 

This opens the Open Pattern dialog, where you can locate and open 
the desired pattern. You can even perform the operations such as 
renaming and deleting the pattern file and creating new folders.
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You can select the pattern from the following default folders:

1 Shared: Patterns that are shared between settings.

2 Current: Patterns that are local to current setting.

3 Factory: Factory supplied standard patterns. These patterns are 
read only and cannot be modified.

2 Click Open to load the patterns. 

3 To rename a file, select the file and click Rename. The filename will 
become editable.

4 To delete a file, select the file and click Delete.

5 To add new folder, select location you want to create your folder and 
then click New Folder. 

6 To rename a folder, select the folder and click Rename. The folder 
name will become editable.

7 To delete a folder, select the folder and click Delete.
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Saving Patterns

To save the current user pattern:

1 Click the  Save icon present on the tool bar. A Save Pattern dialog 
will appear which allows you to save the patterns under the defined file 
name and location. 

You can use the Save Pattern dialog to perform the operations such as 
renaming and deleting the patterns. You can even create a new folder 
or save the patterns in the Current or Shared folders. The current 
folder is for current users while the shared folder is accessible by all 
users. If the pattern has already been saved earlier, the saved file will 
be updated. 
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2 Click on the  Save As icon if you wish to change the properties of 
current pattern and then save it under different name. The current 
pattern can be either a non-captured pattern or a captured pattern. 

a For saving a non-captured pattern, a Select Pattern Properties 
dialog will appear. This dialog provides the following options: 

• Make a copy of current pattern with no change in pattern properties.

• Change the properties of current pattern. Using this option, you can 
change the pattern coding and enable/disable Mask and Squelch.

b For saving a captured pattern, a Select Captured Pattern 
Properties dialog will appear. This dialog provides the following 
options: 
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• Change the properties of current pattern. Using this option, you can 
change the pattern coding and enable/disable Mask, Squelch and 
Error as Mask.

The Use Error As Mask option is only visible when the Use Mask option 
is enabled and coding is same as captured pattern.

• Change the properties of current captured pattern. Using this 
option, you can change the pattern coding and enable/disable 
Mask, Squelch and Error as Mask.

• Click Override to remove all errors from the pattern.

3 Press Save As... button. A standard Save As Pattern dialog box will 
appear. 

4 Specify the name and location and click Save.
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Importing Patterns

The M8070A Pattern Editor allows you to import the J-BERT N4903B 
patterns, edit them and use it for testing and analysis.

 

To import a pattern:

1 Click the  Import icon. This opens the Select J-BERT Pattern 
dialog, where you can locate the J-BERT N4903B pattern. You are 
allowed to import patterns with any file extension.

2 Select the JBERT pattern and click Open in the Select J-BERT Pattern 
dialog. An Import Pattern dialog will appear as shown in the following 
figure: 

3 Choose a location (shared or current) to save the pattern. You can also 
create a new folder.

NOTE
The length of J-BERT N4903B pattern format (Version=EPA 2.0) is 
limited to 4194304 bytes (33554432 bits). However, M8070A pattern 
format (Version=M8000 1.0.0) can be much longer and has a different 
header.
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4 Provide a file name and click Import. The imported patterns will appear 
in the Pattern Edit Pane.

5 You can use the Import Pattern dialog to perform the operations such 
as renaming and deleting the patterns. 

Exporting Patterns

The M8070A Pattern Editor allows you to export patterns and use it for 
testing and analysis.

To export a pattern:

1 Click the  Export icon. This opens the Select Pattern to Export 
dialog. 

2 Select the pattern and click Export. This opens the Export Pattern 
dialog.
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3 Locate the path and file name for the .prtn file.

4 Click Save to export the data to the specified destination.

Sharing Patterns

You can share patterns to other users by exporting the pattern to a shared 
location and later importing that pattern to Pattern Editor. For details on 
how to export and import patters, refer to Exporting Patterns on page 260 
and Importing Patterns on page 259.

Block Edit Operations

The Block Edit window provides an easy way to modify parts of the pattern 
or the entire pattern at once. This can be used when setting up a new 
pattern. It can also be used as an optional technique for editing existing 
patterns. 

Click on the  Block Edit icon present on the toolbar. The Block Edit 
sliding window will appear as shown in the following figure:
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With the Block Edit window, you can use the drop-down list to specify 
whether the block edit operation has to be performed on data or listed 
attributes. You can also define the range that is to be modified. The 
available options for the range are:

• All

Choose this option to edit the entire pattern.

• All

Choose this option to edit the entire pattern.

• Range

Choose this option to select the range of symbols entered in the From 
and To fields.

The Block Edit window contains the following tabs:

• Fill

This tab allows filling the given range in the pattern with the specified 
value. The available options for the Fill tab are:

• Fill Pattern

Fills the specified value to the given range in the pattern. 

• Invert 

Invert the bits. 0 becomes 1 and 1 becomes 0.

• Rotate

This tab provides the following options:
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• Rotate Symbol Left by: 

Treats the pattern data in the specified range as a circular buffer and 
rotates the bits to the left by the specified amount. No data will be lost 
and what is at the start of the buffer will be at the end of the buffer 
after the rotation.

• Rotate Symbol Right by:

Treats the pattern data in the specified range as a circular buffer and 
rotates the bits to the right by the specified amount. No data will be 
lost and what is at the end of the buffer will be at the start of the buffer 
after the rotation.

• Align to Sequence:

Aligns the pattern data in the specified range to a specified pattern 
sequence.

Settings Window

The Settings Window allows you to set the visualizations of the currently 
selected patterns. This helps you to easily identify the data and attributes 
in the pattern. 

The Settings Window provides the following options:

Data View

The Data View option allows you to set the following:

• Data View Mode - Select the data view mode as Bin, Hex or PAM4.

• Show High Low - Toggle the ON/OFF switch to display either high or 
low transition in the patterns. This option is only available in Bit coding. 

• Show Continuous Stream - Toggle the ON/OFF toggle switch to show 
continuous stream in the patterns. This option is only available in Bit 
coding.
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Colors

The Colors option allows you to set the following:

• Background Color - Changes the background color of the pattern 
editor pane.

• Caret Color - Changes the color of the carat in the pattern.

• Zero Color - Changes the color of all occurrences of zeros (0) in the 
pattern.

• One Color - Changes the color of all occurrences of ones (1) in the 
pattern.

• Transition Color - Changes the transition color in the pattern.

• Mask Color - Changes the color of the bits that are masked.

• Squelch Color - Changes the color of the bits that are squelch.

• Attribute 1 Color - Changes the color of attribute 1.

• Attribute 0 Color - Changes the color of attribute 0.

You can at anytime reset the color settings to default colors by pressing 
the Reset to Default Colors button.
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Visuals

The Visual option allows you to set the following:

• Data - Changes the data appearance as selected from the data visual 
options.

• Attributes - Changes the attribute appearance as selected from the 
attributes visual options.
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The pattern edit pane displays the pattern and also allows you to edit it.

The pattern edit pane shows the symbol and data. You can edit selected 
data using the keyboard keys. Remember, the pattern edit pane does not 
allow you to enter any wrong data.

The pattern edit pane also allows the copy/paste functionality. Once you 
select the symbols in a pattern, you can copy them and paste it anywhere 
in the pattern. You can perform the copy/paste operations in the following 
ways:

• Click on Copy/Paste icons

• Use keyboard shortcuts (Ctrl+C, Ctrl+V)

• Right click and use the context menu options

Please note that the copy operation only allows a complete symbol to be 
copied. 

It is possible to use the copy/paste operations across multiple instances of 
Pattern Editor window with same pattern coding.
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Patterns consist of a sequence of symbols. A symbol can have the 
following type of coding:

1 Bit (Binary)

2 8B/10B

3 128B/130B 

4 128B/132B

The following figure shows the Pattern Edit Pane with a bit coded pattern 
(Binary) pattern:

The bottom of the Pattern Editor Pane indicates the position of the 
selected symbols and buttons to edit them. These buttons are only 
available when you create a pattern in bit coding and the data view mode 
is binary (BIN). You can use these buttons to:

0 - Set data 0

1 - Set data 1.

X - Click this toggle button to add/remove mask on a data.

S - Click this toggle button to add/remove squelch on a data.

You can use the  buttons as well as the keyboard keys to 
move the pointer position to the left, right, up and down in the pattern.
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In binary mode, when you click on any symbol, its position is displayed as 
following:

• The top of the Pattern Editor Pane displays the index of cursor (symbol) 
in current row.

• The bottom of the Pattern Editor Pane displays the symbol number.

The following figure shows the Pattern Editor Pane with a symbol coded 
(8B/10B) coded pattern:

You can use the Settings Window to enhance the visualizations of the 
current pattern. For details, refer to “Settings Window” on page -263.

Symbol Attributes

A symbol can have additional attributes to modify behavior. They are 
supported by all symbols. These are:

1 Mask: This attribute only affects the Data In ports. It specifies if the 
symbol is actually compared or masked (excluded from compare). 

2 Squelch: This attribute only affect the Data Out ports. If this attribute 
is 1, a squelch (out of band) level is used.

In addition there are coding specific attributes, to control aspects of the 
coding like bypassing or using a scrambler.
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Editing a Pattern

To edit a pattern:

1 Open an already existing pattern. Refer to Opening Existing Patterns 
on page 254.

2 If no pattern is available, a new pattern can be created. Refer to 
Creating New Patterns on page 253. 

3 Select the bits to be edited in the patterns 

4 Use the keyboard to enter the required bits. It can be in form of 0 or 1.

Editing a Captured Pattern

To edit a captured pattern, it needs to be converted to an editable pattern. 
Follow the given steps make the captured pattern editable:

1 Open an already saved captured pattern. Refer to Opening Existing 
Patterns on page 254.

2 Select the bits to be edited in the patterns 

3 Use the keyboard to enter the required bits. It can be in form of 0 or 1. 
A Select Captured Properties dialog will appear:

4 Change the properties of current pattern. Using this option, you can 
change the pattern coding and enable/disable Mask, Squelch and 
Error as Mask.

The Use Error As Mask option is only visible when the Use Mask option 
is enabled and coding is same as captured pattern.

5 Click Override to remove all errors from the pattern.
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6 Click Save As. A Save Pattern As dialog will appear. 

7 Specify the name and location and click Save.

Bit Coding

The following figure shows the pattern edit pane with a bit coded pattern 
in binary (BIN) mode:

The bottom of the pattern edit pane indicates the position of the selected 
symbols and buttons to edit them. These buttons are only available when 
you create a pattern in bit coding and the data view mode is binary (BIN). 
You can use these buttons to:

0 - Set data 0

1 - Set data 1.

X - Click this toggle button to add/remove mask on a data.

S - Click this toggle button to add/remove squelch on a data.

You can use the  buttons as well as the keyboard keys to 
move the pointer position to the left, right, up and down in the pattern.

The bottom of the pattern edit pane also displays the symbol number 
which indicates the number.

You can use the Settings Window to enhance the visualizations of the 
current pattern. For details, refer to “Settings Window” on page -263.



Keysight M8070A User Guide 271

Setting up Patterns 7

 

To encode a bit coded symbol 1, 2 or 3 bits are needed. This depends on 
the use of mask and squelch:

Table 44  Plain bit coding without using mask or squelch

Table 45  Mask is used

Table 46  Squelch is used

Table 47  Mask and Squelch are used

Bit offset range Bit (range) name Description

0 Data Data bit

Bit offset range Bit (range) name Description

0 Data Data bit

1 Mask Mask (ignored on DataOut)

Bit offset range Bit (range) name Description

0 Data Data bit

1 Squelch Squelch (ignored on DataIn)

Bit offset range Bit (range) name Description

0 Data Data bit

1 Mask Mask (ignored on DataOut)

2 Squelch Squelch (ignored on DataIn)
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8B/10B Coding

The following figure shows the pattern edit pane with a 8B/10B coded 
pattern:

You can use the Settings Window to enhance the visualizations of the 
current pattern. For details, refer to Settings Window on page 263.

This type of pattern contain:

• Symbol: 8B/10B coding have 8 bits in one symbol.

• Attributes: It has the following attributes:

• Mask - This attribute only affects the Data In ports. 

• Squelch - This attribute only affects the Data Out ports. 

• Scrambler Enable - This attribute enables/disables the scrambler.

• Scrambler Pause - This attribute is used to pause scrambler for 
some special symbol.

• Scrambler Reset - This attribute is used to reset scrambler LFSR 
(Linear feedback shift register).

• Start of frame - This attribute enables/disables the start of frame 
marker.

• K/D - This attribute specifies whether the symbol bits are control 
characters or data. 

• Data - Specifies data bits.
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To encode an 8B/10B symbol, 16 bits (2 bytes) are used:

Table 48  

Bit offset range Bit (range) name Description

7:0 Data Symbol data

8 K/D 0 = D-character, 1 = K-character

9 Reserved for future use. Must be set to 0

10 Mask Mask (if present, ignored on DataOut)

11 Squelch Squelch (if present, ignored on DataIn)

12 Enable Scrambler Enable Scrambler (ignored on DataIn)

13 Pause Scrambler Pause Scrambler (ignored on DataIn)

14 Reset Scrambler Reset Scrambler (ignored on DataIn)

15 Start of Frame Start of Frame (ignored on DataOut)
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128B/130B Coding

The following figure shows the pattern edit pane with a 128B/130B coded 
pattern:

You can use the Settings Window to enhance the visualizations of the 
current pattern. For details, refer to Settings Window on page 263.

This type of pattern contain:

• Symbol: 128B/130B coding having 128 bit in one symbol.

• Attributes: It has the following attributes:

• Mask - This attribute only affects the Data In ports. 

• Squelch - This attribute only affects the Data Out ports. 

• Scrambler Enable - This attribute enables/disables scrambler.

• Scrambler Pause - This attribute is used to pause the scrambler for 
some special symbol.

• Scrambler Reset - This attribute is used to reset the scrambler LFSR 
(Linear feedback shift register).

• Scrambler Bypass - This attribute is used to bypass the scrambling 
over the symbol.

• Scrambler Bypass Byte 0 - If this bit is enabled, it does not allow 
scrambling over the symbol.

• Do DC Balancing - This attribute is used to set DC balancing over 
symbol.



Keysight M8070A User Guide 275

Setting up Patterns 7

 

• Reset DC Balancing - This attribute resets the DC balancing state.

• Send Scrambled State - This attribute specifies whether to send the 
scrambled state.

• Reset Parity - This attribute is used to reset the parity bit.

• Pause Parity - This attribute is used to pause the parity bit.

• Start of frame - This attribute enables/disables the start of frame 
marker.

• Framing - This attribute enables/disables the start of frame marker.

• Data - Specifies the data bits.

To encode a 128B/130B symbol, 144 bits (18 bytes) are used:

Table 49  

Bit offset range Bit (range) name Description

1:0 Framing Framing bits

129:2 Data Data

130 Mask Mask (if present, ignored on DataOut)

131 Squelch Squelch (if present, ignored on DataIn)

132 Reset Scrambler Scrambler reset (ignored on DataIn)

133 Pause Scrambler Scrambler pause (ignored on DataIn)

134 Bypass Scrambler Scrambler bypass

135 Bypass Byte 0 
Scrambler

Scrambler bypass byte 0

136 Do DC Balancing Do DC balancing (ignored on DataIn)

137 Reset DC Balancing Reset DC balancing (ignored on DataIn)

138 Send Scrambler 
State

Send scrambler state (ignored on DataIn)

139 Reset Parity Reset Parity (ignored on DataIn)

140 Pause Parity Pause Parity (ignored on DataIn)

141 Start of Frame Start of Frame (ignored on DataOut)

143:142 Reserved for future use. Must be set to 0



276 Keysight M8070A User Guide

7 Setting up Patterns
 

128B/132B Coding

The following figure shows the pattern editor pane with a 128B/132B 
coded pattern:

You can use the Settings Window to enhance the visualizations of the 
current pattern. For details, refer to Settings Window on page 263.

This type of pattern contain:

• Symbol: 128B/132B coding having 128 bit in one symbol.

• Attributes: It has the following attributes:

• Mask - This attribute only affects the Data In ports. 

• Squelch - This attribute only affects the Data Out ports. 

• Scrambler Reset - This attribute is used to reset the scrambler LFSR 
(Linear feedback shift register).

• Scrambler Pause - This attribute is used to pause the scrambler for 
some special symbol.

• Scrambler Bypass - This attribute is used to bypass the scrambling 
over the symbol. If this bit is enabled, it will not allow scrambling 
over the symbol. 

• Scrambler Bypass Byte 0 - If this bit is enabled, it does not allow 
scrambling over the symbol.
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• Do DC Balancing - This attribute is used to set DC balancing over 
the symbol.

• Reset DC Balancing - This attribute resets the DC balancing state.

• Send Scrambled State - This attribute specifies whether to send the 
scrambled state.

• Reset Parity - This attribute is used to reset the parity bit.

• Pause Parity - This attribute is used to pause the parity bit.

• Start of frame - This attribute enables/disables the start of frame 
marker.

• Framing 0 1 2 3 - This attribute enables/disables the start of frame 
marker.

• Data - Specifies the data bit.

You can edit selected data using the keyboard.

To encode a 128B/132B symbol, 144 bits (18 bytes) are used:

Table 50  

Bit offset range Bit (range) name Description

3:0 Framing Framing bits

131:4 Data Data

132 Mask Mask (if present, ignored on DataOut)

133 Squelch Squelch (if present, ignored on DataIn)

134 Reset Scrambler Scrambler reset (ignored on DataIn)

135 Pause Scrambler Scrambler pause (ignored on DataIn)

136 Bypass Scrambler Scrambler bypass

137 Bypass Byte 0 
Scrambler

Scrambler bypass byte 0

138 Do DC Balancing Do DC balancing (ignored on DataIn)

139 Reset DC Balancing Reset DC balancing (ignored on DataIn)

140 Send Scrambler 
State

Send scrambler state (ignored on DataIn)
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141 Reset Parity Reset Parity (ignored on DataIn)

142 Pause Parity Pause Parity (ignored on DataIn)

143 Start of Frame Start of Frame (ignored on DataOut)

Bit offset range Bit (range) name Description
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Pattern Capture

The M8020A/M8030A Analyzer captures the data received from the device 
under test. The captured data bits are displayed in the pattern capture 
pane in binary or 8b/10b symbol coding. The received data is compared 
with the expected data and the errored bits/symbols are highlighted. The 
captured data can be saved for post processing. The maximum capture 
memory is 
2 Gb. However, it also depends on the holdoff length which represents the 
amount of symbols in which the trigger events will be ignored.

How to Launch Pattern Capture Window

To launch the Pattern Capture window:

• Go to the Menu Bar > Patterns and then select Pattern Capture.

The Pattern Capture window will appear as shown in the following figure:

The Pattern Capture window includes the following elements:

• Toolbar

• Pattern Captured Pane

• Captured Results

• Parameters Window
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Toolbar

The toolbar provides the following convenient pattern capture functions:

Table 51  

Elements Name Description

Start Starts capturing the current pattern

Stop Stops capturing the current pattern

Reset Resets the values of acquisition parameters

Manual Trigger Manually starts the event that is triggering the capture 
logic.

Save Captured 
Data

Opens the “Save As” dialog which allows to save the 
captured data patterns as a separate pattern in the 
workspace (shared/current).

Copy Copies the selected data.

Save all 
Analyzers 
Captured Data

Opens the “Save As” dialog which allows to save all 
analyzers captured data patterns as a separate pattern in 
the workspace. This button will only be available when 
data acquisition is perform using the location group. 

Error 
Navigation 
Buttons

• First Error - Takes to the first errored bit in the 
captured pattern.

• Previous Error - Takes to the previous errored bit 
before the current one in the captured pattern.

• Next Error - Takes to the next errored bit after the 
current one in the captured pattern.

• Last Error - Takes to the last errored bit in the 
captured pattern.
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Parameters Window

The Parameters window have the following acquisition and show 
parameters for pattern capture.

Acquisition Parameters

• Analyzer - Use this drop-down menu to select the channel against 
which the data capture has to be performed.

• Trigger -Selects the event that is triggering the captured logic. It can 
be captured on the following four stop events: 

• Immediately – Starts capturing the data immediately and displays 
the captured data.

• Error – Starts capturing the data when it receives an errored bit and 
displays the captured data.

• CTRL IN A – Waits for a trigger signal from CTRL IN A port and 
displays the captured data.

• CTRL IN B – Waits for a trigger signal from CTRL IN B port and 
displays the captured data.

• Slope - Selects the edge (rising edge or falling edge) of CTRL IN A or 
CRL IN B that is triggering the captured logic. 

• Holdoff - Defines the minimum of data bits to capture before the 
trigger event occurs. This value is adjusted to a multiple of the current 
symbol granularity.

• Capture Depth - Defines the minimum of data bits to capture including 
holdoff. This value is adjusted to a multiple of the current symbol 
granularity. 

Show Parameters

• View Bit Pattern As - Displays the captured bit coed pattern in Binary, 
Hex or Symbol view.

• View Coded Pattern As - Display the coded pattern (8B/10B) in Binary, 
Hex or Symbol view.

How to Capture a Pattern

The following example explains the steps to capture a pattern to display 
errored bits.

1 Switch to Parameters window.

2 Set the acquasation parameters are shown below:
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• Location: M1.DataIn1

• Trigger: Error

• Holdoff: 500

• Capture Depth: 10000

3 Click Start button. A message “Waiting for Trigger” will appear. You 
can click Manual Trigger to manually trigger the captured logic.

4 The captured data will be displayed in the Pattern Captured pane. The 
errored bits are marked red as shown in the following figure:

Pattern Capture Pane

The Pattern Capture Pane displays the captured pattern in the binary or 
8b/10b symbol coding. 

The errored bits in the captured patterns are marked red. You can use the 
 Error Navigation buttons to jump to next, previous, first or 

last error.
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Please note that the Pattern Capture pane does now allow to editing 
feature. This means you cannot edit the captured pattern. However, if you 
want to edit a captured pattern, you have to first save it and then open in 
the Pattern Editor. For details on how to edit pattern, refer to Editing a 
Pattern on page 269. Using a Pattern Editor, you can also save the results 
in different encoding schemes.

Saving a Captured Pattern

You can save the captured pattern for post processing. To do so;

• Click Save icon. This will open a Save Captured Pattern dialog. 

• Specify the folder where it will be saved. 

• Enter a file name and click Save. The current pattern will be saved 
under the filename. 

You can open the saved file it in the Sequence Editor and then download it 
to module to create a sequences. For details, refer to Sequence Editor on 
page 227.
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Capture Results Pane

The Capture Results pane displays the results of the patterns captured.

The results are summarized as following:

• Location - Displays the location on which pattern capture is performed.

• Capture Status - Displays the current status of the capturing event as 
‘Finished’, ‘Stopped’ or ‘Waiting for Trigger’.

• First Error - Displays the position of first error bit.

• Last Error - Displays the position of last error bit.

• Errors Count - Displays the total number of errored bits.

• Holdoff - Displays the minimum number of data bits to capture before 
the trigger event occurs.

• Capture Depth - Displays the minimum number of data bits to capture 
including holdoff.
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Interactive Link Training

PCI Express 3.0 Testing

It provides the following types of testing:

• Transmitter Testing for PCIe 3.0

• Receiver Jitter Tolerance Testing for PCIe 3.0

• Tx/Rx Link Equalization Testing for PCIe 3.0

• PLL Loop Bandwidth Testing for PCIe

• Differential Impedance Testing

LTSSM (Link Training and Status State Machine)

Link Training and Status State Machine (LTSSM) is the sub-block that 
drives and controls the link initialization, and training process for a PCIe 
device to enable the normal data exchange between the two devices over 
the link. LTSSM operates at the physical layer level and exchanges 
physical layer packets (Ordered sets such as TS1 and TS2) to initialize, 
train, and manage the link.

Two PCIe 3.0 instruments exchange Training Sequences as shown in the 
following diagram:

Training Sequences are also used to switch the link to low power states.

LTSSM States

LTSSM transits through various states and substates during link 
initialization, training, and management. The entry and exit of each of 
these states and the exchange of packets (Ordered sets) between the two 
devices during each state is as per the PCIe specifications.

As per the PCIe specifications, LTSSM has 11 states and further 
sub-states. These states are referred to frequently in this chapter to 
describe LTSSM testing using the Keysight LTSSM Tester tool. Following is 
a list of these states followed by a diagram to illustrate the sequence of 
these states as per the PCIe specifications.

Device A Device B

TS TS TS TS

TS TS TS TS
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• Detect

• Quiet

• Polling

• Configuration

• L0

• Recovery

• L0s

• L1

• L2

• Hot Reset

• Disabled

• Loopback

The following figure displays the top-level states of LTSSM.
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The Link Training starts in state “Detect”. The purpose of this state is to 
detect when a far end termination is present. In the “Polling” state, bit lock 
and Symbol lock are established and Lane polarity is configured. In 
“Configuration”, both the Transmitter and Receiver are sending and 
receiving data at the negotiated data rate. In “Recovery”, both the 
Transmitter and Receiver are sending and receiving data using the 
configured Link and Lane number as well as the previously supported data 
rate(s). An active link that can transport transaction layer packets is in 
state “L0”. All power management states are entered from this state.

The intent of the “Disabled” state is to allow a configured Link to be 
disabled until directed or Electrical Idle is exited (i.e., due to a hot removal 
and insertion) after entering “Disabled”. The “Loopback” is intended for 
test and fault isolation use. 

LTSSM Tests for PCIe 3.0

You can execute the following types of LTSSM tests for PCIe 3.0:

Table 52  

Test Number Test Name

2.3 Add-in Card Transmitter Initial Tx EQ Test for 8.0GT/s

2.4 Add-in Card Transmitter Link Equalization Response Test for 8GT/s

2.7 System Board Transmitter Link Equalization Response Test for 8GT/s

2.10 Add-in Card Receiver Link Equalization Test for 8GT/s

2.11 System Board Receiver Link Equalization Test for 8GT/s
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Test Setup

The following block diagram shows the setup for test 2.3:

The following block diagram shows the setup for test 2.4:

CBBRiser Card
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Power 
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The following block diagram shows the setup for test 2.7:

The following block diagram shows the setup for test 2.10:

CLBTx

M8041A
Data Out Data In Ctrl Out
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Power 
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The following block diagram shows the setup for test 2.11:

Link Training Configuration

You can configure the link training parameters to control LTSSM using the 
Sequence Settings window. For details on link training parameters, refer 
to Link Training Configuration on page 236.

Test Procedure

Follow the given steps to perform link training for test 2.3:

1 In the M8070A software load the instrument state PCIe_PHY2.3_Test.

2 Power on the DUT.

3 Enable the Outputs of the M8041A.

4 Reset the DUT by pressing the reset button on the CBB.

5 With this setup everything is prepared for capturing the data for the P0 
preset. Hit the Break button in the Sequence Editor to start the link 
training. If link training was successful the Status Indicator should 
show that the sequencer of the generator is executing block 4 or 5 and 
that there are no bit errors.

6 Set up the oscilloscope. 

7 For shutting down the PCIe link hit the Break button again. The 
sequencer of the generator should return to block 2.

8 Before taking the measurement for P1 the test pattern has to be 
changed. For this select block 4 of the generator sequence. Under 
Sequence Settings > Block Data change the memory pattern to 
compliancePatternHeaderP1Lane0. This pattern can be found in the 

CLBTx

M8041A
Data Out Data In Ctrl Out

Trig outRef Clk In

DUT

RxClk Out
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Current directory. Not changing the pattern will cause the SIG test 
software to show the wrong preset number, but won’t affect the test 
results otherwise.

9 Do the same for block 4 of the error detector sequence.

10 Under Sequence Settings > Instrument Configuration > Link Training 
PCIe 3.0 change the DUT Initial Preset to P1.

11 Download the changed sequence.

12 Repeat the test as for P0 and then repeat the test procedure for P2 
through P9.

13 Start the SIG software and load all captured files into the Preset Test.

Link Training Log

The Show Link Training Log window displays the log generated while 
initiating the link training test. All information regarding the executed tests 
and their status are displayed with the date and time stamp. This helps to 
identify the root cause of a problem. For instance, the Show Link Training 
Log shows test failure due to an unexpected LTSSM state change. 

The following figure shows the log generated by the Show Link Training 
Log window.

You can open/close the Show Link Training Log window by clicking on the 
Show Link Training Log icon present in the status bar. The Show Link 
Training Log  icon with orange background indicates an update or new 
entry in the link training log.
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User Calibrated Presets

It specifies whether BERT's Data Out should use user-calibrated presets or 
standard presets during link training. Turning it on means that BERT’s 
Data Out will use de-emphasis/pre-shoot values that had been previously 
calibrated, otherwise it will use standard de-emphasis/pre-shoot values 
defined by the PCIe3 specification (defined below). By default this option is 
turned off which means that standard presets will be used.

The following table shows standard preset from PCIe3 specification:

Preset Number De-emphasis (dB) Preshoot (dB)

P0 -6.0 0.0

P1 -3.5 0.0

P2 -4.5 0.0

P3 -2.5 0.0

P4 0.0 0.0

P5 0.0 2.0

P6 0.0 2.5

P7 -6.0 3.5

P8 -3.5 3.5

P9 0.0 3.5
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Overview

The M8070A software provides the following measurements:

• Error Ratio

• Output Timing

• Output Level

• Jitter Tolerance

• Eye Diagram 
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Exploring Measurement User Interface

This section describes the functionality provided by the measurement user 
interface. 

Launching the Measurement User Interface

To launch the measurement user interface:

• Go to the Menu Bar > Measurements and then select the respective 
measurements (Error Ratio, Output Timing, Output Level or Jitter 
Tolerance) to launch the measurement user interface.

The following figure shows the measurement user interface:

The measurement user interface has the following GUI elements which are 
common to all measurements:

• Toolbar

• Status Indicator

• Measurement History Pane

• Measurement Graph

• Parameter Window

• Calculated Results Pane
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Lets discuss these GUI elements in the following sections.

Toolbar

The toolbar contains the following icons:

Table 53  

Elements Name Description

Start 
/Continue 
Measurement

Starts a measurement.

Break 
Measurement

Halts the measurement at that point. Once paused, you 
can continue the measurement again by pressing Continue 
Measurement icon.
Note: This option is not available in Error Ratio 
Measurement.

Stop 
Measurement

Stops the measurement.

Step Into 
Measurement

Steps further into the measurement.
Note: This option is not available in Error Ratio 
Measurement.

Enable/Disable 
Measurement 
Run History

Enables or disables the measurement run history. For 
details, refer to Measurement History Window 
on page 297. 

Clear 
Measurement 
History

Clears the measurement run history.

Copy 
Measurement 
History 
Properties

Copies the measurement history properties to the currently 
running measurement.

Reset 
Measurement

Resets the measurement to its default values.
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Status Indicator

The status indicator shows the current state of a measurement. There can 
be various states of a measurement, depending on the type of 
measurement. These may be as follows:

• Not Started: Indicates that the measurement has not yet started.

• Running: Indicates that the measurement is currently running.

• Stop: Indicates that the measurement is stopped.

• Error: Indicates an error while executing the measurement which is 
caused due to invalid parameter settings.

• Suspended: Indicates that the measurement is suspended.

• Finished: Indicates that the measurement is completed.

The following figure shows the status indicator while the measurement is 
running:

Measurement History Window

The Measurement History window maintains the history of executed 
measurement along with their time stamp. This allows you to refer to the 
previously run measurements and compare their results. 

The Measurement History window is shown in the figure below:

Click the  icon to toggle between the enable/disable measurement run 
history in the Measurement History window.
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Copy Measurement History Properties

This feature allows you to copy the properties of run measurement to 
currently running measurement. 

To do so, 

• Select a measurement history from the list shown in the Measurement 
History window.

• Click the  Copy Measurement History Properties icon. The 
properties of the selected measurement will be copied to the current 
measurement. 

Measurement Graph

The Measurement Graph displays the calculated graph and results.

The following figure displays the Measurement Graph of the Output 
Timing Measurement.
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The Measurement Graph contains the following tabs:

• Graph: Displays the graphical representation of the measurement. The 
graph varies from measurement to measurement. The details of each 
measurement graph are further described in their respective sections.

• Location: Displays the raw measurement data for that location. 
However, if you are running measurement for a group, multiple tabs will 
appear that display the raw measurement for each location.

When you right-click on the Measurement Graph, a context menu 
appears which provides the following options:

• Turn ON/OFF Fit to view (Ctrl+Home)- Turns ON/OFF Fit to view 
option.

• Fit to view (Home) - Makes the visible area fit to display entire 
contents.

• Copy screenshot (F11) - Copies the screenshot of charts to clipboard.

• Save screenshot (Ctrl+S) - Saves the screenshot as an image (PNG) 
under a name.

• Quick Help (Alt+F1) - Opens a window that provides brief information 
about the dynamic display.

Parameters Window

The Parameter window allows you to set the parameters for a location or a 
group. For each measurement, it contains two types of parameters:

• Acquisition Parameters - Pre-Parameters influence how the data for a 
measurement is collected; changes require a re-run in order to be 
effective. It also allows you to select a location or location group 
against which the data acquisition is performed.

• Evaluation Parameters - Post-Parameters influence how the collected 
measurement data is evaluated. Changes do not require a re-run in 
order to be effective.

The acquisition and evaluation parameters differ from measurement to 
measurement. The detailed description of these parameters are explained 
in the sections that follow. 

Calculated Results Pane

The Calculated Results pane displays the calculated results in the form of 
measurement parameters for each location. The calculated measurement 
parameters varies from measurement to measurement.
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The Calculated Results pane is shown in the following figure:

For each location, you can click on the  slide button to show/hide 
the measurement graph.
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Error Ratio Measurement

Overview

The Error Ratio Measurement allows you to collect measurement data 
over a specific period. This can be used to create test scenarios that are 
reproducible and comparable. Also, you can let tests run over long times 
and then evaluate the results afterwards.

The period of time can be set through the Parameters window, an 
absolute time setting, or the time it takes to measure a specified number 
of bits or bit errors. The accumulation period should be long enough to 
make a statistically valid BER measurement.

Launching Error Ratio Measurement 

To launch the Error Ratio Measurement:

• Go to the Menu Bar > Measurements and then select Error Ratio.

The user interface of Error Ratio Measurement will appear as shown in the 
following figure:

NOTE
While the error ratio measurement is running, you should not modify the 
measurement setup, as the measured bit errors do not represent the 
performance of your DUT under real circumstances.
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• Toolbar: For details, refer to Toolbar on page 296.

• History Pane: For details, refer to Measurement History Window on 
page 297.

• Measurement Graph: For details, refer to Measurement Graph on 
page 305.

• Parameter Pane: For details, refer to Acquisition and Evaluation 
Parameters for Error Ratio on page 303.

• Calculated Results: For details, refer to Calculated Results on 
page 306.
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Acquisition and Evaluation Parameters for Error Ratio

The Parameters window allows you to set the acquisition and evaluation 
parameters for Error Ratio measurement:

Table 54  

Parameters Description Values

Acquisition 
Parameters

Analyzer Location Location or location group against which the 
data acquisition is performed.

Use the drop-down list 
to specify the location 
or location group.

Accumulation End Specify the criteria to end accumulation. Pass/Fail | Full Duration 
| Number of Bits

Accumulation 
Duration

Specify the acquisition duration. Fixed Time | Indefinitely

Accumulation Fix 
Time

Specifies the duration of the accumulation. 
This is a conditional parameter and appear 
when the Accumulation Duration as 
selected as Fixed Time.

Min - 1 s
Max - 31.5 Ms

Accumulation 
Interval

Specify the accumulation interval on which 
the error ratio sample is taken.

Min - 100 ms
Max - 2 Ms

Number of 
Compared Bits

Specify the number of compared bits for 
which the error ratio sample is taken. This is 
a conditional parameter and appear when 
the Accumulation End as selected as 
Number of Bits.

Min - 1E+6
Max - 1E+18

Target Error Ratio Specifies the target error ratio of the 
accumulation results. This is a conditional 
parameter and appear when the 
Accumulation End as selected as 
Pass/Fail.

Min - 1E -18
Max -1E-3

Target Confidence 
Level

Specifies the target confidence level of the 
accumulation results. This is a conditional 
parameter and appear when the 
Accumulation End as selected as 
Pass/Fail.

Min - 0.1 %
Max - 99.9 %

History Defines the number of accumulation values 
that are kept in memory.

Min - 1
Max - 100000
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How to Run a Measurement 

The Error Ratio measurement immediately starts calculating the error ratio 
as soon as it receives a valid signal and the respective error ratio settings 
are done.

To run an Error Ratio measurement, perform the following steps:

• Use the Parameters window to select the location or location group for 
which the data acquisition has to be performed. 

• Set the acquisition parameters in the Parameters window. For details, 
refer to Acquisition and Evaluation Parameters for Error Ratio on 
page 303.

• Click the  Start Measurement icon to run the measurement. The 
measurement status indicator will indicate Running.

How to Stop a Measurement 

To stop an Error Ratio measurement:

• Click the  Stop Measurement icon to stop the measurement.

Evaluation 
Parameters

Results View Mode Allows to view the calculated results in 
either detailed or summarized mode. 

Detailed | Summary

Display Error Ratio Displays the error ratio of the accumulated 
results. This is a conditional parameter and 
appear when the Results View Mode is 
selected as “Detailed”.

Erroneous Zero Ratio | 
Erroneous One Ratio |
Error Ratio

Parameters Description Values

NOTE
Please note that once you run the measurement you cannot modify the 
acquisition parameters. However, if you try to modify acquisition 
parameters by stopping the measurement and then run the 
measurement, a new instance of measurement will be executed.
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Measurement Graph

Once you run an Error Ratio measurement for a specified duration, the 
calculated graph and the raw data is shown on the measurement graph as 
follows:

This graph displays the delta errored 1's ratio, delta errored 0's ratio, and 
total delta error ratio at data points over the entire accumulation period. 
The error ratios on the y-axis are set to a range of 1E+0 (100% errors) to 
1E-12. The accumulation period is on the x-axis.

Display Change

During accumulation, data will appear to move from left to right on the 
ratios graph. When the graph is completely filling the display, the x-axis 
time scale will double. The data graph is then occupying only half of the 
display and will continue to move to the right again. This will repeat until 
the accumulation period has ended.

Measurement Data

The following figure shows the raw measurement data for the selected 
location. 
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Test Times and Confidence Levels

A true Error Ratio measurement must be statistically valid. Because it is 
not possible to predict with certainty when errors will occur, your device 
must be tested long enough to have confidence in its Error Ratio 
performance.

Calculated Results

The following results are displayed when the bit coded patterns are loaded 
in Sequence Editor:

• Errored Zeros: Displays the number of errored zeros during the 
accumulation period.

• Errored Ones: Displays the number of errored ones during the 
accumulation period.

• Error Bits: Displays the number of errored bits during the accumulation 
period.
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• Compared Zeros: Displays the number of compared zeros during the 
accumulation period.

• Compared Ones: Displays the number of compared ones during the 
accumulation period.

• Compared Bits: Displays the number of compared bits during the 
accumulation period.

• Error Ratio: Displays the ratio of the number of errors to the number of 
bits.

• Error Zero Ratio: Displays the ratio of the number of error zero to the 
number of bits.

• Error One Ratio: Displays the ratio of the number of errors one to the 
number of bits.

• Total Words: Displays the total number of received sequencer words.

• Frames: Displays the number of frames received in a time interval.

• Errored Frames: Displays the number of errored frames received in a 
time interval.

• Frame Error Ratio: Displays the ratio of the number of frame errors to 
the number of frames received in the current (or last completed) 
accumulation period.

• ConfidenceLevel@TargetErrorRatio: Displays the percentage of 
confidence level achieved at specified target error ratio at certain point 
of time.

• ErrorRatio@TargetConfidenceLevel: Displays the number of error ratio 
achieved at specified confidence level at certain point of time.

• Results: Display the measurement result either Pass or Fail. It is only 
available when the “Accumulation End” is selected as “Pass/Fail”.

However, when the symbol coded patterns are loaded in Sequence Editor, 
the following results are displayed:

• Symbol Error Ratio: Displays the symbol ratio of the number of errored 
symbols to the total number of symbols received.
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• Received Symbols: Displays the total number of Received Symbol 
Count (all incoming symbols excluding incoming filler symbols) 
received in a time interval.

• Compared Symbols: Displays the number of compared symbols 
considered for the accumulation period. 

• Errored Symbols: Displays the number of errored symbols measured 
during the accumulation period. 

• Illegal Symbol Ratio: Displays the ratio of the number of Illegal Symbol 
count to the number of symbols received in the accumulation period.

• Illegal Symbols: Displays the total number of Illegal Symbols received 
in the accumulation period. 

• Filler Symbols Ratio: Displays the ratio of total no of filler symbols to 
the number of symbols received during the accumulation period.

• Filler Symbols: Displays the total no of filler symbols received during 
the accumulation period.

• Disparity Error Ratio: Displays the ratio of the number of illegal 
disparity change count to the number of symbols received in the 
accumulation period.

• Wrong Disparity: Displays the total number of wrong disparity received 
in the accumulation period. 

• Error Ratio: Displays the ratio of the number of errors to the number of 
bits.

• Compared Bits: Displays the number of compared bits during the 
accumulation period.

• Errored Bits: Displays the number of errored bits during the 
accumulation period.

• ConfidenceLevel@TargetErrorRatio: Displays the percentage of 
confidence level achieved at specified target error ratio at certain point 
of time.

• Results: Display the measurement result either Pass or Fail. It is only 
available when the “Accumulation End” is selected as “Pass/Fail”.

• Total Words: Displays the total number of received sequencer words.

• Frame Error Ratio: Displays the ratio of the number of frame errors to 
the number of frames received in the accumulation period.

• Frames: Displays the number of frames received in a time interval.

• Errored Frames: Displays the number of errored frames received in a 
time interval.

• ErrorRatio@TargetConfidenceLevel: Displays the number of error ratio 
achieved at specified confidence level at certain point of time.
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Output Timing Measurement

Overview

The Output Timing measurement is used to measure the timing and jitter 
behavior for a device under test (DUT). It uses a bit error rate (BER) 
measurement to evaluate the shape of the eye for the output signal of the 
DUT. It also analyzes the jitter, separates the random jitter and 
deterministic jitter components, and estimates the total jitter.

A direct result is the determination of the optimum sampling point delay 
for receiving data from the DUT with maximum confidence.

DUT Output Timing/Jitter includes the Fast Total Jitter measurement 
that can be used to measure the total jitter for devices which generate a 
very low error density in a reasonable time span.

Output Timing Characteristics

The sampling point is swept automatically within a 1.5 clock period to 
generate a "bathtub" curve. The resulting graph is centered around the 
optimum sampling point of the port.

In addition, the results are available in a tabular view. If a clock signal is 
defined, the software measures the data to clock alignment and displays 
the absolute delay.

Jitter Characteristics

The DUT Output Timing/Jitter measurement calculates the different 
components making up the jitter:

• Random Jitter (RJ)

• Deterministic Jitter (DJ)

Example Results

The following illustration shows the resulting graph of a typical DUT 
Output Timing measurement:
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Understanding the Jitter Calculation

After the output timing behavior of the DUT is measured, the 
M8020A/M8030A calculates the different jitter components:
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Random and Deterministic Jitter

To understand the RJ and DJ results, it is helpful to first understand how 
the software generates the results:

1 The bathtub curve is measured.

2 All measurement points that have BER between the BER Threshold and 
Minimum BER for RJ/DJ Separation are transformed into Q-space.

The Q-factor describes the signal-to-noise ratio at the decision circuit. 

3 Linear regression is performed for both the left and right edges.

4 The mean and sigma are calculated for both lines:

• RJ is calculated as the mean of the two sigmas.

• DJ is calculated as the period minus the difference of the two 
means.

5 The estimated TJ is calculated:

• Linear regression is used to extrapolate the bathtub curve to lower 
BER values.

• The intersections of the resulting lines with the Residual BER for 
RJ/DJ Separation are located.

• The eye opening is calculated.

The estimated TJ is the period minus the width of the eye opening.
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The following illustration shows a jitter curve where both RJ and DJ are 
present. It also shows how the TJ peak-to-peak and RMS are calculated.

Estimated Total Jitter

The Estimated Total Jitter (TJ) allows you to predict the jitter expected for 
very low bit error rates that would take a long time to measure. It is 
obtained by extrapolating the measured BER curves.

The TJ is estimated by extending the BER curves (based on the points 
detected between the BER Threshold and the Minimum BER for RJ/DJ 
Separation) to the Residual BER for RJ/DJ Separation level. The estimated 
TJ is the period minus the width of the measured eye.
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 Explanation of the Fast Total Jitter Measurement

The Fast Total Jitter measurement is an optimized method to determine 
the total jitter for devices that generate a very low error density (BER well 
below 10-10).

To measure (not estimate) the total jitter for a device with a BER of 10-12 
with conventional methods, one usually needs to compare more than 1012 

bits for each sample point. To measure a full eye opening this way with 
appropriate timely resolution takes time (maybe days or weeks, depending 
on the data rate), and the probability of seeing one or no error in 1012 bits 
is not higher than 37%.

If one would compare 1013 bits for the same device, the probability of 
seeing ten errors is even lower (12%), but the probability of observing no 
error is almost zero.

The Fast Total Jitter measurement implements a method that reduces the 
measurement time considerably and provides a higher accuracy. It is 
based on statistical and probability calculations.
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Measurement Duration

The duration of a Fast Total Jitter measurement depends on:

• the BER threshold

• the bit rate

• the sample delay step size

• the contribution of random jitter

• the contribution of deterministic jitter

Compared to a conservative bathtub measurement, the Fast Total Jitter 
measurement can reduce the measurement time by more than a factor of 
40.

Typical test times are approximately 20 minutes at 10 Gbit/s and slightly 
more than one hour at 2.5 Gbit/s for a measurement at the 10-12 BER 
threshold with an overall confidence level better than 90%.

Acquisition Parameters

You can use the Properties window to specify the following acquisition 
parameters:

Set the criteria for moving to the next sample point:

• Number of Compared Bits

After this number of compared bits, the measurement stops for the 
current sample point and moves to the next one.

• Number of Errors

After this number of errors, the measurement stops for the current 
sample point and moves to the next one. This allows you to speed up 
the measurement. You can switch off this option if only the number of 
compared bits is important.

Set the criteria for the sample delay:

• Sample Delay Resolution

Specifies the time distance between sampling points. A smaller value 
yields more sampling points in a unit interval. You can enter the 
resolution in UI.

If the resolution used for the measurement is not high enough, the 
bathtub curve does not clearly show the edges. For example, you may 
wish to change the Resolution from 0.01 to 0.005 and run the 
measurement again.

• Sample Delay Optimization

You can choose between Fast Total Jitter at BER or None.
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• Fast Total Jitter at BER

This enables the Fast Total Jitter measurement. Before enabling this 
measurement, you need to know the BER floor of the device and to 
specify a BER threshold that is above that floor.

Evaluation Parameters

You can use the Properties window to specify the following evaluation 
parameters:

• Analyze Errors

You can analyze for:

• All Errors

To calculate the BER values from all bits/errors.

• Errored Zeros

To calculate the BER values if "0" is expected, but "1" received.

• Errored Ones

To calculate the BER values if "1" is expected, but "0" received.

• BER Threshold

To calculate the parameters for the given BER threshold. This is the 
BER level for which output timing numerical values (phase margin, 
skew, etc.) are calculated. It is also the upper limit of the BER range for 
RJ/DJ separation.

The BER threshold influences some of the parameters of the DUT 
Output Timing measurement. You can also drag and drop the 
horizontal BER threshold in the graphical display to change this value.

• Min BER for RJ/DJ Separation

Lower limit of the BER range for RJ/DJ separation.

• Residual BER for Estimated Total Jitter

BER level for which the estimated total jitter is calculated. 

• Display Unit

Choose between Unit Interval and Seconds to select the timebase for 
the display's x-axis.

• Vertical Axis Scale

Choose between Logarithmic and Linear to select the scale for the 
display’s y-axis.

For example, a DUT Output Timing measurement displayed on a linear 
scale may look like this:
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• Show Measured Points

If you want to see the points that have actually been measured, click 
the Show Measured Points slide button.
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Launching the Output Timing Measurement

To launch the Output Timing user interface:

• Go the Menu Bar > Measurements and then select Output Timing.

The Output Timing user interface will appear as shown in the following 
figure:

The Output Timing user interface includes the following elements:

• Toolbar: For details, refer to Toolbar on page 296

• History Pane: For details, refer to Measurement History Window on 
page 297.

• Measurement Graph: For details, refer to Measurement Graph on 
page 320

• Parameters Window: For details, refer to Parameters Pane on 
page 318. 

• Calculated Results: For details, refer to Calculated Results on 
page 321.
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Parameters Pane

The Parameters window shows the acquisition parameters and evaluation 
parameters for output timing measurement.

Table 55  

Parameters Description Values

Acquisition Parameters

Acquisition Location Location or Location Group against which 
the data acquisition is performed.

Sample Delay Specify the sample delay resolution. Min - 5 mUI
Max - 200 mUI

Sample Delay 
Optimization

Specify the sample delay optimization. None | Fast Total 
Jitter

Fast Total Jitter at BER Specifies the Fast Total Jitter BER. This is a 
conditional parameter and appear when 
Sample Delay Optimization is selected 
as “Fast Total Jitter”

Min - 1E-15
Max - 1E-9

No. of Compared Bits Specify the criteria for moving to the next 
measurement and is only enabled when the 
Sample Delay Optimization is “None”.

Min - 1 E+0
Max - 1E+18

Enable Number of Errors Use the slide switch to enable this property. 
Once this property is enabled, you can 
specify the additional number of errored bits 
to consider while moving to the next 
measurement

ENABLE | DISABLE

Number of Errors Specify the criteria for moving to the next 
measurement and is only enabled when the 
Sample Delay Optimization is “None”. This 
parameter gets enabled when you enable 
the “Enable Number of Errors”.

Min - 1 E+0
Max - 1E+18

Evaluation Parameters

BER Threshold Specify the BER threshold Min - 1E-15
Max - 1E-1

Min BER for RJ/DJ 
Separation

Specifies the minimum BER for random and 
deterministic jitter components separation.

Min - 1E-18
Max - 1E+0

Residual BER for 
Estimated Total Jitter

Specify the residual BER for estimated total 
jitter. 

Min - 1 E-12
Max - 1E-6
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How to Run Output Timing Measurement 

To run an Output Timing measurement, perform the following steps:

• Use the Parameters window to select the location or location group for 
which the data acquisition has to be performed. 

• Set the acquisition and evaluation parameters for Output Timing in the 
Parameters Window. For details, refer to Acquisition Parameters on 
page 314 and Evaluation Parameters on page 315.

• Click the  Start Measurement icon to run the measurement. The 
measurement status indicator will indicate Running.

How to Stop Output Timing Measurement 

To stop a measurement:

• Click the  Stop Measurement icon to stop the measurement.

Analyze Errors Specify options to analyze errors All Errors | Errored 
Zeros | Errored 
Ones

Vertical Axis Scale Specify the Y axis scale. Linear | 
Logarithmic

Display Unit Specify the unit to be displayed. Seconds | UI

Show Measured Points Show/hides the measured points on the 
graph.

Show | Hide

Parameters Description Values



320 Keysight M8070A User Guide

8 Working with Measurements
 

Measurement Graph

Once you run an Output Timing measurement for a specified duration, the 
following graph is shown on the measurement graph:

The bathtub curve in the graph shows the overall jitter distribution over a 
unit interval and serves as the basis for bit error rate estimation.

How an Output Timing Measurement Works

The sampling point is swept automatically within a 1.5 clock period to 
generate a “bathtub” curve. The resulting graph is centered around the 
optimum sampling point.

The BER Bathtub graph plots TJ (Total Jitter) data and BER values across 
an entire bit period, which is labeled as the unit interval (UI) on the 
horizontal axis. BER values are calculated using DJ and RJ and are used to 
extrapolate to low BER levels. In general, the BER values will differ from 
the measured TJ values at high probabilities, but the two should converge 
at low probabilities. Jitter can be measured by moving the sampling point 
across the eye pattern into the crossing region step by step.
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The sampling point- the amplitude decision threshold and the time at 
which the bits are measured – is scanned across the eye pattern over the 
time period while monitoring the BER. The bathtub curve can also be used 
to separate random from the deterministic jitter.

The slope of the bathtub curve is the measure of the random jitter, 
whereas the slope offset positions on the time axis are set by deterministic 
jitter. Total jitter is quantified by noting points where BER reduces to at 
both the eye edges and subtracting this interval from the bit period.

Calculated Results

The calculated results for the Output Timing measurement are displayed 
in the tabular format. It includes the following elements:

• Location: Location or Location/Group against which the data 
acquisition is performed.

• Show Graphics: Displays the measurement graph in the measurement 
output window.

• Optimal Sample Delay: Sample delay coordinate of the center of a 
bounding box around the BER threshold contour line.

• Phase Margin: Period of time where the bit error rate is lower than the 
BER threshold.

• Total Jitter Peak-to-Peak: Peak-to-peak value for total jitter. 
Calculated as the pulse period (unit interval) minus the Phase Margin.
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• Total Jitter RMS: The average of the left and right jitter histogram root 
mean squared values.

• Jitter Mean: Mean value for total jitter. Calculated as the weighted 
average of the left edge jitter histogram.

• Random Jitter RMS: The total jitter component with Gaussian 
distribution. After transforming a contiguous range of measured points 
into Q space and performing a linear regression, it is calculated as the 
mean of the sigmas of the two straight lines. The contiguous range is 
limited by the BER Threshold and the Min. BER for RJ/DJ Separation 
threshold.

• Deterministic Jitter: The total jitter component with non-Gaussian 
distribution. After transforming a contiguous range of measured points 
into Q space and performing a linear regression, it is calculated as the 
period minus the difference between the means of the two straight 
lines.

• Estimated Total Jitter: A forecast of the expected jitter for very low bit 
error rates. After extrapolating the measured BER curves, it is 
calculated as the period minus the expected width of the eye opening.

• Left Edge No. Points: The the number of points that has been 
measured between the BER Threshold and the Min. BER for RJ/DJ 
Separation threshold. It is displayed for both slopes. This number has to 
be greater than 2 for the RJ, DJ, and estimated TJ values to be 
applicable.

• Left Edge R^2: The R^2 values are calculated for both slopes of the 
bathtub curve. They are a measure of how well the transformed points 
between BER Threshold and Min. BER for RJ/DJ Separation fit to the 
linear regression. They have to be greater than 0.75 for the RJ, DJ, and 
estimated TJ values to be applicable.

• Right Edge No. Points: The number of points that has been measured 
between the BER Threshold and the Min. BER for RJ/DJ Separation 
threshold. It is displayed for both slopes. This number has to be greater 
than 2 for the RJ, DJ, and estimated TJ values to be applicable.

• Right Edge R^2: The R^2 values are calculated for both slopes of the 
bathtub curve. They are a measure of how well the transformed points 
between BER Threshold and Min. BER for RJ/DJ Separation fit to the 
linear regression. They have to be greater than 0.75 for the RJ, DJ, and 
estimated TJ values to be applicable.
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Fast Total Jitter Measurement Results

The Fast Total Jitter measurement provides both graphical and numerical 
results:

The example below shows a copied result, and the display of measured 
points was enabled.

The results of the recent measurement are disabled, because they refer to 
a standard "bathtub" measurement that provides many more results. By 
actuating the Show indicator, you can inspect both alternatively.

The resulting graph shows you the points in time that have been 
investigated and whether the actual BER at these points was higher or 
lower than the BER threshold specified for the measurement.

Calculated Results for Fast Total Measurement

The calculated results for the Fast Total Jitter measurement are displayed 
in the Calculated Results pane. It includes the following elements:

• Location: Location or Location/Group against which the data 
acquisition is performed.

NOTE
For coded patterns, the Fast Total Jitter measurement will only work 
when the bit recovery mode is enabled.
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• Show Graphics: Displays the measurement graph in the measurement 
output window.

• Optimal Sample Delay: The mean value of the left and right 
bathtub/Total Jitter BER Threshold intersections.

• Phase Margin: The period of time where the bit error rate is lower than 
the Total Jitter BER Threshold.

• Total Jitter Peak-Peak: Peak-to-peak value of the total jitter. 
Calculated as the pulse period (unit interval) minus the Phase Margin at 
the Total Jitter BER Threshold.

• Total Jitter Uncertainty: Displays the total jitter uncertainty.
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Output Level Measurement

Overview

The Output Levels measurement allows you to characterize the behavior 
of the output levels of a device under test (DUT). The sampling delay is 
fixed. The analyzer's decision threshold is automatically swept within a 
user-defined range.

A direct result is the determination of the optimum decision threshold level 
for receiving data from the DUT with maximum confidence.

Launching the Output Level Measurement

To launch the Output Level user interface:

• Go the Menu Bar > Measurements and then select Output Level.

The Output Level user interface will appear as shown in the following 
figure:
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• Toolbar: For details, refer to Toolbar on page 296

• History Pane: For details, refer to Measurement History Window on 
page 297.

• Measurement Graph: For details, refer to Measurement Graph on 
page 320

• Parameters Window: For details, refer to Parameters Window on 
page 326. 

• Calculated Results: For details, refer to Calculated Results on 
page 333.

Parameters Window

The Parameters window have the following acquisition, evaluation and 
show parameters for output level measurement.

Acquisition Parameters

• Analyzer: Specifies location/location group against which data 
acquisition is performed.
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• Resolution: Specifies the distance between the sampling points. The 
lower this value is, the more sampling points you have in the selected 
voltage range. The minimum step width is hardware-dependent. At the 
time being, the minimum is 1 mV.

• Low Level: This is the lower end of the measured voltage range.

• High Level: This is the upper end of the measured voltage range.

• Number of Compared Bits: After this number of compared bits, the 
measurement stops for the current sample point and moves to the next 
one.

• Number of Errors: After this number of errors, the measurement stops 
for the current sample point and moves to the next one. This allows you 
to speed up the measurement. You can switch off this option if only the 
number of compared bits is important.

Evaluation Parameters

• BER Threshold: This is the bit error rate threshold at which the 
Threshold Margin is determined. It is also the upper threshold for the 
Q-factor calculations. The BER Threshold is displayed in the BER vs. 
Threshold graph.

• Min BER for Q: This is the lower threshold for the Q-factor calculations.

Show Graphics View

BER vs. Threshold Graph: This graph shows the relationship between the 
analyzer decision threshold and the measured BER.
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The BER considers all errors. It is calculated as:

• QBER vs. Threshold Graph: This graph shows the extrapolation of the 
optimum Q-factor and the optimum threshold level from a limited 
number of measured points.
The measured data points to be used for the calculation have to be 
within a contiguous BER range. This range is defined by specifying the 
Min BER for Q (lower threshold) and the BER Threshold (upper 
threshold). Both thresholds can be set in the lower section of the View 
tab.
The Q-factor can only be calculated if for both high and low level rails 
two or more points fall within the defined BER range. For reliable 
results use at least five measured points.
To ensure proper settings, enable the Show Measured Points function 
and switch to the BER vs. Threshold graph. Move the upper BER 
threshold marker (vertical line) so that a sufficient number of measured 
points is included for the calculation:
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This graph illustrates the calculation of the Q-factor as the best fit line 
through the calculated points.

Changing the Measurement Setting

• If you change the acquisition settings through Parameter window after 
the measurement has been run, please note that the changes on the 
parameters tab will take only effect if you run the measurement again. 

• However, if you change the parameters that change the display of the 
measured data (graphics, show measurement points and axis scale), 
there is no need to repeat the measurement.

Available Views

The Output Levels measurement provides three different graphical views 
to visualize the calculated results:

• BER versus Threshold: 
This graph shows the relationship between the analyzer decision 
threshold and the resulting BER. It presents the raw data.

• Q from BER versus Threshold: 
This graph shows the extrapolation of the Q-factor and the optimum 
threshold level from a limited number of measured points.
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How to Execute Output Level Measurement 

To run an Output Level measurement, perform the following steps:

• Use the Parameters window to select the location or location group for 
which the data acquisition has to be performed. 

• Set the acquisition and evaluation parameters for Output Level in the 
Parameters Window. For details, refer to Parameters Window on 
page 326.

• Click  Start Measurement icon to execute the measurement. The 
measurement status indicator will indicate Running.

How to Stop Output Level Measurement 

To stop a measurement:

• Click  Stop Measurement icon to stop the measurement.

Measurement Graph

The Measurement Graph displays the absolute values of the derivative of 
the bit error rates over the thresholds (dBER/dTh). It visualizes the data 
that forms the basis for the calculations of the level and noise values.

The Output Level measurement provides Q from BER versus Threshold 
graph. This graph refers to the Q-factor calculations.

The following illustration shows the BER versus Threshold graph of a 
simple Output Level measurement:
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The Measurement Graph contains the following tabs:

• Graph: Displays the graphical representation of the measurement. The 
graph varies from measurement to measurement. The details of each 
measurement graph are further described in their respective sections.

• Location: Displays the raw measurement data for that location. 
However, if you are running measurement for a group, multiple tabs will 
appear that display the raw measurement for each location.

When you right-click on the Measurement Graph, a context menu 
appears which provides the following options:

• Turn ON/OFF Fit to view (Ctrl+Home) - Turns ON/OFF Fit to view 
option.

• Fit to view (Home) - Makes the visible area fit to display entire 
contents.

• Copy screenshot (F11) - Copies the screenshot of charts to clipboard.

• Save screenshot (Ctrl+S) - Saves the screenshot as an image (PNG) 
under a name.
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• Quick Help (Alt+F1) - Opens a window that provides brief information 
about the dynamic display.

How to Improve the Output Levels Display

You can consider the following points to change the display of an existing 
measurement:

• Measurement Points: If you wish to see more details to investigate the 
graph, select Show Measured Points on the Graph option of the 
Properties window. With this option selected, all measured points are 
indicated in the graph with small squares. 

• Zoom: Several zoom factors are available. When you show the zoom 
graph, you can also allow the zoom graph to track the mouse

• Scale: Choose between Logarithmic and Linear to select the scale for 
the displays x-axis. 
The scale of the QBER vs. Threshold graph is always linear.

• Graph Context Menu: When you right-click on the Measurement 
Graph, a context menu appears which provides the options such as fit 
to view, copy and save screen shot and quick help of dynamic display.

How to Change the Output Levels Properties

In the example measurement, we have set the focus on speed: 100 
threshold levels and 1,000,000 compared bits per measuring point. You 
may wish to obtain more precise results.

1 Switch to the Parameters window.

2 Increase the Number of Compared Bits to 100,000,000.

Remember: One failure per 1 million bits yields a BER resolution of 
10-6. One failure per 100 million bits yields a BER resolution of 10-8.

3 Decrease the Sample Threshold Resolution to 2mV.

This gives us 500 steps per Volt.

4 Press the Start Measurement icon to repeat the measurement with the 
new parameters.

The measurement now takes more time than the previous, but it is also 
much more precise.
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Calculated Results

The following figure illustrates the calculated results:

The calculated results are divided into three groups:

• Level Results

• Noise Results

• Q-factor Results

Level Results

The level results are defined as follows:

• High Level: The High Level is the mean of the upper dBER/dTh 
distribution. It is calculated as:
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• Low Level: The Low Level is the mean of the lower dBER/dTh 
distribution. It is calculated as:

• Mean Level: The Mean Level is the middle between the High and Low 
Levels, calculated as:

• Amplitude: The Amplitude is the difference between its High and Low 
Levels.

• Threshold Margin: The Threshold Margin is the distance between the 
upper and the lower BER curves at the position given by the BER 
Threshold setting.

Noise Results

The noise parameters are defined as follows:

• High Level Std. Dev.: The standard deviations are derived from the 
dBER/dTh histogram. 
The High Level Standard Deviation is calculated as:

where Mean is the High Level of the terminal.

• Low Level Std. Dev.: The Low Level Standard Deviation is calculated 
as:

where Mean is the Low Level of the terminal.
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• Peak Peak Noise: The peak-to-peak Noise is calculated as:

Note that the Threshold Margin depends on the position of the BER 
Threshold.

• Signal/Noise Ratio (RMS): The RMS Signal-to-Noise Ratio is 
calculated as:

• Signal/Noise Ratio (Peak Peak): The peak-to-peak Signal-to-Noise 
Ratio is calculated as

Note that the Peak-to-Peak Noise depends on the position of the BER 
Threshold.

Q Factor Results

The numerical Q-factor parameters are defined as follows:

• Q Factor: The Q-factor is calculated as:

where μ1,0 is the mean level of the 1 and 0 rails, respectively, and 
1,0 is the standard deviation of the noise distribution on the 1 and 0 

rails.
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• Q Optimum Threshold: The Q Optimum Decision Threshold is 
calculated as:

• Q Residual BER: The Q Residual BER is the expected BER at the 
Optimum Decision Threshold. It is calculated as:

Numbers below 1e-255 are expressed as zero.

• Q High Level: The Q High Level is the mean, calculated from the linear 
regression curve for the high level data:

• Q High Level Std.Dev: The Q High Level Standard Deviation is the  
(Sigma), calculated from the linear regression curve for the high level 
data:

• Q High Level Nr. Points: This is the number of data points used for the 
calculation of the Q High Level value. It depends on the setting of the 
BER Threshold and also on the setting of the Min BER for Q parameter.
The minimum for calculating Q-factor values is two points. It is 
recommended to use more than 5 points.

• Q High Level R^2: The R2 parameter is an indicator that shows how 
well the converted data points fit to the straight line. It is calculated as:



Keysight M8070A User Guide 337

Working with Measurements 8

 

The R2 parameter should be examined before trusting the Q-values. Its 
maximum value is 1.0. It must be seen in conjunction with the number 
of data points.

For example: Two data points always fit perfectly well, but the resulting 
Q-factor calculations are not reliable. On the other hand, 50 data 
points may reveal a poor R2 value. This tells you that the linearization is 
prone to errors.

If the R2 value falls below 0.75, the Q-factor calculations are not 
applicable.

• Q Low Level: The Q Low Level is the mean, calculated from the linear 
regression curve for the low level data:

• Q Low Level Std.Dev: The Q Low Level Standard Deviation is the  
(Sigma), calculated from the linear regression curve for the low level 
data:

• Q Low Level Nr. Points: This is the number of data points used for the 
calculation of the Q Low Level value. It depends on the setting of the 
BER Threshold and also on the setting of the Min BER for Q parameter.

The minimum for calculating Q-factor values is two points. It is 
recommended to include more than 5 points.

• Q Low Level R^2: The R2 value can also be seen as an indicator of how 
well the noise distribution fits to Gaussian shape. It will not fit, for 
example, if the received signal is dominated by cross-talk or modal 
noise.
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Jitter Tolerance Measurement

Overview

A Jitter Tolerance measurement is used to determine the ability of a 
device or system to maintain communication quality in the presence of 
jitter. It comes in two varieties:

• Jitter Tolerance Characterization determines the jitter levels where the 
device under test can no longer maintain a desired bit error ratio (BER).

• Jitter Tolerance Compliance verifies that the device under test is able 
to maintain a BER level at pre-defined jitter levels and jitter frequencies, 
as defined by a standard.

The basic setup of a jitter tolerance test is illustrated below:

Understanding Jitter Tolerance

The behavior and the passed/failed classification of data receiving devices 
or circuits are determined by their ability to withstand: 

• Jitter

• Intersymbol interference

• Level noise

This refers particularly to the performance of phase-locked loops (PLLs) or 
clock data recovery circuits (CDR).
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Jitter tolerance can be measured by applying a distorted data signal to the 
DUT and measuring the resulting bit error ratio. To make jitter tolerance 
tests reproducible, the signal distortion must also be reproducible. This 
requires some definitions.

Jitter

Receivers react differently on

• different types of jitter

• the jitter composition

• the jitter frequency spectrum

• the combination of jitter frequencies and data rate

Various test standards specify the jitter composition to be used for jitter 
tolerance tests.

The M8020A/M8030A provides the following means for generating 
artificial (reproducible) jitter:

• Two types of voltage-controlled signal delay lines

• A phase shifter for modulating the generated clock

Intersymbol Interference

Conductors on PC boards have a limited bandwidth. This causes 
intersymbol interference which changes the shape of the received eye 
opening. The eye becomes asymmetrical.

Level Noise

Level noise affects the voltage amplitude of the eye opening.

PLL Performance Test Testing a PLL (or CDR) is not complete until the 
entire frequency range of the PLL has been checked under worst-case 
conditions.

For this purpose, the M8020A/M8030A provides the Jitter Tolerance 
Characterization measurement.

PLL Standards and Compliance Tests

The Optical Internetworking Forum (OIF) as well as other institutions have 
proposed standards for testing the performance of data receivers and 
receiver circuits in the presence of jitter.

For this purpose, the M8020A/M8030A provides the Jitter Tolerance 
Compliance measurement.
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Types of Jitter

The standards for jitter tolerance tests prescribe combinations of certain 
jitter types. This section gives an overview of these types.

Random Jitter

Random jitter (RJ) is always present. Resistors, transistors, and other 
components generate noise that impacts transmitters and receivers.

This kind of jitter has a Gaussian distribution over time.

Bounded Uncorrelated Jitter

Similar to random jitter, bounded uncorrelated jitter (BUJ) has also a 
Gaussian distribution, but this distribution is cut (bounded) at both sides.

This kind of jitter can be caused, for example, by crosstalk on a parallel bus 
or by intersymbol interference of random or long pseudo random binary bit 
sequences.

To simulate bounded uncorrelated jitter for jitter tolerance tests, it can be 
generated from a filtered (frequency-limited) PRBS.

Periodic Jitter

Periodic jitter (PJ) is generally picked up from other periodic sources.

• Rectangular Jitter: Rectangular jitter may be caused, for example, by a 
switching power supply. The jitter amplitude is usually specified in UI. 
One UI (Unit Interval) is always the reciprocal of the present data rate.

• Sinusoidal Jitter: This kind of jitter can be picked up from any adjacent 
signal or clock. The jitter histogram has a U-shape.

• Triangular Jitter: Triangular jitter is always generated by a spread 
spectrum clock but can also be caused by other periodic sources. 
Triangular jitter has a uniform jitter distribution.

Intersymbol Interference

Intersymbol interference (ISI) is caused by bandwidth limitations of cables 
and backplanes. It cuts off higher frequencies and hence changes the 
shape of the eye opening.

Intersymbol interference can be simulated by inserting a defined 
transmission path between the Generator and the DUT.
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Crosstalk

Crosstalk between adjacent signal paths modulates the vertical eye 
amplitude. This narrows the voltage range of the receiver needed for 
capturing data correctly.

For jitter tolerance tests, amplitude modulation is most often simulated by 
modulating the data output with a sinewave signal. This is called 
Sinusoidal Interference (SI).

Total Jitter

Total jitter is the sum of all kinds of jitter.

BER Setup

Table 56  BER setup description

Graph Setup

Table 57  Graph setup description

Name Description

Data Rate Displays the Data Rate for the measurement. 

Target BER Sets the required target BER. The default is 1.0E-09.

Confidence Level Confidence Level = 1 – exp(-data rate * gate time * measurement 
depth)
The range is 0 % to 99.9 %. The default is 95 %.

Frequency Relax Time Sets the amount of time to pause the measurement after a change 
in jitter modulation frequency.

Amplitude Relax Time Sets the amount of time to pause the measurement after a change 
in jitter modulation amplitude.

Name Description

Template Limits Show/hides the maximum and minimum jitter amplitude limits in 
the graph.

Template Points Show/hides the template points in the graph.

Compliance Limits Show/hides the compliance curve in the graph.
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Instrument Setup

Table 58  Instrument setup description

Measurement Setup

Table 59  Measurement setup description

Name Description

Generator The Generator drop down list box shows all available Data Out 
locations that are used as a data source. A generator must be 
specified to perform the measurement.

Analyzer The Analyzer drop down list box shows all available Data In 
locations that are used for data acquisition. A detector must be 
specified to perform the measurement.

Name Description

Measurement Template Click the  Open icon to open the Jitter Tolerance 
Measurement template.

Start Frequency Sets the start frequency of the Jitter Tolerance Measurement. 

Stop Frequency Sets the stop frequency of the Jitter Tolerance Measurement. 

Num Points Sets the number of measurement points.

Mode Sets the Jitter Tolerance Measurement mode. The options are 
Compliance or Characterization. 
In Characterization mode you have to set the search algorithms. 
For details, refer to Characterization on page 343.
To set Compliance margins, see Compliance Margin on 
page 348.

Step Size Sets the step size for characterization algorithms. The option are 
Binary Step Size, Linear Step Size and Log Step Size. For details, 
see Step Size on page 347.

CDR LBW Auto Automatically sets the external CDR Loop Bandwidth.
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Characterization

Table 60  Characterization

Name Description

Algorithm Search algorithms apply to characterization measurements only.

Name Description

Binary The Binary algorithm uses a variable step size to find the highest 
passing SJ amplitude at each SJ frequency in the template. 
Starting at the maximum SJ amplitude determined by the upper 
limit in the template file or the instrument limit, whichever is 
lower, followed by the minimum SJ amplitude determined by the 
lower limit in the template file, the Binary algorithm then sets 
subsequent SJ amplitudes at the logarithmic midpoint between 
the highest passing and lowest failing SJ amplitudes. A test point 
is determined to be a passing point if the BER measured is below 
the BER threshold set by the user.
The equation for the midpoint (c) between points a and b on a log 
scale is:
c = 10^((log(a) + log(b)) / 2).
The algorithm exits if the channel is tolerant of the maximum jitter 
amplitude or is intolerant of the minimum jitter amplitude. 
Otherwise, the algorithm continues until the last step size is less 
than the minimum step size set by the user for Binary algorithms.
The jitter tolerance result at each jitter modulation frequency is 
the highest jitter amplitude at which the measurement was made 
below the threshold BER. However, if the device is intolerant of 
even the minimum jitter value, the result is not valid and is not 
plotted.
In many cases, the Binary algorithm is the quickest. However, 
devices with hysteresis may not have consistent results when 
using the Binary algorithm since the approach direction (up vs. 
down) will cause the result to vary. This occurs because the PLL in 
the clock data recovery unit will typically hold lock longer as the 
jitter is increased, then it would establish lock as the jitter is 
reduced. For example, a receiver may have a higher passing SJ 
amplitude when the previous step was a lower (passing) SJ 
amplitude, compared to a lower passing SJ amplitude when the 
previous step was a higher (failing) SJ amplitude. If this is a 
problem, see the Binary + Down Linear and Binary + Up Linear 
algorithms.
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Name Description

The following is an example of the Binary algorithm.
At a single SJ frequency, if the true pass/fail SJ amplitude is 0.7 
UI, the minimum step size is 0.1 UI, the template minimum is 0.1 
UI, and the template maximum is 1.0 UI, then the binary algorithm 
would follow these test points:
1 Template maximum 1.0 UI - FAIL
2 Template minimum 0.1 UI - PASS
3 Log midpoint between 1.0 UI (FAIL) and 0.1 UI (PASS) = 0.32 UI 

- PASS
4 Log midpoint between 1.0 UI (FAIL) and 0.32 UI (PASS) = 0.57 

UI - PASS
5 Log midpoint between 1.0 UI (FAIL) and 0.57 UI (PASS) = 0.75 

UI - FAIL
6 Log midpoint between 0.75 UI (FAIL) and 0.57 UI (PASS) = 0.65 

UI - PASS
7 Log midpoint between 0.75 UI (FAIL) and 0.65 UI (PASS) 0.70 

UI - PASS
8 Last step size < 0.1 UI, highest passing SJ amplitude is 0.70 UI

Binary + down linear The Binary + Down Linear algorithm is the same as the Binary 
algorithm followed by the Down Linear algorithm. Refer to the 
descriptions for Binary and Down Linear in this table.

Binary + up linear The Binary + Up Linear algorithm is the same as the Binary 
algorithm followed by the Up Linear algorithm. Refer to the 
descriptions for Binary and Up Linear in this table.

Down linear The Down Linear search algorithm starts at the maximum jitter 
value determined by the template.
If a BER measurement has errors above the measurement 
threshold, the jitter amplitude is adjusted lower by the linear step 
size.
This algorithm exits when the BER is measured below the 
measurement threshold BER, or if the last amplitude 
measurement point was at the minimum jitter value in the 
template.
The jitter tolerance result at each jitter modulation frequency is 
the highest jitter amplitude at which the measurement was made 
below the threshold BER. However, if the device is intolerant of 
even the minimum jitter value, the result is not valid and is not 
plotted.
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Down logarithmic The Down Logarithmic search algorithm starts at the maximum 
jitter value determined by the template.
If a BER measurement has errors above the measurement 
threshold, the jitter amplitude is adjusted lower by the coefficient 
calculated from the logarithmic step size. For example, if the 
coefficient is 10%, then the next amplitude equals the previous 
amplitude minus 10% of the previous amplitude.
This algorithm exits when the BER is measured below the 
measurement threshold BER, or if the last amplitude 
measurement point was at the minimum jitter value in the 
template.
The jitter tolerance result at each jitter modulation frequency is 
the highest jitter amplitude at which the measurement was made 
below the threshold BER. However, if the device is intolerant of 
even the minimum jitter value, the result is not valid and is not 
plotted.

Name Description
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Up linear The Up Linear search algorithm starts at the minimum jitter value 
determined by the template.
If a BER measurement has errors below the measurement 
threshold, the jitter amplitude is adjusted higher by the linear step 
size.
This algorithm exits when BER is measured above the 
measurement threshold BER, or if the last amplitude 
measurement point was at the max jitter value in the template.
The jitter tolerance result at each jitter modulation frequency is 
the highest jitter amplitude at which the measurement was made 
below the threshold BER. However, if the device is intolerant of 
even the minimum jitter value, the result is not valid and is not 
plotted.

Up logarithmic The Up Logarithmic search algorithm starts at the minimum jitter 
value determined by the template.
If a BER measurement has errors below the measurement 
threshold, the jitter amplitude is adjusted higher by the coefficient 
calculated from the logarithmic step size. For example, if the 
coefficient is 10%, then the next amplitude equals the previous 
amplitude plus 10% of the previous amplitude.
This algorithm exits when the BER is measured above the 
measurement threshold BER, or if the last amplitude 
measurement point was at the maximum jitter value determined 
by the template.
The jitter tolerance result at each jitter modulation frequency is 
the highest jitter amplitude at which the measurement was made 
below the threshold BER. However, if the device is intolerant of 
even the minimum jitter value, the result is not valid and is not 
plotted.

Up Log + Linear The Up Log + Linear search algorithm performs the same 
algorithm as Up Logarithmic, but in addition, it returns to the last 
passing amplitude and steps linearly up until it reaches a fail 
point. The algorithm continues to increase the SJ amplitude until 
failure, even if it surpassed the original failed point.

Name Description
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Step Size

Table 61  Step size descriptions for characterization algorithms

Name Description

Binary Step Size The Step Size for the Binary algorithm defines the exit criteria for 
the algorithm. The Binary search algorithm stops once its step size 
falls below this user defined Step Size.
The Binary Step Size applies to the Binary algorithm and the binary 
portions of the Binary + Down Linear and Binary + Up Linear 
algorithms..

Linear Step Size This defines the step size for each step of the Up Linear and Down 
Linear algorithms.
When Down Linear is enabled as the search algorithm, the 
measurement starts from the maximum (which depends on the 
jitter frequency). A step size of 100 mUI, for example, may result in 
a sequence of 1000 UI, 999.9 UI, 999.8 UI, and so on. The test for 
one frequency stops when the BER limit is met or minimum 
specified amplitude is reached.
When Up Linear is enabled as the search algorithm, the 
measurement starts from the minimum. A step size of 100 mUI, for 
example, will result in a sequence of 0.1 UI, 0.2 UI, 0.3 UI, and so 
on. The test for one frequency stops when the BER limit is 
exceeded or the maximum amplitude is reached.

Log Step Size This defines the step size for each step of the Up Logarithmic and 
Down Logarithmic algorithms.
When Down Logarithmic is enabled as the search algorithm, the 
measurement starts from the maximum (which depends on the 
jitter frequency). A percentage of 50%, for example, may result in a 
sequence of 1000 UI, 500 UI, 250 UI, and so on. The test for one 
frequency stops when the BER limit is met or the specified 
minimum amplitude is reached.
When Up Logarithmic is enabled as the search algorithm, the 
measurement starts from the specified minimum amplitude. A 
percentage of 50%, for example, may result in a sequence of 0.1 
UI, 0.15 UI, 0.23 UI, and so on. The test for one frequency stops 
when the BER limit is crossed or the maximum amplitude (which 
depends on the jitter frequency) is reached.
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Compliance Margin

Table 62  Compliance Margin

Launching Jitter Tolerance Measurement

To launch the Jitter Tolerance Measurement:

• Go to Menu Bar > Measurements and then select Jitter Tolerance. 

The Jitter Tolerance user interface will appear as shown in the following 
figure:

Name Description

Compliance Margin In Compliance mode, the test starts at points defined on the jitter 
tolerance curve and is increased or decreased by the specified 
margin percent.
The compliance template is adjusted according to the equation SJ 
Amplitude (with margin) = original SJ Amplitude * (1.0 + 
margin(%)/100).
This can be used to test if a receiver can withstand a certain 
percentage more jitter than dictated by the compliance template. 
Conversely, if a receiver is failing, the margin can be lowered to 
test if a receiver can pass a compliance test with a less stringent 
template.
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 The Jitter Tolerance user interface includes the following GUI elements:

• Toolbar: For details, refer to Toolbar on page 296.

• Status Indicator: For details, refer to Status Indicator on page 297.

• Measurement History Window: For details, refer to Measurement 
History Window on page 297.

• Measurement Graph: For details, refer to Measurement Graph on 
page 350

• Results Pane: For details, refer to Viewing the Jitter Tolerance Results 
on page 351.

How to Run Jitter Tolerance Measurement 

Once you have specified the Frequency, BER, and Search criteria, press 
the  Start Measurement icon to run the measurement. The 
measurement status indicator will show the progress. 

How to Stop/Abort Jitter Tolerance Measurement 

To stop a measurement, click the  Stop Measurement icon.
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Measurement Graph

After a jitter tolerance measurement has been run, results can be viewed 
by clicking on the Graph tab. The graph displays the sinusoidal jitter 
frequency on the x-axis, and the sinusoidal jitter amplitude on the y-axis.

The following figure shows the measurement results in the graph view.

Results Points

The graph displays the BER measurement results of each tested sinusoidal 
jitter point. Passing results are displayed as a green dot. In the graph, the 
green “+” means that you’ve reached the instruments max jitter capability 
without a fail. The red cross "x" means that you have failed to reached the 
instruments max jitter capability.

Maximum and Minimum Template Limit Lines

The solid white lines on the graph show the search range during 
characterization. This feature reduces test time by eliminating points 
where the DUT is likely to pass when its performance range is known.

Template Points

The green dots on the graph are the measurement points defined in the 
Template File.
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Compliance Limit Line

The dashed white line on the graph shows the compliance test defined in 
the Template File.

Viewing the Jitter Tolerance Results

Measurement results can also be viewed in tabular form by clicking on the 
Results tab. 

The following figure shows the results at each measurement point in 
tabular form.

Saving Jitter Tolerance Measurement Results

You can also save the Jitter Tolerance Measurement results in to a CSV 
file. To do so:

• Click on the  Save icon. A standard Save As dialog will appear.
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• Provide a filename and location.

• Click Save. The Jitter Tolerance Measurement results will be saved in 
CSV format.

Using the Jitter Tolerance Template Editor

The Jitter Tolerance Template Editor is used to modify the currently 
loaded template file. It can be accessed by clicking on the  Open Jitter 
Tolerance Template Editor icon, present on the toolbar.

The following is an example of jitter tolerance template editor showing the 
measurement point values (frequency and amplitude) for the currently 
loaded template file.
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 Template Editor Toolbar

Table 63  

Elements Name Description

Previous /Next 
Measurement 
Point

The left and right arrow buttons cause the vertical marker 
to jump to the next/previous measurement point.

Auto Scale 
Graph

Scales the graph to the optimum setting.



354 Keysight M8070A User Guide

8 Working with Measurements
 

Template Editor Functions

Table 64  

Function Description

Edit 

Frequency The frequency at the current vertical marker position is displayed in this 
window. Changing this frequency using the keypad, allows new 
measurement points to be defined. 

Add Test 
Point/Remove Test 
Point

Use the drop-down menu to add or remove test points and then click on 
the Execute button.

Test Points

Measurement 
Template

Selects the Jitter Tolerance Measurement template file. It provides the 
following functions:

 New - Opens a new template file.

 Open... - Opens an existing template file which includes limits, 
compliance, and jitter tolerance measurement state.

 Save - Saves the currently open template file to the current 
filename.

 Save As... - Saves the currently open template file to a different 
filename and/or location.

Maximum
Changes the maximum amplitude of the measurement point at the current vertical marker 
position. These are the points along the solid white line on the graph.

Compliance
Changes the compliance amplitude of the measurement point at the current vertical marker 
position. These are the points along the upper solid white line on the graph.

Minimum
Changes the minimum amplitude of the measurement point at the current vertical marker 
position. These are the points along the lower solid white line on the graph.
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Eye Diagram Measurement

What is an Eye Diagram?

The M8070A System Software provides quick design analysis with the Eye 
Diagram capability.

The Eye Diagram allows a quick check for the DUT’s signal output, and 
determines the signal quality. The eye contour lines display the measured 
eye at a deeper BER level, for accurate results.

The Eye Diagram feature provides the following measurement capabilities:

• Eye Diagram Waveform

• BER Contour Lines

• Automatic Measurement for the most relevant eye parameters:-

• Eye Height

• Eye Width

• Jitter P-P

• Jitter RMS

• Cross Voltage

The Eye Diagram generates a three dimensional graph of the bit error rate 
(BER).

This measurement helps in determining and analyzing the quality of the 
DUT’s signal output. The Eye Diagram results comprise of voltage(y), 
time(x), and BER(z). 

The Eye Diagram, and the table of Calculated Eye Measurement Results 
form simultaneously. They become more precise with the increasing 
number of measured bits.

The following graph shows the Eye Diagram integrated in the M8070A 
system software:
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Methods of Representation of Eye Diagram

There are two methods of representing the eye diagram:

• Waveform

• Contour

Waveform

Waveform is the shape, and form of a signal. The waveform graph shows 
the periodical variation of voltage against time.

The waveform in the M8020A/M8030A is similar to the one in the 
oscilloscope. In this case, the waveform initially gives a coarse, but quick 
picture of the signal quality; while the ‘smooth waveform’ quickly 
generates a high resolution graph. The waveform is displayed in an 
incremental way, showing the coarse picture quickly, and then refining it 
further.

The BER Threshold is configurable. The BER Threshold is the level up to 
which the signal is represented as waveform, and BER values below this 
threshold are represented as contours.



Keysight M8070A User Guide 357

Working with Measurements 8

 

BER Contour

Contour is a curve connecting points where the BER has a same particular 
value.

The contour graph is plotted within the Eye Diagram, and it helps to 
determine the Eye Opening at deep bit error rates, such as 1e-10, 1e-12, 
and so forth. Depending upon the user’s requirement the deep BERs can 
be calculated. The extrapolated eye contour lines display the eye opening 
for lower BER levels, such as 1e-15. The BER is displayed as a function of 
sampling delay, and sampling threshold.

The eye opening is one of the main characteristics of a high speed device.

The legend on the right side of the screen represents the contour BER 
values in different colors. When you select a BER value from the legend, it 
displays the contour for the selected BER in the same color. Initially all the 
BER values on the legend are struck across. When the contour is 
measured, the BER value changes into normal font; and when the contour 
is extrapolated the BER value changes into italics. A BER value for which a 
Contour does not exist is struck across. You can select multiple BER 
values. The screen shot below displays the contour and the legend.

The outer contour represents the measured BER contour, while the inner 
lines are extrapolated.
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The Minimum Number of Errors indicates the minimum number of hits 
required to plot the contour.

Eye Diagram Measurement Parameters

Acquisition Parameters

Name Description

Analyzer Location or location group against which the data acquisition is 
performed.

Persistence Set the criteria for Persistence.

Name Description

Infinite With ‘Infinite’, the eye appears with the Automated Eye Parameter 
Measurement, and the results keep on improving in accuracy, as 
more number of points get measured and represented on the 
diagram along with the deeper BER values. The BER threshold in 
the Graph Tab decides how long the measurements will be done at 
the boundaries of the eye. Once the measured points exceed the 
BER Threshold defined by the user, the measurement is done deep 
inside the eye.
This is a default setup for persistence.

Fixed Time (Secs) With ‘Secs’, the measurement runs for the specified time, and the 
measurement automatically restarts showing only the refined eye 
diagram. To stop the measurement, click the abort button.

Number of eyes Set the criteria for the number of eyes.
 1.5ui
This option displays ‘1.5’ eyes on the graph. The transitions of the 
complete eye are placed such, that, they show ‘0.25’ eyes on both 
sides. So, the total number of displayed eyes is 1.5.
 2ui
This option displays ‘2.0’ eyes on the graph. The transitions of the 
complete eye are placed such, that, they show ‘0.5’ eyes on both 
sides. So, the total number of displayed eyes is 2.0.
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Evaluation Parameters

Graph Settings

Name Description

Calculate Results For Set the criteria for calculating the eye width, eye height, JPP, 
JRMS, cross voltage according to the BER threshold selected.

0 Errors To see ‘0 errors’ select the option. This gives the results according 
to the last measured contour for the current measurement. This is 
more significant in the case of deep BERs.

BER Threshold Enter the BER threshold at which the five results, eye width, eye 
height, JPP, JRMS, and cross voltage, will be calculated.
The show checkbox displays the contour at which the results are 
calculated.

Transition Time Set criteria for transition time
10/90
Measures horizontal scan from 10% to 90% of the signal 
amplitude.
20/80
Measures horizontal scan from 20% to 80% of the signal 
amplitude.

Name Description

Display Unit Set the criteria for the Timing Units:
Unit Interval
Unit used to measure delay relative to the eye width.
Seconds
Unit used to measure eye width in absolute terms of time.

Show Waveform This option shows the waveform graphic.

Smooth Waveform 
Graphics

The smooth waveform gives a finer waveform output. It 
logarithmically interpolates between the measured points to give a 
finer waveform.

Waveform BER Threshold The BER Threshold value allows the user to measure around the 
eye boundaries first, and then, deeper inside the Eye for BERs 
beyond the specified threshold. 

Contours This option plots the contour.

Contour Legend This shows the list of BER values.
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Lunching the Eye Diagram Measurement

To launch the Eye Diagram Measurement:

• Go to Menu Bar > Measurements and then select Eye Diagram. 

The Eye Diagram user interface will appear as shown in the following 
figure:

The Eye Diagram user interface includes the following GUI elements:

• Toolbar: For details, refer to Toolbar on page 296.

• Status Indicator: For details, refer to Status Indicator on page 297.

• Measurement History Window: For details, refer to Measurement 
History Window on page 297.

• Results Pane: For details, refer to Calculated Eye Diagram Results on 
page 362.

How to Start/Abort an Eye Diagram Measurement

To initiate the eye diagram measurement:

1 Click the Eye Diagram menu item from the Analysis submenu.

2 Click the Start button to execute the measurement.

The measurement runs, and the eye diagram along with the Calculated 
Eye Diagram Results get updated constantly.
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The following graph shows the eye diagram.

3 To stop the measurement click on Abort.

How to Change the Default Settings

To achieve desired results, you can change the measurement parameters 
through the Parameters window.:

1 Click the Properties button to open the Properties dialog box.

2 Use the different tabs in this dialog box to make the required settings:

For details, see Acquisition, Evaluation and Graph Settings.

Please note that you can only change the Evaluation and Graph Settings 
while the measurement is running.
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Calculated Eye Diagram Results

The following results are displayed when an eye diagram measurement is 
completed:

• Location: Location or Location/Group against which the data 
acquisition is performed.

• Sample Count: The number of points measured for the eye diagram. If 
persistence, ‘infinite’, is enabled, the value will gradually increase.

• Error Bits: Displays the number of errored bits during the accumulation 
period.

• 1-Level: One Level is a measure of the mean value of the logical 1 of an 
eye diagram.

• 0-Level: Zero level is the measurement of the mean value of the logical 
0 of an eye diagram.

• Rise time: Measures the mean transition-time taken by the data on the 
rising edge of the eye diagram. The data crosses three thresholds: 
lower, crossover point, upper and the eye transition.

Note: Rise time is dependent on the Transition Time of the View Tab. 
The two options are 10/90 and 20/80.

• Fall time: Measures the mean transition-time taken by the data on the 
falling edge of the eye diagram. The data crosses three thresholds: 
lower, crossover point, upper and the eye transition.

Note: Fall time is dependent on the Transition Time of the View Tab. 
The two options are 10/90 and 20/80.

• Eye Amplitude: The difference between the logic 1 level and the logic 0 
level. 

• Eye Height: Measures the vertical opening of an eye diagram with 
respect to BER threshold. This determines “eye closure” due to noise.

Note: The Eye Height is calculated according to the BER Threshold set 
in the View Tab. Eye Height is calculated with 'Height at' in the View 
tab.
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• Eye Width: The horizontal measurement of the eye opening at a 
specified BER Threshold.

Note: The Eye Width is calculated according to the BER Threshold set 
in the View Tab. Eye Width is calculated as per the selection of either 
Width at Crossing Point or Custom defined Width.

• Jitter Peak-Peak: Full width of the histogram at the eye crossing point 
with respect to BER threshold.

Note: The Jitter P-P is calculated according to the BER Threshold set 
in the Parameter window.

• Jitter RMS: A standard deviation of the crossing point histogram with 
respect to BER threshold.

Note: The Jitter RMS is calculated according to the BER Threshold set 
in the Parameter window.

• Cross Voltage: Crossing percentage is a measure of the amplitude of 
the crossing points relative to the 1 level and 0 level.

Note: The Cross Voltage is calculated according to the BER Threshold 
set in the Parameter window.

• Signal to Noise Ratio: In signal-to-noise, the "signal" is the information 
power of the signal indicated by the difference between the ‘1’, and ‘0’ 
level. The "noise" is the combined standard deviations of the ‘1’ level 
spread, and the ‘0’ level spread.

• Duty Cycle Distortion: This value is the difference between the period 
of a 1 bit and a 0 bit.
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Overview

The M8070A software provides the following utilities:

• Script Editor

• DUT Control Interface

• SCPI Editor

• Self Test Utility

• Licenses Window

• Settings Window

• Logger Window

• SCPI Server Information

• Plug-in Manager Window
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Script Editor

The Script Editor provides flexibility to the programmers to automate their 
plug-ins thus allowing them to do everything they want in the 
measurements.

The Script Editor uses the IronPython programming language which is a 
flexible and powerful language suitable to a range of tasks. The IronPython 
is an open-source implementation of the Python programming language 
which is tightly integrated with the .NET Framework. IronPython can use 
the .NET Framework and Python libraries, and other .NET languages can 
use Python code just as easily. Whether you’re interested in writing full 
applications, tackling scripting tasks, or embedding a scripting language 
into another application, IronPython has something to offer you.

For more details on the IronPython, please refer to the following 
web-page: http://ironpython.net
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Launching the Script Editor

To launch the Script Editor:

• Go to the Menu Bar > Utilities and then select Script Editor.

The Script Editor interface will appear as shown in the following figure:

The Script Editor interface consists of the following GUI elements:

• Toolbar

• Editor Pane

• Output Pane

• Console

• Settings Window

• Find and Replace Dialog

The listed GUI elements are described in the section that follows.
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Toolbar

The Script Editor toolbar provides the following convenient script editing 
functions:

Table 65  

Icon Name Keyboard 
Shortcut

Description

New CTRL + N Click this icon to create a new project/module. For 
details, refer to Creating a Script on page 376

Save CTRL + S Click this icon to save the current project/module. For 
details, refer to Saving a Script on page 376.

Import CTRL + O Click this icon to import external project/module (.PY) 
in to the current project/module. For details, refer to 
Importing a Script on page 376.

Export CTRL + E Click this icon to export the project/module (.PY) to 
the local drive. For details, refer to Exporting a 
Script on page 377.

Cut CTRL + X

These functions follow Microsoft Windows 
conventions.

Copy CTRL + C

Paste CTRL + V

Delete DEL

Undo CTRL + Z Click this icon to undo your last action. 

Redo CTRL + 
SHIFT + Z

Click this icon to redo your last action. 
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Status Indicator

The Status Indicator indicates the current state of the script. It is located 
on the right side of the toolbar.

It shows the following status:

• Running - When the script is being executed.

• Not Running - When the script is either not executed or the execution 
is completed.

• Failed - When the script execution fails.

Start 
Script

F5 Click this icon to execute the script. For details, refer 
to Running a Script on page 377.

Start 
Selected

F8 Click this icon to execute the select portion of the 
script.

Stop 
Script

F6 Click this icon to stop the currently running script.

Reset 
local 
variables 
and loops

Click this icon to reset the local variable and loops in 
the script.

Duplicate 
Row/Sele
ction

CTRL + D Click this icon to duplicate the code of the current 
cursor position or selected code to a new row. For 
details, refer to Adding Duplicate 
Row/Selection in the Code on page 378.

Restore 
default 
window 
layout

Click this icon to restore the default window layout. 

Icon Name Keyboard 
Shortcut

Description
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Editor Pane

The Editor pane allows you to:

• Write, edit, debug and run the scripts

• Open, save, import and export the scripts

• Debug the script code

• Run the entire script or selected lines from the script

• Apply settings to the editor using the Settings window 

The Editor pane is an area where you enter code and execute it 
immediately. It also allows the execution of a single line of script code, 
with the resulting messages printed to the Output pane. For details, refer 
to Output Pane on page 372. In addition, the Editor pane has many 
features to help you enter, edit, check syntax, and debug script code. 
Beside this, it also allows you to use the Microsoft Window’s standard 
functionally such as cut, copy, paste, undo and redo operations in the 
script code.

The following figure shows a simple program written in the Editor pane.

Context Menu

The Context menu appears when you right-click on the editor pane. It 
provides the Window’s standard functionally such as undo, redo, cut, 
copy, paste, delete and select all operations in the script code.

The following figure shows the options provided by the Context menu:
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Output Pane

The Output pane displays the result of the executed script code. However, 
if the interpretor finds any error in the code, it is displayed in this pane.

The following figure shows an output of a program shown in an Output 
pane:

It provides the following options:

Clear Window - Click the  Clear Window icon to clear the output pane.

Export - Click the  Export icon to open a Window’s standard Save As 
dialog to save the content of the Output pane in a log file.
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Console

The Console allows you to enter, interact with and visualize data, inside a 
command interpreter. All the commands entered in the Console are 
executed in a separate process, thus allowing you to interrupt any process 
at any time.

Settings Window

The Settings window provides settings for Editor pane, Output pane and 
Console.

The following table lists the settings for Editor pane:

Table 66  

Settings Description

Show Whitespace Click this switch to show whitespace in the code.

Convert Tabs to Spaces Click this switch to convert tabs to spaces in the code.

Tab Size Use this setting to increase/decrease the tab size in the code.
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The following table lists the settings for Output pane:

Table 67  

Word Wrapping Click this switch to enable word wrapping in the code.

Zoom Use this setting to zoom in or zoom out the code.

Code Completion Click this switch to enable code completion feature. It saves 
the key strokes for caret movement when coding which can 
greatly reduce typing required for coding.
The following figure shows how the code completion feature 
can reduce the typing while coding:

Settings Description

Word Wrapping Click this switch to enable word wrapping.

Zoom Use this setting to zoom in or zoom out the output of the 
program executed.

Autoscroll Output Click this switch to enable autoscroll feature.

Settings Description
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The following table lists the settings for Console:

Table 68  

Find and Replace

The Find and Replace dialog provides the search and replace capability in 
the script. The Quick Find option allows you to locate a specified text 
string while the Quick Replace option allows you to locate and replace a 
specified text string.

The Find and Replace dialog provides the following options:

• Find What - Displays the search string you want to locate.

• Replace With - Displays the string that will replace the string you 
searched for.

Settings Description

Zoom Use this setting to zoom in or zoom out.

Code Completion Click this switch to enable code completion feature. It saves 
the key strokes for caret movement when coding which can 
greatly reduce typing required for coding.
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• Look In - Provides the search operation either in the entire document 
(script) or in the selection (selected part of the script).

• Find Options - Provides several other options (Match case, Match 
whole word, Search up and Search type) in the find dialog that you can 
use to customize your search. 

• Find Next - Locates the next instance of the search string.

• Replace - Displays the string that will replace the string you searched 
for.

• Replace All - Replaces all instances where the search string is found.

Creating a Script

To create a script, click the  New icon present on the toolbar. You can 
use Editor pane to write a script code.

Saving a Script

To save a current script, click the  Save icon present on the toolbar.

Importing a Script

To import a script, click the  New icon present on the toolbar. A 
Window’s standard Open dialog will appear.

• Locate the python script file (.PY) you want to import.

• Click OK.
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Exporting a Script

To export a script, click the  New icon present on the toolbar. The 
Window’s standard Save As dialog will appear.

• Select the location where you want to export the script.

• Enter a file name in the File Name text field. 

• Click Save. 

Running a Script

You can run either the complete script code or the selected part. To do so;

• Click the  Start Script icon present on the toolbar to execute the 
entire script. 

•

• Click the  Start Selected icon present on the toolbar to execute the 
selected part of the script.

Verify the status of the executed scripts though Status Indicator. Refer to 
Status Indicator on page 370.

The output of the scripts will be displayed in the Output pane. However, if 
the scripts fails, the error will also be shown in the Output pane.
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Stopping a Script

To stop the currently running script, click the  Stop icon present on the 
toolbar. 

Adding Duplicate Row/Selection in the Code

To create a copy of the current row of the code or the 

selected part, click the  Duplicate Row/Selection icon. 

The following figure shows the row being duplicated using the Duplicate 
Row/Selection option.
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DUT Control Interface

The DUT Control Interface feature allows you to control a device under 
test at well defined positions within the measurements of the M8070A 
software. It allows you to:

• Read out error count information from devices with built-in error 
counters.

• Read out and write devices status registers 

• Import and edit of Python scripts to access DUT from M8070A system 
software

• Integrate devices built-in error count information in error monitoring 
and jitter tolerance test routines of M8070A. 

The DUT Control Interface editor provides inserting code snippets of the 
supported DUT. This allows you to tailor the supported measurements in a 
way that the DUT is controlled at critical points during the measurement 
and also provide error information for the measurement. Currently, the 
DUT Control Interface supports using a DUT's built-in error counters in 
the following measurements:

• Error Ratio Measurement

• Jitter Tolerance Measurement

All other measurements provide callback functions as well. These are 
useful to tailor the measurement to the DUT (e.g. settling times in 
dependency of measurement parameters), or to control the device under 
test during the measurement.

The DUT Control Interface feature is enabled by the license M8070A-1TP 
or M8070A-1NP.

Launching the DUT Control Interfacer

To launch the DUT Control Interface:

• Go to the Menu Bar > Utilities and then select DUT Control Interface.

The DUT Control Interface interface will appear as shown in the following 
figure:
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• Toolbar

• Editor Pane

• Output Pane

• Console

• Insert Code 

• Settings Window

• Find and Replace Dialog

The listed GUI elements are described in the section that follows.
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Toolbar

The toolbar provides the following convenient script editing functions:

Table 69  

Icon Name Description

New Click this icon to open a new DUT script. For details, refer to 
Creating a Script on page 376

Open Click this icon to open an existing DUT script. 

Save Click this icon to save the current DUT script. For details, refer 
to Saving a Script on page 376.

Save As Click this icon to save the current DUT script under different file 
name at either shared or current locations. For details, refer to 
Saving a Script on page 376.

Import Click this icon to import external DUT script (.PY) in to the 
editor. For details, refer to Importing a Script on 
page 376.

Export Click this icon to export the DUT script (.PY) to the local drive. 
For details, refer to Exporting a Script on page 377.

Cut

These functions follow Microsoft Windows conventions.
Copy

Paste

Delete

Undo Click this icon to undo your last action. 
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Redo Click this icon to redo your last action. 

Duplicate 
Row/Select
ion

Click this icon to duplicate the code of the current cursor 
position or selected code to a new row. For details, refer to 
Adding Duplicate Row/Selection in the Code 
on page 378.

Install Click this button to install or uninstall the DUT control 
interface.
Installing the DUT Control Interface script integrates the 
implemented functions into the M8070A software and makes 
the built-in error counters available for measurements and the 
remote interface.
Editing, or interactive execution of the script is no longer 
possible when the script is installed.

Start Script Click this icon to execute the script. For details, refer to 
Running a Script on page 377.
Running the script in the editor is useful to debug the script 
functionality.
The individual functions can be executed from the Console 
after the script has been executed.

Start 
Selected

Click this icon to execute the select portion of the script.
This is useful to update the functionality available on the 
console after making changes to parts of the script, without 
executing all of the script. This avoids other side effects like 
resetting global variables that can be unwanted during testing 
the script.

Stop Script Click this icon to stop the currently running script.

Reset local 
variables 
and loops

Click this icon to reset the local variable and loops in the script.

Restore 
default 
window 
layout

Click this icon to restore the default window layout. 

Icon Name Description
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Status Indicator

The Status Indicator indicates the current state of the script. It is located 
on the right side of the toolbar.

It shows the following status:

• Running - When the script is being executed.

• Not Running - When the script is either not executed or the execution 
is completed.

• Failed - When the script execution fails.

Editor Pane

The Editor pane allows you to:

• Write, edit and run the scripts

• Open, save, import and export the scripts

• Run the entire script or selected lines from the script

• Apply settings to the editor using the Settings window 

The Editor pane is an area where you enter code and execute it 
immediately. It also allows the execution of a single line of script code, 
with the resulting messages printed to the Output pane. For details, refer 
to Output Pane on page 372. In addition, the Editor pane has many 
features to help you enter, edit and check syntax of the code. Beside this, it 
also allows you to use the Microsoft Window’s standard functionally such 
as cut, copy, paste, undo and redo operations in the script code.

The following figure shows a simple program written in the Editor pane.
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Context Menu

The Context menu appears when you right-click on the editor pane. It 
provides the Window’s standard functionally such as undo, redo, cut, 
copy, paste, delete and select all operations in the script code.

The following figure shows the options provided by the Context menu:
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Output Pane

The Output pane displays the result of the executed script code. However, 
if the interpretor finds any error in the code, it is displayed in this pane.

The following figure shows an output of a program shown in an Output 
pane:

It provides the following options:

Clear Window - Click the  Clear Window icon to clear the output pane.

Export - Click the  Export icon to open a Window’s standard Save As 
dialog to save the content of the Output pane in a log file.

Console

The Console allows you to enter, interact with and visualize data, inside a 
command interpreter. All the commands entered in the Console are 
executed in a separate process, thus allowing you to interrupt any process 
at any time.
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Insert Code Window

The Insert Code window lists code snippets that are supported by the DUT 
Control Interface. You can double-click on the code snippet to insert them 
in the Editor pane. The code snippets ensure correct signature of the 
supported functions and contain documentation of the expected 
functionality and the function's arguments. 

Please note that you are not allowed to modify the script when the DUT 
control script is installed.

Also, the Output pane and Console will not be available when DUT control 
script is installed.

Settings Window

The Settings window provides settings for the Editor pane, Output pane 
and Console.

The following table lists the settings for the Editor pane:

Table 70  

Settings Description

Show Whitespace Click this switch to show whitespace in the code.

Convert Tabs to Spaces Click this switch to convert tabs to spaces in the code.

Tab Size Use this setting to increase/decrease the tab size in the code.
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The following table lists the settings for the Output pane:

Table 71  

Word Wrapping Click this switch to enable word wrapping in the code.

Zoom Use this setting to zoom in or zoom out the code.

Code Completion Click this switch to enable code completion feature. It saves 
the key strokes for caret movement when coding which can 
greatly reduce typing required for coding.
The following figure shows how the code completion feature 
can reduce the typing while coding:

Settings Description

Word Wrapping Click this switch to enable word wrapping.

Zoom Use this setting to zoom in or zoom out the output of the 
program executed.

Autoscroll Output Click this switch to enable autoscroll feature.

Settings Description
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The following table lists the settings for Console:

Table 72  

Find and Replace

The Find and Replace dialog provides the search and replace capability in 
the script. The Quick Find option allows you to locate a specified text 
string while the Quick Replace option allows you to locate and replace a 
specified text string.

The Find and Replace dialog provides the following options:

• Find What - Displays the search string you want to locate.

• Replace With - Displays the string that will replace the string you 
searched for.

Settings Description

Zoom Use this setting to zoom in or zoom out.

Code Completion Click this switch to enable code completion feature. It saves 
the key strokes for the caret movement when coding which can 
greatly reduce typing required for coding.
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• Look In - Provides the search operation either in the entire document 
(script) or in the selection (selected part of the script).

• Find Options - Provides several other options (Match case, Match 
whole word, Search up and Search type) in the find dialog that you can 
use to customize your search. 

• Find Next - Locates the next instance of the search string.

• Replace - Displays the string that will replace the string you searched 
for.

• Replace All - Replaces all instances where the search string is found.

Creating a New Script

To create a new script, click the  New icon present on the toolbar. A 
default script will be loaded in the Editor pane which you can edit to create 
a new script.

Open a Script

To open a saved script, click the  Open icon present on the toolbar. A 
Open Hooks Script dialog will appear which allows you to open the DUT 
scripts.

Saving a Script

To save the current script, click the  Save icon present on the toolbar. 
A Save Hooks Script dialog will appear which allows you to save the 
scripts on either shared or current folder.

Importing a Script

To import a script, click the  Import icon present on the toolbar. A 
Window’s standard Open dialog will appear.
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• Locate the Python script file (.PY) you want to import.

• Click OK.

Exporting a Script

To export a script, click the  Export icon present on the toolbar. The 
Window’s standard Save As dialog will appear.

• Select the location where you want to export the script.

• Enter a file name in the File Name text field. 

• Click Save. 
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Running a Script

You can run either the complete script code or the selected part. To do so;

• Click the  Start Script icon present on the toolbar to execute the 
entire script. 

• Click the  Start Selected icon present on the toolbar to execute the 
selected part of the script.

Verify the status of the executed scripts though Status Indicator. Refer to 
Status Indicator on page 370.

The output of the scripts will be displayed in the Output pane. However, if 
the scripts fails, the error will also be shown in the Output pane.

Stopping a Script

To stop the currently running script, click the  Stop icon present on the 
toolbar. 

Stopping the script does not always work. If the script is using non-Python 
code (e.g. calling functions in .Net libraries), then the execution of these 
functions cannot be stopped in all cases.

Adding Duplicate Row/Selection in the Code

To create a copy of the current row of the code or the 

selected part, click the  Duplicate Row/Selection icon. 

The following figure shows the row being duplicated using the Duplicate 
Row/Selection option.
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Effects on M8070A GUI on Installing a DUT Control Script

On successful installation of DUT control scripts, the following changes are 
reflected in M8070A GUI.

Module View

A new DUT control along with the supported parameters is now added in 
the Module View:

Group View

New locations will be now available to create a group in the Group View.
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Error Ratio Measurement

A new location will be now available in the Analyzer parameter of the Error 
Ratio Measurement.

Jitter Tolerance Measurement

A new location will be now available in the Analyzer parameter of the 
Jitter Tolerance Measurement.
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Writing a Script Code for DUT Control Interface

Scripting Runtime 

• The underlying scripting technology uses IronPython 2.7.5

• The M8070A does not include the full IronPython 2.7.5 installation, only 
the scripting engine itself. When referencing the modules of an 
IronPython installation that is available on the computer, it must be 
ensured that the versions match.

• IronPython makes it very easy to use functionality provided by the 
Microsoft .NET framework, but it cannot directly access dynamic link 
libraries that are not based on .NET. 
Functions that are implemented in unmanaged DLLs (usually 
implemented in C or C++) do require a .NET wrapper library. 
For details see: 
https://msdn.microsoft.com/en-us/library/ms235282.aspx
Title: Calling Native Functions from Managed Code

• Python functions do not have out parameters. If a function is using out 
parameters, then these will be returned as additional return values. 

Example:

• C# function
bool DoSomething(int arg1, out double resultArg1, 

double arg2, out int resultArg2, 

out string resultArg3)

• IronPython usage
(returnValue, resultArg1, resultArg2, resultArg3) = 
DoSomething(arg1, arg2)

• Remote commands to control M8070A cannot be used within the DUT 
Control Interface scripts. 
While this is possible in principle, it will cause problems when the 
functions implemented in the DUT Control Interface are being executed 
in the context of remote commands (e.g. query error counters via 
:fetc:bco?). In this case the remote interface is busy until the DUT 
counters have been returned by the script function DUT_getBER, but 
while the remote interface is busy it cannot process any further remote 
commands, neither internally issued nor external ones. This can very 
easily end up in deadlock/timeout scenarios.

• Code outside of function definitions is being executed at load time of 
the script. 
This can be used to initialize required variables, or establish the 
communication link with the DUT.
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Minimum Requirements to Integrate a DUT's Error Counters

• Implement DUT_getLocations() to return a unique name for each 
location within the DUT that does provide an error counter (e.g. Lane1, 
Lane2, Lane3, Lane4)

Example: 
The following example defines DUT_getLocations to define 4 locations 
named Lane to Lane 4:
def DUT_getLocations(): 

return ["Lane1", "Lane2", "Lane3", "Lane4" ]

• Implement DUT_getBER(location) to return the error counter for each 
of the defined locations.

Example:  

The following example reads BER counter from one of 4 Lanes. Each 
Lane is assumed to be controlled by an instance of a driver class that 
implements the IBerReader interface (see code snippet below). The 
instances of the 4 lanes are held in a dictionary that allows easy lookup 
by the given location name.

 
# create empty dictionary

myDUTs = {}

# instantiate the driver for each location

myDUTs["Lane1"] = MyDutBerReader(1)

myDUTs["Lane2"] = MyDutBerReader(2)

myDUTs["Lane3"] = MyDutBerReader(3)

myDUTs["Lane4"] = MyDutBerReader(4)

def DUT_getBER(location): 

global myDUTs

(bits, errors) = myDUTs[location].GetCounter()

return BitErrorCounter(bits, errors) 

• Implement DUT_synchPattern(location) to synchronize the error 
counter to the received data stream. 

Optionally reset the DUT, but be aware that this should not have side 
effects on other locations. 

The M8070A framework expects the DUT's error counters to be 
running all the time. If the synchronization occurs on a stopped to 
running transition, then the sop as well as the start need to be part of 
DUT_syncPattern(location).
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def DUT_syncPattern(location):

global myDUTs

lane = myDUTs[location]

lane.Stop()

lane.ResetDut()

lane.Start()

• Optionally implement DUT_Init(location, initArg) if it is required to 
configure the DUT to different modes.

DUT_Init can be called from the remote programming interface, so the 
test automation is able to execute initialization code on the DUT 
programmatically.

The M8070A software will not call DUT_Init unless the script is using it 
internally, or it is either requested from the remote programming 
interface, or interactively from within the DUT Control Interface script 
editor.

NOTE
• Making script code executable from within the remote programming 

interface can cause a security issue in your computer.
• The M8070A software is not able to limit the user script's 

functionality. It is the user‘s responsibility to ensure that no unsafe or 
otherwise critical code is being executed from within DUT_Init.

• Special care should be taken when using the python statements eval 
or exec, as these allow dynamic execution of python code.

• Keysight recommends not using eval or exec at all, except the DUT or 
application requires this.

• Keysight is not liable for any kind of damage caused by the use of 
remote executable script code (see Limitation of Liability in End User 
License Agreement).
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Useful Sources of Information

• http://ironpython.net/

Home of the IronPython project.

Especially the IronPython .Net Integration documentation is a valuable 
source of information regarding access to the .Net framework 
(http://ironpython.net/documentation/dotnet/ )

• https://www.python.org/

Home of the python programming language. This is the preferred 
souorce of information regarding to the language syntax itself.

When referring the language documentation make sure to use the 
Python 2.7 documentation.

Keep in mind that Python is not the same as IronPython, so Python 
libraries or modules are not necessarily working with IronPython.

• https://msdn.microsoft.com/en-us/library/gg145045(v=vs.100).aspx

Title: NET Framework Class Library

Programming reference of the .NET framework that is accessible to 
IronPython scripts.

 

Useful Code Snippets

Importing core .NET functionality

The base .NET functionality is implemented in mscorlib.dll 

Making a .NET data type available to the script requires loading the 
assembly and importing the data type.

Example: Importing and using System.UInt64
clr.AddReference("mscorlib")

from System import UInt64

comparedBits = UInt64(0)

comparedBits = comparedBits + UInt64(1e6)

Using .NET Generic Types

It is often required to use generic types when calling .NET code. 

The C# code to instantiate a List of Strings looks like this:
using System;

using System.Collections.Generic;

var stringList = new List<string>()
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The corresponding IronPython code:
clr.AddReference("mscorlib")

from System import String

from System.Collections.Generic import List

stringList = List[String]()

 

Using User Defined .NET Assemblies (e.g. Implementations of IBerReader)

In order to reference user defined assemblies, the search path of the 
scripting engine needs to be extended. After this is done the assembly 
reference can added and the data type imported.

# Add c:\MyLibraries\MyDUT to the search path import sys

sys.path.append("C:\\MyLibraries\\MyDUT") 

 

# reference MyDutCustomBerReader.dll located in 
c:\MyLibraries\MyDUT

clr.AddReferenceToFile("MyDutCustomBerReader")

 

# from the namespace MyNamespace.MyDutCustomBerReader 
# that is defined in the previously referenced assembly, 

# import the actual data type.

from MyNamespace.MyDutCustomBerReader import 
MyDutBerReader

 

# create an instance of MyDutBerReader

myDUT = MyDutBerReader()

 

# call a function defined in the data type MyDutBerReader

myDUT.DoSomething()

 

Using the COM Port to Access the DUT

.NET does provide a dedicated class to work with the computer's COM 
ports. This class is implemented in the System assembly.

Importing the SerialPort class
# import SerialPort from System assembly

clr.AddReference("System")

import System.IO.Ports.SerialPort
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# additional reference assembly mscorlib to have all data 
types

# available that are used by SerialPort

clr.AddReference("mscorlib")

 

Open the COM Port
# create an instance of SerialPort for COM4

serialPort = System.IO.Ports.SerialPort("COM4")

 

# configure COM4 to 9600 bit/s 8N1

serialPort.BaudRate = int (9600)

serialPort.DataBits = int(8)

# available choices for Parity are

# None: System.IO.Ports.Parity.None

# Odd   : System.IO.Ports.Parity.Odd

# Even  : System.IO.Ports.Parity.Even

# Mark  : System.IO.Ports.Parity.Mark

# Space : System.IO.Ports.Parity.Space

serialPort.Parity = System.IO.Ports.Parity.None

# available choices for StopBits are

# None : System.IO.Ports.StopBits.None

# One  : System.IO.Ports.StopBits.One

# Two  : System.IO.Ports.StopBits.Two

# OnePointFive : System.IO.Ports.StopBits.OnePointFive

serialPort.StopBits = System.IO.Ports.StopBits.One 

# set read and write timeouts to 500ms

serialPort.ReadTimeout = int(500)

serialPort.WriteTimeout = int(500)

 

# finally open the COM port

serialPort.Open()

 

Reading and Writing Data
# write a string

serialPort.Write("Sending string data")

 

# sending binary data

 

# prepare the data to be sent. SerialPort expects an Array 
of Byte. This requires importing mscorlib!
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buf = System.Array[System.Byte] ([0x5A, 0x02, 0x00, 
0xaf])

 

# send 4 bytes beginning at offset 0

serialPort.Write(buf, 0, 4)

 

# reading 100 bytes

numBytes = 100

buf = System.Array.CreateInstance(System.Byte, numBytes)

serialPort.Read(buf, 0, numBytes)

Closing the COM Port

The following code snippet shows the required code to close the COM port 
and discard the SerialPort instance. This code should be called in the 
OnUninstall function of the DUT Control Interface in order to ensure that 
the COM port becomes unavailable after the currently active script 
becomes removed from the computer's memory.

if (serialPort != None):

# check if COM port is open

if (serialPort.IsOpen):

serialPort.Close()

# dispose the serialPort instance

serialPort.Dispose()

# ensure that the disposed object is not used in future

serialPort = None

Common Pitfalls when Working with COM Ports

A COM port cannot be opened more than once. Therefore it is very 
important to close the port before the script is unloaded. 

This does have several implications:

• If the COM port is not available when the script is being loaded (e.g. 
when recalling a setting), then the script will fail opening the COM port 
and the DUT will not be accessible.
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• When working with additional tools to communicate with the DUT, e.g. 
a debug-tool to configure the device, only one process can have control 
over the COM port at a time. If the M8070A software has opened the 
COM port in the DUT Control Interface script, then the external tool 
cannot control the device and vice versa.

• Exceptions in the program flow may not prevent releasing the COM 
port.

 

Best Scripting Practices

• Always implement OnUninstall and close the COM port properly.

• Create and open the COM port as late as possible in the script.

• Import all data types

• Implement all driver functionality to communicate with the device.

• Implement the required hook functions and call the device specific 
functions.

• Configure and open the COM port.

The preferred place to do this is in the DUT_connect and 
DUT_disconnect hooks.

• Initialize the DUT using the successfully opened COM port.

If there can be errors during the initialization phase, ensure that the 
variable that provides access to the COM port is only getting invalid 
after the COM port has been closed.

Communication with the M8070A Instrument Layer

Overview

The DUT Control Interface provides a functional API to allow interaction 
with the instrument layer of the M8070A software.

The functional API is provided via the global symbol M8000 within the DUT 
Control Interface script.

This is similar to the M8000.Scpi API in the Script Editor, but does not 
allow sending remote commands to the M8070A software. Instead it 
provides direct access to measurement relevant status and control of the 
sequencing directly.
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This can be used to implement measurement hooks that take the status 
information of the instrument into consideration and initiate sequence 
branching in dependency of the reported status.

The API to control the instrument may not be used from within the DUT 
specific hooks. Doing so will cause error messages when executing the 
respective hooks at runtime.

If an API call is resulting in an error (e.g. when reading status bits that 
don't exist for a DUT) then an exception is thrown, which finally results in 
an error message on the level of the DUT Control Interface script.

Examples

An example of how this can be used to re-train a DUT back into loopback 
during a Jitter Tolerance measurement can be found in the Tutorials folder 
of the Factory provided DUT Control Interface scripts.

The script is named Retrain_DUT_in_JTOL.py and demonstrates how the 
Instrument API can be used to control the sequence in dependency of the 
reported status information and bit counter values.

API Summary

The following is giving a quick overview over Instrument control API.

Sequencing Control

M8000.Instrument.Sequence.Restart(groupOrLocationName)

Restart the sequence on the given group or location. 

M8000.Instrument.Sequence.BreakAll()

Execute a sequence break, which will influence all sequencers in the 
system that are capable of being controlled by the break command.

M8000.Instrument.Sequence.GetBlockNumber(groupOrLocationName)

Reads the current sequence block number from the addressed locations. 

Analyzer Control

M8000.Instrument.Analyzer.AutoAlign(groupOrLocationName)

Execute an auto-alignment on the addressed locations.
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M8000.Instrument.Analyzer.DataCenter(groupOrLocationName)

Executes a data-center alignment on the addressed locations.

M8000.Instrument.Analyzer.ThresholdCenter(groupOrLocationName)

Executes a threshold-center alignment on the addressed locations.

M8000.Instrument.Analyzer.SyncNow(groupOrLocationName)

Executes a pattern synchronization on the addressed locations.

M8000.Instrument.Analyzer.GetBitCounters(groupOrLocationName, 
combineIntoOneResult)

Read the bit counters from the addressed locations and return either the 
sum of all addressed counters, or each addressed counter individually.

M8000.Instrument.Analyzer.GetDataLoss(groupOrLocationName, 
combineIntoOneResult)

Read the data loss status bit from the addressed locations and return 
either the logical OR of all addressed locations, or each location's status 
individually.

M8000.Instrument.Analyzer.GetSyncLoss(groupOrLocationName,combi
neIntoOneResult)

Read the sync loss status bit from the addressed locations and return 
either the logical OR of all addressed locations, or each location's status 
individually.

M8000.Instrument.Analyzer.GetSymbolLoss(groupOrLocationName,co
mbineIntoOneResult)

Read the symbol loss status bit from the addressed locations and return 
either the logical OR of all addressed locations, or each location's status 
individually.
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M8000.Instrument.Analyzer.GetCdrUnlock(groupOrLocationName, 
combineIntoOneResult)

Read the CDR unlock status bit from the addressed locations and return 
either the logical OR of all addressed locations, or each location's status 
individually.

API Details

Sequencing Control

M8000.Instrument.Sequence.Restart(groupOrLocationName)

M8000.Instrument.Sequence.BreakAll()

Functionality Restart the sequence on the given group or location. 

Parameters

groupOrLocationName Addresses the locations that shall be restarted. 
The use of .Net regular expression patterns is allowed.

Returns Nothing

Notes • Initiates the restart, but does not wait until all sequencers 
have actually executed the request.

• Not allowed for "DUT_" hooks.
• Not supported for locations defined by the DUT Control 

Interface script.

Functionality Execute a sequence break, which will influence all sequencers 
in the system that are capable of being controlled by the break 
command.

Parameters None

Returns Nothing

Notes • Initiates the break, but does not wait until the sequencers 
have executed the break.

• Not allowed for "DUT_" hooks.
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M8000.Instrument.Sequence.GetBlockNumber(groupOrLocationName)

Analyzer Control

M8000.Instrument.Analyzer.AutoAlign(groupOrLocationName)

Functionality Reads the current sequence block number from the addressed 
locations. The use of .Net regular expression patterns is allowed.

Parameters

groupOrLocationName Addresses the locations that shall be read. 
The use of .Net regular expression patterns is allowed.

Returns IReadOnlyDictionary<string, int>
The dictionary contains one entry for each addressed location.

Notes • Not allowed for "DUT_" hooks.
• Not supported for locations defined by the DUT Control 

Interface script.

Functionality Execute an auto-alignment on the addressed locations. 

Parameters

groupOrLocationName Addresses the locations that shall be aligned. 
The use of .Net regular expression patterns is allowed.

Returns Nothing

Notes • Is blocking until the alignment has finished.
• Not allowed for "DUT_" hooks.
• Not supported for locations defined by the DUT Control 

Interface script.
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M8000.Instrument.Analyzer.DataCenter(groupOrLocationName)

M8000.Instrument.Analyzer.ThresholdCenter(groupOrLocationName)

Functionality Executes a data-center alignment on the addressed locations.

Parameters

groupOrLocationName Addresses the locations that shall be aligned. 
The use of .Net regular expression patterns is allowed.

Returns Nothing

Notes • Is blocking until the alignment has finished.
• Not allowed for "DUT_" hooks.
• Not supported for locations defined by the DUT Control 

Interface script.

Functionality Executes a threshold-center alignment on the addressed 
locations.

Parameters

groupOrLocationName Addresses the locations that shall be aligned. 
The use of .Net regular expression patterns is allowed.

Returns Nothing

Notes • Is blocking until the alignment has finished.
• Not allowed for "DUT_" hooks.
• Not supported for locations defined by the DUT Control 

Interface script.
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M8000.Instrument.Analyzer.SyncNow(groupOrLocationName)

M8000.Instrument.Analyzer.GetBitCounters(groupOrLocationName, 
combineIntoOneResult)

Functionality Executes a pattern synchronization on the addressed locations.

Parameters

groupOrLocationName Addresses the locations that shall be aligned. 
The use of .Net regular expression patterns is allowed.

Returns Nothing

Notes • Is blocking until the synchronization has finished.
• Not allowed for "DUT_" hooks.
• Supported for locations defined by the DUT Control 

Interface script. But requires implementation of 
DUT_syncPattern.

Functionality Read the bit counters from the addressed locations and return 
either the sum of all addressed counters, or each addressed 
counter individually.

Parameters

groupOrLocationName Addresses the locations that shall be read. 
The use of .Net regular expression patterns is allowed.

combineIntoOneResult • True
Return the sum of all addressed bit counters as a single 
instance of type BitErrorCounter.

• False
Return a dictionary of type IReadOnlyDictionary<string, 
BitErrorCounter> that holds an entry for each addressed 
location.

Returns BitErrorCounter 
or
IReadOnlyDictionary<string, BitErrorCounter>

Notes • Not allowed for "DUT_" hooks.
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M8000.Instrument.Analyzer.GetDataLoss(groupOrLocationName, 
combineIntoOneResult)

M8000.Instrument.Analyzer.GetSyncLoss(groupOrLocationName,combi
neIntoOneResult)

Functionality Read the data loss status bit from the addressed locations and 
return either the logical OR of all addressed locations, or each 
location's status individually.

Parameters

groupOrLocationName Addresses the locations that shall be read. 
The use of .Net regular expression patterns is allowed.

combineIntoOneResult • True
Return the logical OR of all addressed status bits.

• False
Return a dictionary of type IReadOnlyDictionary<string, 
bool> that holds an entry for each addressed location.

Returns bool 
or
IReadOnlyDictionary<string, bool>

Notes • Not allowed for "DUT_" hooks.
• Not supported for locations defined by the DUT Control 

Interface script.

Functionality Read the sync loss status bit from the addressed locations and 
return either the logical OR of all addressed locations, or each 
location's status individually.

Parameters

groupOrLocationName Addresses the locations that shall be read. 
The use of .Net regular expression patterns is allowed.
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M8000.Instrument.Analyzer.GetSymbolLoss(groupOrLocationName,co
mbineIntoOneResult)

combineIntoOneResult • True
Return the logical OR of all addressed status bits.

• False
Return a dictionary of type IReadOnlyDictionary<string, 
bool> that holds an entry for each addressed location.

Returns bool 
or
IReadOnlyDictionary<string, bool>

Notes • Not allowed for "DUT_" hooks.
• Not supported for locations defined by the DUT Control 

Interface script.

Functionality Read the symbol loss status bit from the addressed locations 
and return either the logical OR of all addressed locations, or 
each location's status individually.

Parameters

groupOrLocationName Addresses the locations that shall be read. 
The use of .Net regular expression patterns is allowed.

combineIntoOneResult • True
Return the logical OR of all addressed status bits.

• False
Return a dictionary of type IReadOnlyDictionary<string, 
bool> that holds an entry for each addressed location.

Returns bool 
or
IReadOnlyDictionary<string, bool>

Notes • Not allowed for "DUT_" hooks.
• Not supported for locations defined by the DUT Control 

Interface script.
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M8000.Instrument.Analyzer.GetCdrUnlock(groupOrLocationName, 
combineIntoOneResult)

Functionality Read the CDR unlock status bit from the addressed locations 
and return either the logical OR of all addressed locations, or 
each location's status individually.

Parameters

groupOrLocationName Addresses the locations that shall be read. 
The use of .Net regular expression patterns is allowed.

combineIntoOneResult • True
Return the logical OR of all addressed status bits.

• False
Return a dictionary of type IReadOnlyDictionary<string, 
bool> that holds an entry for each addressed location.

Returns bool 
or
IReadOnlyDictionary<string, bool>

Notes • Not allowed for "DUT_" hooks.
• Not supported for locations defined by the DUT Control 

Interface script.
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SCPI Editor

The SCPI Editor lists all SCPI that can be used to program 
M8020A/M8030A and also provides a platform to execute them.

The following figure depicts the elements of the SCPI Editor:

The listed elements are described below:

• SCPI Text Box - Allows you to type the SCPI.

• SCPI List Pane - Lists all SCPI related to M8020A/M8030A.

• Execute Button - Click this button to run the SCPI.

• SCPI History Pane - Maintains the history of the executed SCPI 
commands and also displays the invalid command errors.

• Clear History Icon - Clears the contents of the SCPI History Pane.

SCPI Basics

There are a number of key areas to consider when using SCPI for the first 
time. These are as follows:

• Instrument Model

• Command Syntax

• Optional Command Keywords

• Query Responses

• Command Separators

• SCPI Command Structure

• Invalid Commands
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Instrument Model

SCPI guidelines require that the M8020A/M8030A is compatible with an 
instrument model. This ensures that when using SCPI, functional 
compatibility is achieved between instruments that perform the same 
tasks. For example, if two different instruments have a programmable 
clock frequency setting, then both instruments would use the same SCPI 
commands to set their frequency. The instrument model is made up of a 
number of subsystems.

The sub-system defines a group of functions within a module and has a 
unique identifier under SCPI, which is called the Root Keyword.

Command Syntax

Commands may be up to twelve characters long. A short-form version is 
also available which has a preferred length of four characters or less. In 
this document the long-form and short-form versions are shown as a 
single word with the short-form being shown in upper-case letters.

For example, the long-form node command SOURce has the short-form 
SOUR. Using the short form saves time when entering a program; 
however, using the long form makes a program more descriptive and 
easier to understand.

SCPI commands may be commands only, commands and queries, or 
queries only. A question mark at the end of a command indicates that it is 
a query. If the question mark appears in brackets ([?]), the command has a 
command and query form.

Optional Command Keywords

Some layers in the SCPI command structure are optional. These optional 
keywords are indicated by square brackets ([]). A typical use for these 
types of keywords is with a command that is unique to one module. In this 
case, the top layer (Root Keyword) of the command structure may be 
omitted.

For example, the following command code segments are functionally 
identical:
[:SOURce]:JITTer[:GLOBal][:STATe] <ON|OFF|1|0>
:JITTer <ON|OFF|1|0>
:JITT <ON|OFF|1|0>
:jitt <ON|OFF|1|0>

Note that it is not necessary to include the syntax inside the square 
brackets ([]).
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Query Responses

It is possible to interrogate the individual settings and status of a device 
using query commands. Retrieving data is a two-stage operation.

The query command is sent from the controller using the OUTPUT 
statement and the data is read from the device using the ENTER 
statement. A typical example is the SCPI IEEE 488.2 Common Command 
*IDN? which queries the identity of a device.

Command Separators

The SCPI command structure is hierarchical and is governed by commas, 
semicolons and colons:

• Commas are used to separate parameters in one command.

• Colons are used to separate levels.

• Semicolons are used to send more than one command to the 
instrument at a time.

It is possible to send several commands in one pass, as long as the 
commands all belong to the same node in the SCPI tree. The commands 
have to be separated by semicolons.

The following SCPI commands provide examples of this.
SOURce:VOLTage:OFFSet ‘M2.DataOut2’,-0.99
SOURce:VOLTage:AMPLitude ‘M2.DataOut2’,1.11

These commands can also be sent as follows:
VOLT:OFFS ‘M2.DataOut2’,-0.99; ‘M2.DataOut2’,AMPL 
1.11

SCPI Command Structure

The SCPI command structure can be best examined by means of an 
example. For example, the command to set the generator's output 
amplitude is:
[:SOURce]:VOLTage[:AMPLitude] ‘M1.DataOut1’,1.11

NOTE
When sending strings to the instrument, either the double quote (") or 
the single quote may be used ('), the latter being more suited to PASCAL 
programs, which make use of a single quote; the former being more 
suited to use in BASIC programs, which use a double quote as a 
delimiter.
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The structure of this command can be illustrated as follows:

• [:SOURce] - This is the top layer of the command structure and 
identifies the source subsystem.

• :VOLTage - This is the next layer and defines the subnode for setting a 
voltage level.

• [:AMPLitude] - This is the command itself for setting the output 
amplitude level.

• ‘M1.DataOut1’, 1.11 - This specifies module 1, DataOut port of channel 
1, and specifies an amplitude of 1.11.

To translate this syntax into a command line, follow the convention 
described above. Remember, however, that the command line can be 
created in several different ways. It can be created with or without optional 
keywords, and in a long or short form. The following example gives three 
possible forms of the command line; all are acceptable.

In long form:
:SOURce:VOLTage:AMPLitude ‘M1.DataOut1’,1.11

In short form:
:SOUR:VOLT:AMPL ‘M1.DataOut1’,1.11

With the optional commands removed:
:VOLT ‘M1.DataOut1’,1.11

The long form is the most descriptive form of programming commands in 
SCPI.

Invalid Commands

A command is invalid and will be rejected if:

• It contains a syntax error.

• It cannot be identified.

• It has too few or too many parameters.

NOTE
Any optional commands are enclosed in square brackets [] and any 
optional characters are shown in lower case.

A colon indicates a change of level in the command hierarchy. 
Commands at the same level in the hierarchy may be included in the 
same command line, if separated by a semi-colon.

The bar symbol (|) indicates mutually exclusive commands.
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• A parameter is out of range.

• It is out of context.

Executing SCPI Commands

To execute a SCPI command, follow the given steps:

1 Select the SCPI from the given list. You can also type the SCPI in the 
provided text box to expedite the command search.

2 Use the proper SCPI command syntax along with the command 
separators. For complete details, refer to SCPI Basics on page 411. 

The following example shows a SCPI command to enable Global Jitter 
State:
:SOURce:JITTer:GLOBal:STATe ‘M1.SYSTEM’, ON

3 Click Execute. The output of the SCPI command will be displayed in 
the History pane as shown in the following figure:

4 Click the  Clear History icon to clear the contents of History pane.

For complete details on M8020A/M8030A SCPI commands, refer to the 
M8070A Programming Guide.
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Self Test Utility

The Self Test utility checks the specific system information of the 
hardware components for basic functionality. On execution, the following 
results are displayed:

• System related information such as connected modules, serial no. and 
hardware revision.

• Module related information such as calibration, power supplies and 
memory controller.

Launching the Self Test Utility

To launch the Self Test:

• Go to the Menu Bar > Utilities and then select Self Test.

The Self Test utility will appear as shown in the following figure:

The Self Test utility consists of the following GUI elements:

• Toolbar

• Self Test History 

• Self Test Results Window
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Toolbar

The toolbar provides the following convenient self test functions:

Table 73  

Self Test History

The Self Test History maintains the history of self tests (Passed or Failed) 
executed by the user. The passed self test results are indicated by green 
LED while the failed ones are indicated by red LED.

Icon Name Description

Execute Self Test Click this icon to run the self test.

Abort Self Test Click this icon abort a self test. 

Save Self Test Click this icon to save the selected self test from the history. 
For details, refer to Saving Self Test Results on 
page 419.

Delete Self Test Click this icon to delete the selected self test from the history.

Close Report Click this icon to close the self test result. 
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At any point of time, you can double-click on the shown self test entries to 
view their respective results. Once viewed, you can click on  Close 
Report icon to close the self test results.

The Self Test History also allows you to save and delete the self test 
reports. For details, refer to Saving Self Test Results on page 419 and 
Deleting Self Test Results on page 420.

Self Test Results Window

The Self Test Results window displays the results of the executed self test. 
It display the following results:

• System related information such as connected modules, serial no. and 
hardware revision.

• Module related information such as calibration, power supplies and 
memory controller.

Executing Self Test

To execute a self test:

• Terminate each Data Out port with 50 .

• Remove any devices from the tested M8000 system as any connected 
device under test might be damaged.

• Click the  Execute Self Test icon. The following message will 
appear:

Ω
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• Click on Perform Test button present on the message box.

• The self test will start and the status will be indicated by the status 
indicator that appears on the right side of the toolbar. Once the self 
test is completed, the results will be shown on the Self Test Results 
window.

Aborting Self Test

To abort a self test:

• Click  Abort Self Test icon to abort the self test. The self test will 
stop and the self test failure entry will be displayed in the Self Test 
History.

Saving Self Test Results

To save the self test results from the Self Test History:

• Click the  Save Report icon. A standard Save Result dialog will 
appear.

CAUTION
Before performing a system self-test, terminate each Data Out port with 
50 . Take care to remove any devices from the tested M8000 system as 
any connected device under test might be damaged.

Ω
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• Use the navigation pane to provide a location to save the file.

• Provide a file name and specify the file format. You can save the file in 
RTF, HTML, XML and TXT formats.

• Click Save.

Deleting Self Test Results

To delete a self test entry from the Self Test History:

• Click  Delete Report icon. The entry will be removed from the Self 
Test History.
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Licenses Window

The Licenses window displays the license information currently installed in 
the modules or host.

Launching the Licenses Window

To launch the Licenses window:

• Go to the Menu Bar > Utilities and then select Licenses....

The Licenses window is shown in the following figure:

The Licenses window is divided into two panels. The left panel shows the 
modules/host information. Once you select modules/host, the 
corresponding license information is shown in the right panel.

To exit the Licenses window, click the Close button.

For detailed information on the M8020A/M8030A licenses, refer to 
Licenses on page 433.
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Settings Window

The Settings window allows you to set the display and channel settings in 
the GUI.

To open the Settings window, go to Menu Bar > Utilities and then select 
Settings.... The Setting window will appear as shown in the following 
figure:

The Settings window has the following tabs:

Display Settings

The Display Settings tab provides the following options:

• Display - The Display option provides the following choices:
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• Color Scheme - Use this option to change the color scheme of the 
GUI. You can choose between the dark or light scheme. The dark 
scheme is selected by default.

• Font Setting - Use this option to change the font settings in the 
GUI.

• Use System Fonts - Select this option to use the system fonts in the 
GUI.

Keypad Visibility

• Disable Keypad - Use this option to disable the on-screen numeric 
keypad in the GUI. The on-screen numeric keypad is enabled by 
default.

Channel Settings

• The Channel Settings tab displays the color schemes applied to the 
various channels of the connected modules. In addition, this tab also 
allows you to assign your own color schemes to each individual 
channel of the connected modules. The following figure depicts how 
the different color schemes are applied to the various channels of the 
connected modules.

NOTE
The color schemes assigned to the channels will change if you switch to 
light color scheme from the Display Setting tab.



424 Keysight M8070A User Guide

9 Utilities
 

Logger Window

The Logger window displays errors, warnings and information messages 
along with their respective descriptions, applications from where they are 
generated and their time stamps.

The Logger window allows you to: 

• Filter - Use the filter option to select the loggers from where the 
generated messages will be displayed.

• Message Selection - Use this option to choose whether you want to 
view errors, warnings or information message. 

• Copy - Use this option to copy a message. You need to select a 
message in order to enable copy feature.

• Select All - Use this option to select all messages. It also enables 
copying all messages.

• Clear Messages - Use this option to delete all messages. 

• Auto Scroll - Use this option to enable/disable auto scroll option. 
When the Auto Scroll option is enabled, it will automatically scroll you 
to the new message without using the scroll bar

• Search Messages - Use this option to search messages by providing an 
input in the Search Messages search box.
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SCPI Server Information

This dialog lists the VISA resource and remote access strings to connect 
instruments.
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Plug-in Manager

A plug-in is a piece of software application that acts as an add-on to the 
main software and enhances its capability. Plug-in allows the software to 
host additional functionality without undergoing a major modification or 
enhancement. A plug-in is not a permanent part of the software, hence 
can be installed, uninstalled and updated as and when required.

The M8070A system software for the M8000 Series of BER Test Solutions 
supports plug-ins. Thus, the present capabilities of M8070A can be further 
enhanced by simply adding the required plug-ins. 

The Plug-in Manager simplifies all the tasks related to plug-in 
management. It displays list of plug-ins that are installed in the software. 
For each plug-in, it displays the information such as Name, Version, 
Vendor, Description, State and Build Date. In addition, the Plug-in 
Manager also allows you to install, uninstall and update the plug-ins.

How to Launch Plug-in Manager

To launch Plug-in Manager, open the M8070A user interface and then go 
to Menu > Utilities and then Plug-in Manager. The Plug-in Manager 
window will appear as shown in the following figure:

The Plug-in Manager window displays two types of plug-ins:

• Compatible Plug-ins – plug-ins which are compatible with the current 
version of software.

• In-Compatible Plug-ins – plug-ins which are not compatible with the 
current version of software. 
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The Plug-in Manager window displays the following information of each 
plug-in:

• Name - Name of the plug-in

• Verison - Version no. of the plug-in

• Vendor - Vendor/publisher of the plug-in

• Description - Brief description of the plug-in

• State - State of the plug-in. For details on different plug-in states, see 
Plug-in States on page 427.

• Build Date - Build date of the plug-in

Plug-in States

There can be the following plug-in states: 

• Installed - When the plug-in is installed but the M8070A software is 
not re-started. In this case, the installed plug-in is not loaded or it 
cannot be used. You have re-start the M8070A software in order to load 
the plug-in.

• Loaded - When the plug-in is installed and the M8070A software has 
been re-started. In this case, the installed plug-in is ready to be used. 
Remember, you have to restart the M8070A software in order to load 
the plug-in.

• Not Loaded - When the plug-in is installed and but failed to load. In 
this case, the installed plug-in cannot be used.

• Version In-Compatible - When the version of the installed plug-in is 
not compatible with the current version of M8070A software. 

How to Install a Plug-in

The Plug-in Manager window allows you to install a plug-in. 

To do so;

1 Download plug-in file from Keysight webpage: 
www.keysight.com/find/m8000

2 Click on  Install Plug-in from File button. A Window’s standard 
Open dialog will appear.

3 Locate the plug-in file (*.M8KP) you want to install and click OK. 

4 On the successful installation of plug-in, the following message will 
appear:
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5 Restart the software. Once you restart the software, the plug-in state 
will change to Loaded. See Plug-in States on page 427.

How to Uninstall a Plug-in

The Plug-in Manager window allows you to uninstall a plug-in. 

To do so;

1 Select the plug-in from the list. 

2 Click on  Uninstall Selected Plug-in button or right-click on the 
selected plug-in. The Uninstall Plug-in dialog will open. 

3 Click Yes. If the state of plug-in is Installed, then it will be immediately 
uninstalled from the software. 

4 However, if the plug-in is currently in use (Loaded or Not Loaded), 
then you will receive the following message. 

NOTE
Ensure to restart the M8070A software for the changes to take effect.
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5 Restart the software. The plug-in will be uninstalled on software 
startup.

How to Update a Plug-in

The Plug-in Manager window also allows you to update an already 
installed plug-in. 

Following the given steps to update the plug-in with its higher version:

1 Download plug-in file from Keysight webpage: 
www.keysight.com/find/m8000

2 Click on  Install Plug-in from File button. A Window’s standard 
Open dialog will appear.

3 Locate the plug-in file (*.M8KP) you want to update and click OK. You 
will see the following message:

4 Click Yes. If the state of plug-in is Installed, then it will be immediately 
updated and the following message will appear:
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5 However, if the plug-in is currently in use (Loaded or Not Loaded), 
then you will receive the following message. 

6 Click Yes. The following message will appear:

7 Click OK. The selected plug-in will be uninstalled from the software. 
You can now install the new version of that plug-in. For installation 
procedure, see How to Install a Plug-in on page 427. 
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The Plug-in Manager window does not directly allow you to update an 
installed plug-in with previous (lower) version. If you try to do so it will give 
the following error message:

In this case, you have to uninstalled the plug-in and then install the 
previous (lower) version of that plug-in again. 

How to Access an Installed Plug-in Through M8070A User Interface

Follow the steps to access an installed plug-in through M8070A user 
interface:

1 Launch M8070A software user interface.

2 In the M8070A user interface, go to Menu Bar and then click 
Application menu. It will list all installed plug-ins.

3 Select the plug-in. 

4 The plug-in user interface will appear in the M8070A software.

For complete details on how to operate plug-in user interface, refer to the 
respective plug-in's User Guide

NOTE
Ensure to restart the M8070A software for the changes to take effect.
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Overview

The M8070A software requires a license to communicate with the 
M8020A/M8030A hardware. You either purchased an M8070A license to 
install on a dedicated host computer (M8070A-OTP) or one that can be 
installed on a network server that will be used as a license server for 
operation over a company network (M8070A-ONP, floating/networked).

In addition to the M8070A license, the M8020A and M8030A, being a 
modular product, includes different sets of modules hosted in an M9505A 
and M9514A AXI chassis, respectively. Each module has its own licenses 
corresponding to specific features. Therefore, you need to install these 
licenses in your instrument in order to use the modules/features.
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Supported Licenses

The M8020A/M8030A supports the following types of licenses:

• Node-Locked (Uncounted) Licenses

• Floating Licenses

• Module-Specific Licenses

In addition to the binding characteristic (node-locked, floating, or 
module-specific), licenses have the following characteristics:

• Duration (permanent or time-perishable)

• Version (conventional or date-based)

• Features (an instrument may have one or more features licensed)

• Transportability (the ability to be moved from one instrument to 
another)

Finally, the following license types are available for legacy systems. Please 
contact Keysight Technologies support first (http://www.keysight.com) if 
you are considering using these in new designs:

• Counted Node-Locked License

• Upgrade License

Node-Locked (Uncounted) Licenses

Node-locked licenses are tied to a particular instrument or PC Host ID. 
The Host ID consists of the model number and serial number, and is stored 
in SecureStorage on the instrument or PC.

The node-locked licenses can be of the following type:

• Permanent licenses that do not have expiration date.

• Time-perishable licenses that have expiration date.

• Transportable licenses that can be moved from one instrument to 
another, and may be either time-perishable or permanent.

• Non-removable licenses that typically provide right-to-use for a 
hardware component.

Permanent License

A permanent license is the most common type of license. It does not have 
an expiration date.
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Time-Perishable License

A time-perishable license differs from the permanent license in a way that 
it has an expiration date. The date is in the dd-mm-yyyy format. The 
time-perishable licenses are applied to instruments only and not applied 
to PC software applications. They are typically used for trial or demo 
purposes.

Transportable Node-Locked License

A transportable license can be moved (transported) from one instrument 
to another. It can be either permanent or time-perishable, but it must be 
node-locked. Once a license has been transported off of a system, that 
feature is no longer valid on that system. If a user wishes to transport the 
license back to the original device, he or she is free to do so.

When removed from the device, this license is marked as not reinstallable 
on the system. The user is notified and a transport confirmation key will be 
generated so that a new license can be redeemed with a new Host ID.

If the license file is transported back to the original system, a unique serial 
number ensures that the new license has a different signature from any 
previously installed and transported licenses (which cannot be reinstalled).

You can acquire a transportable license by moving the license from a 
system where it was previously installed, or by acquiring the license from 
the Keysight Software Manager web site. You cannot manually create a 
transportable license. Even if you know the correct syntax, construct the 
license correctly, and sign it with a license generator, you will not be able 
to transport the license. The Keysight Software Manager which provides 
the real-time re-hosting does not recognize a transportable license that it 
did not originate.

Floating Licenses

A floating license entitles anyone on the same network to use the licensed 
software, up to the numeric limit specified in the license file. You must 
configure a license server in order to use floating licenses. These licenses 
require the license server manager daemon (FLEXnet Publisher lmadmin) 
and the Keysight daemon (agilent.exe) to be running in order to count the 
concurrent usage of the licenses.

Floating licenses are further subdivided into local and remote licenses. 
Local licenses are stored in the licensing folder and in secure storage; 
remote licenses are kept in a “Remote Licenses” sub folder, and are not 
stored in SecureStorage. Floating licenses are installed on two different 
host machines, the application host and the server host. A license is 
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considered to be local if there is a SERVER line in the license with a host 
name that refers to the host where the license is installed. Conversely, a 
license is considered to be remote if there is a SERVER line in the license 
that has a host name that is different from the host where the license is 
installed.

Module-Specific Licenses

Module-specific licenses are a specialized type of license that enables a 
specific module of a modular instrument (such as a PXI or AXIe module). 
The module-specific license resides on the controller and is bound to both 
the controller (typically a PC) and the module; the controller by means of 
the HostID, and the module itself by means of the module serial number 
which is embedded in the feature name for the license.

Module-specific licenses may be time-perishable.
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M8020A/M8030A Licenses

The list of licenses used by the various modules of M8020A/M8030A is 
listed in the following tables: 

M8070A System Software for M8000 Series of BER Test Solutions

M8070 - M8000 Series BER Test Solution License

Table 74  M8070 - M8000 Series BER Test Solution License

M8041A - High-Performance BERT Module 

M8041A - Basic Selection

Table 75  M8041A - Basic Selection

Product Option Description

M8070A-0TP 0TP System Software for M8000 Series of BER Test Solutions, 
Transportable, Perpetual License

M8070A-0NP 0NP System Software for M8000 Series of BER Test Solutions, 
Network/Floating, Perpetual License

Product Option Description

M8041A-G08 G08 Generator one Channel, Data Rate up to 8.5 Gb/s

M8041A-G16 G16 Generator one Channel, Data Rate up to 16 Gb/s (Upgrade: U16)

M8041A-C08 C08 BERT one Channel, Data Rate up to 8.5 Gb/s

M8041A-C16 C16 BERT one Channel, Data Rate up to 16 Gb/s (Upgrade: UED)
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M8041A- Module Functionality

Table 76  M8041A- Module Functionality

M8041A - License Upgrades for M8041A High-Performance BERT Module

Table 77  M8041A - License Upgrades for M8041A High-Performance BERT Module

Product Option Description

M8041A-0G2 0G2 Second Channel for Generator, License

M8041A-0A2 0A2 Second Channel for Analyzer, License

M8041A-0G3 0G3 Advanced Jitter Sources for Receiver Characterization, 
Module-wide License

M8041A-0G4 0G4 Multi-tap De-emphasis, Module-wide License

M8041A-0G5 0G5 Adjustable ISI, Module-wide License

M8041A-0G6 0G5 Reference Clock Input with Multiplying PLL, Clockgroup-wide 
License

M8041A-0G7 0G7 Advanced Interference Sources for Receiver Characterization, 
Module-wide License

M8041A-0S1 0S1 Interactive Link Training for PCI Express, Clockgroup-wide 
License

M8041A-0S2 0S2 SER/FER Analysis for Coded and Retimed Loopback, 
Clockgroup-wide License

M8041A-0A3 0A3 Analyzer Equalization, Module-wide License

Product Option Description

M8041A-U16 U16 Upgrade to 16 Gb/s data rate from M8041A-G08 and 
M8041A-C08, Module-wide License

M8041A-UED UED Upgrade to BERT from M8041A-G08 and M8041A-G16, 
Module-wide License

M8041A-UG2 UG2 Upgrade to Second Channel for Generator, License

M8041A-UA2 UA2 Upgrade to Second Channel for Analyzer, License
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M8041A-UG3 UG3 Upgrade to Advanced Jitter Sources for Receiver 
Characterization, Module-wide License

M8041A-UG4 UG4 Upgrade to Multi-tap De-emphasis, Module-wide License

M8041A-UG5 UG5 Upgrade to Adjustable ISI, Module-wide License

M8041A-UG6 UG6 Upgrade to Reference Clock Input with Multiplying PLL, 
Clockgroup-wide License

M8041A-UG7 UG7 Upgrade to Advanced Interference Sources for Receiver 
Characterization, Module-wide License

M8041A-US1 US1 Upgrade to Interactive Link Training for PCI Express, 
Clockgroup-wide License

M8041A-US2 US2 Upgrade to SER/FER Analysis for Coded and Retimed Loopback, 
Clockgroup-wide License

M8041A-UA3 UA3 Upgrade to Analyzer Equalization, Module-wide License

Product Option Description
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M8051A - High-Performance BERT Module 

M8051A- Basic Selection

Table 78  M8051A- Basic Selection

M8051A- Module Functionality

Table 79  M8051A- Module Functionality

Product Option Description

M8051A-G08 G08 Generator one Channel, Data Rate up to 8.5 Gb/s

M8051A-G16 G16 Generator one Channel, Data Rate up to 16 Gb/s (Upgrade: U16)

M8051A-C08 C08 BERT one Channel, Data Rate up to 8.5 Gb/s

M8051A-C16 C16 BERT one Channel, Data Rate up to 16 Gb/s 
(Upgrade: UED)

Product Option Description

M8051A-0G2 0G2 Second Channel for Generator, License

M8051A-0A2 0A2 Second Channel for Analyzer, License

M8051A-0G3 0G3 Advanced Jitter Sources for Receiver Characterization, 
Module-wide License

M8051A-0G4 0G4 Multi-tap De-emphasis, Module-wide License

M8051A-0G5 0G5 Adjustable ISI, Module-wide License

M8051A-0G7 0G7 Advanced Interference Sources for Receiver Characterization, 
Module-wide License

M8041A-0A3 0A3 Analyzer Equalization, Module-wide License
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M8051A - License Upgrades for M8051A High-Performance BERT Module 

Table 80  M8051A - License Upgrades for M8051A High-Performance BERT Module

M8061A Multiplexer 2:1 with De-emphasis

Table 81  M8061A Licenses

Product Option Description

M8051A-U16 U16 Upgrade to 16 Gb/s data rate from M8051A-G08 and 
M8051A-C08, Module-wide License

M8051A-UED UED Upgrade to BERT from M8051A-G08 and M8051A-G16, 
Module-wide License

M8051A-UG2 UG2 Upgrade to Second Channel for Generator, Module-wide License

M8051A-UA2 UA2 Upgrade to Second Channel for Analyzer, Module-wide License

M8051A-UG3 UG3 Upgrade to Advanced Jitter Sources for Receiver 
Characterization, Module-wide License

M8051A-UG4 UG4 Upgrade to Multi-tap De-emphasis, Module-wide License

M8051A-UG5 UG5 Upgrade to Adjustable ISI, Module-wide License

M8041A-UG7 UG7 Upgrade to Advanced Interference Sources for Receiver 
Characterization, Module-wide License

M8051A-UA3 UA3 Upgrade to Analyzer Equalization, Module-wide License

M8051A-U16 U16 Upgrade to 16 Gb/s data rate from M8051A-G08 and 
M8051A-C08, Module-wide License

Product Option Description

M8061A-001 001 32 Gb/s multiplexer

M8061A-004 004 4-tap de-emphasis

M8061A-008 008 Extension to 8-tap de-emphasis

M8061A-U04 U04 Upgrade to 4-tap de-emphasis

M8061A-U08 U08 Upgrade to 8-tap de-emphasis
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M8062A 32Gb/s Front-end for J-BERT M8020A High-Performance BERT

M8062A - Basic Selection

Table 82  M8062A - Basic Selection 

M8062A - Module Functionality

Table 83  M8062A - Module Functionality 

M8062A - License Upgrades for M8062A 32Gb/s Front-end for J-BERT M8020A 
High-Performance BERT

Table 84  M8062A - License Upgrades for M8062A 32Gb/s Front-end for J-BERT M8020A 
High-Performance BERT

Product Option Description

M8062A-C32 C32 32 Gb/s BERT front-end

M8062A-G32 G32 32 Gb/s Pattern generator front-end

Product Option Description

M8062A-0G4 0G4 Multi-tap De-emphasis License

M8062A-0G5 0G5 Adjustable Intersymbol Interference (ISI) License

M8062A-0A3 0A3 Analyzer Equalization License

M8062A-0A4 0A4 Clock Recovery up to 32 Gb/s

Product Option Description

M8062A-UED UED Upgrade of M8062A-G32 Pattern Generator to M8062A-C32 
BERT License

M8062A-UA3 UA3 Upgrade of M8062A to Analyzer Equalization License
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M8062A-UG4 UG4 Upgrade of M8062A to Multi-tap De-emphasis License

M8062A-UG5 UG5 Upgrade of M8062A to Adjustable Intersymbol Interference 
License

M8062A-UA4 UA4 Upgrade of M8062A to Clock Recovery up to 32 Gb/s

Product Option Description

NOTE
In addition to the M8062A-UA4 license, M8062A modules with serial 
numbers < MY55400300 may also require a hardware upgrade in order 
to enable the CDR feature.
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Keysight License Manager

Keysight License Manager is a software utility used with Full Licensing 
that enables end users to easily manage right-to-use licenses for software 
and hardware capabilities on Keysight instruments or systems. The 
graphical user interface (GUI) gives you a visual representation of the 
licenses installed on your Keysight Technologies systems and provides 
access to the following features:

• Install licenses for new capabilities

• Transport licenses from one controller to another

• Remove licenses for capabilities no longer needed

For detailed information on Keysight License Manager, refer to the 
Keysight License Manager Help. You can access the Keysight License 
Manager Help from the Keysight License Manager web page: 
http://www.keysight.com/find/LicenseManager
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Keysight License Service

The Keysight License Service is used in Full Licensing to accomplish 
installation, listing, validation, removal, and transportation of instrument 
licenses.

NOTE
The Keysight License Service is a Windows service that runs 
automatically and appears in the Windows Task Manager and Event 
Viewer the same as other processes. ACCL code communicates with this 
service to perform licensing functions, and the service monitors system 
and user events and take appropriate actions.

NOTE
The Keysight License Service supports certain specific firewalls. These 
firewalls must be appropriately configured. For details, refer to Firewall 
Configuration for Licensing on page 448.
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Installing the Licenses

Software Requirements

The M8070A uses the following operating system for installation: 

• Microsoft Windows 7 (64 bit) SP1

• Windows 8 (64 bit)

• Windows 8.1 (64 bit)

Installing M8070A-OTP License (not required for M8020A-BU1 and M8030A-BU1)

The following procedure shows how to redeem and install a M8070A 
license on a dedicated host computer.

1 Locate the Software License Entitlement Certificate.

2 Follow the instructions on the Software License Entitlement 
Certificate to redeem your license.

3 You will receive a license file (in an email). The file has the suffix .lic.

4 Follow the instructions in the email to complete the installation of the 
license file.

5 In the M8070A software interface, verify that the license has been 
installed by selecting Help > Licenses and then viewing the license 
status in the Installed column.

Installing M8070A-ONP Floating/Networked License

An M8070A-ONP floating/networked license resides on a network server 
and is accessible by multiple users. The user checks out a license each 
time the software is accessed. The server tracks the number of licenses 
checked out and the number of licenses available for use.

The server must be running license services. This server can be a 
dedicated computer running the license server or it can run license 
services and the M8070A software concurrently.

NOTE
In case you ordered M8020A-BU1 all module and M8070A licenses have 
been pre-installed (except for a floating/networked license). All other 
system configurations require license installation as described in this 
step.
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Firewall Configuration for Licensing

If your instrument or PC has a firewall installed and enabled, your system 
administrator may need to allow certain executables and/or a limited 
range of port numbers to go through the firewall. This topic discusses 
those ports and configuration for three common firewalls.

1 In Windows, click Start > Control Panel > System and Security > 
Windows Firewall.

2 In the left pane, click Allow a program or feature through Windows 
Firewall. If this is not accessible, perform the following alternate 
procedure:

1 In Windows, click Start and enter Allow a program through 
Windows Firewall in the search field.

2 In the Control Panel, select Allow a program through Windows 
Firewall as shown in the following figure.

3 Click Change Settings. You may need to provide an administrator 
password or provide confirmation for this action.

4 Click on the Allow another program button.

5 Select M8000 then click Add.

6 Add program path:

C:\Program Files (x86)\FlexNet Publisher License Server Manager\
lmadmin.exe.

NOTE
Typically, the Licensing installer will do the necessary configuration of 
the Windows firewall. These instructions are provided in case you need to 
verify or modify the firewall configuration manually.
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7 Repeat step 4 to step 6 to add other programs.

8 In the Allowed Programs dialog, click OK to save the settings.

Installing the FlexNet License Manager

The FlexNet License Manager tools associated with floating licenses are 
available from Flexera at www.keysight.com/find/fnptools. You must use 
version 11.11.1 or higher.

FlexNet provides two different license server executables: lmgrd.exe and 
lmadmin.exe. You can use either one or the other.

Imadmin Installation

The following procedure describes how to install lmadmin.exe (server 
side):

1 Copy the agilent.lic file from the Keysight Licensing installation path 
(typically, C:\Program Files\Agilent\ACCL\Licensing\bin or 
C:\Program Files (x86)\ACCL\Licensing\bin) into the licensing folder. 
(The license filename will change to agilent0.00.lic after successful 
installation.)

2 Determine whether the target system has Java installed, if not, install 
it from www.java.com. The Java virtual machine is required to run the 
lmadmin.exe installer.

3 Run the lmadmin.exe. (Right-click the installer file and Run as 
Administrator.) During the installation:

www.keysight.com/find/fnptools
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1 Accept the default installation path.

2 Check the box to Install Visual C++ 2005 SP1 Redistributable.

3 On the Service Configuration page, enter the HTTP Port Number: 
‘8090’.

4 On the Service Configuration page, select the check-box to Run as 
Service.

5 On the Start the Server page, select the check box to Start server 
now. If you don't do it now, then you will need to start the lmadmin 
service before configuring the license server.

4 If the web browser does not shows the license configuration page, just 
exit the browser and reboot the PC.
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5 After reboot start the browser and use the use following 
http://localhost:8090/ address again.Now you should see the web 
configuration page of the lmadmin. 

6 However, if you see the message ‘The page can’t be displayed …’ again 
the firewall of windows has block the access. You may need to allow 
certain executable and/or the port number to go through the firewall. 
For firewall settings, refer to Firewall Configuration for Licensing on 
page 448.

7 In the login page, if you have not previously set up a login, sign in as 
“user admin” with password “admin”. You will then be required to 
change the password.

8 Start the browser and use the use following http://localhost:8090/ 
address again.

9 The lmadmin is installed as service. To check the state of the service, 
right click on the Computer icon on the desktop and then select 
Manage. Click on Services and check if service lmadmin is started.
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10 Login to the lmadmin web configuration page. Add the agilent.lic and 
the M8070A-0NP.

C:\Program Files (x86)\Agilent\ACCL\Licensing\bin\agilent.lic

…\1001562893_1166729.lic

11 On the client side, install the M8070A software on the client PC.
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12 Install the edited license M8070A-0NP on the client (import license in 
the Keysight License Manager).

13 In the Keysight License Manager, verify by opening the ‘Licenses list’ 
and ‘Feature Detail’ view. The following illustration displays the 
‘Licenses list’ view.

14 Start the M8070A software. From the menu bar, select Utilities > 
Licenses. The M8070A license dialog will display the installed licenses.

15 Request a floating license. For details, refer to Acquiring Floating 
Licenses on page 456.
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Lmgrd Installation

The following procedure describes how to install lmgrd.exe (server side).

1 Copy the agilent.lic file from the Keysight Licensing installation path 
(typically found in C:\Program Files\Agilent\ACCL\Licensing\bin or in 
C:\Program Files (x86)\Agilent\ACCL\Licensing\bin into the licensing 
folder. (The license file name will change to agilent0.00.lic after 
successful installation).

2 Copy the appropriate version of lmgrd.exe (32-bit or 64-bit, depending 
on your operating system) to the target system. It is recommended to 
put lmgrd.exe in the Keysight Licensing installation path (see step 1 for 
path information).
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3 Install floating licenses to the licensing folder, C:\Program Files\
Agilent\Licensing.

4 Open a DOS prompt and change directory to the location of lmgrd.exe.

5 Launch lmgrd.exe with the following command:

lmgrd.exe -z -c "C:\Program Files\Agilent\licensing"

6 If the license server is running (lmgrd.exe) you will see the licenses in 
the Keysight License Manager on the server.

7 On the client side, install the edited license M8070A-0NP (import 
license in the Keysight License Manager) 

8 In the Keysight License Manager, verify by opening the ‘Licenses list’ 
and ‘Feature Detail’ view. The following illustration displays the 
‘Licenses list’ view.

9 Start the M8070A software. From the menu bar, select Utilities > 
Licenses. The M8070A license dialog will display the installed licenses.
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10 Request a floating license. For details, refer to Acquiring Floating 
Licenses on page 456.

Acquiring Floating Licenses

1 Contact your Keysight Technologies representative to purchase 
licenses for your software. You will receive an order number and 
certificate number, which you will use to request a license file in step 3.

2 Select and configure your license server machine as described above. 
For more information, refer to the Flexera Software License 
Administration Guide. You must install Keysight Licensing on the 
license server computer, as described in Creating a New License 
Service using lmadmin.exe on page 458, before requesting a license 
file in step 3.

3 Request a license file for your license server machine:

1 Determine the hostname and serial number (10-digit alphanumeric 
sequence, which is the second component of the host ID) of your 
license server from Keysight License Notifier's About box.

2 To display the About box, right-click the Keysight License Notifier 
icon in the notification area (bottom right of your screen) and click 
About Keysight License Notifier.

• You will need the highlighted items shown in the following figure: 
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• Visit the Keysight Software Manager website to request a license 
file.

4 When you receive your license via e-mail from Keysight Technologies, 
carefully read the instructions sent with the license. If the license is a 
"served" or "floating" license, put it in the directory C:\Program Files\
Agilent\licensing on the license server.
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Creating a New License Service using lmadmin.exe

Follow the given steps to create a new license service using lmadmin.exe:

1 To access the lmadmin license server management interface, open a 
web browser and navigate to http://<server>:8080, where <server> is 
the name of the computer on which the license server is running. For 
this first-time configuration, you need to be logged on to the license 
server computer, so that you can simply navigate to 
http://localhost:8080.

2 Select the Administration tab.

3 Log in. If you have not previously set up a login, sign in as “user admin” 
with password “admin”. You will then be required to change the 
password. Don’t forget this password.

4 Select the Vendor Daemon Configuration tab.

5 Select Import License.

6 Browse to the new floating license file. You can only choose one file at 
this step, so if you have more than one license file, then pick one of 
them, and click Import License.

7 An Import Error and an Import Warning will be displayed indicating 
that it can’t find the Agilent.exe file. Click OK.

8 Select the “Agilent” vendor daemon and click Administer.

9 Change the License File or Directory to “licenses\agilent” instead of 
the file you specified above. This will enable you to easily add more 
license files.

NOTE
If the browser cannot find the web page, then the lmadmin service may 
not be running on the server. Go to Start > Control Panel > 
Administrative Tools > Services, find “lmadmin” and start the service. 
After starting the service, refresh, or try navigating the browser to the 
web page again.

NOTE
To add more license files, follow the procedure below.
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10 Change the Vendor Daemon Location to the location of the Agilent.exe 
file:

1 For 32-bit Windows, enter “C:\Program Files\Agilent\ACCL\
Licensing\bin\Agilent.exe”.

2 For 64-bit Windows, enter “C:\PROGRA~2\Agilent\ACCL\Licensing\
bin\Agilent.exe”.

11 Click Save.

12 Start the daemon by pressing Start.

13 To verify the status of the server, select the Dashboard tab and click 
the Concurrent button. Wait for the Web page to refresh. If the 
“Agilent” daemon is not selected in the vendor drop-down list in the 
upper right side of the Licenses page, then select it by clicking Select. 
You will now see the list of floating licenses that are managed by 
lmadmin.exe.

Installing and Setting up Client PC Floating Licenses

The following procedures show how to install and set up client PC floating 
licenses. Repeat this procedure for each client PC.

1 Ensure that you have the Keysight Licensing Services and the M8000 
software to be installed on the client PC.

2 Create the Client floating license files.

The Client floating license files redirect licensing requests to the 
license server. Only one client floating license file needs to be created. 
This client floating license file is copied and re-used by each client PC.

Make a copy of the original license server floating license file. Remove 
all line entries except these three lines, which you must modified as 
shown.

• “SERVER” line: Keep original text

• “VENDOR” line: If the optional VENDOR line “port” number is 
included in the original server license file, remove the optional 
“Vendor” daemon TCP/IP port number from the line

• “USE_SERVER” line: Keep original text

NOTE
For 64-bit Windows, the file is in “C:\Program Files (x86)”, but the Web 
page does not allow you to enter a file path containing an open or close 
parenthesis, so you must instead enter the short file name “C:\
PROGRA~2” of the path.
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3 Install the client floating license files.

1 Start the Keysight License Manager by double clicking the 
Keysight License Notifier icon or click Start > (All) Programs > 
Keysight License Manager > Keysight License Manager.

2 To install the license file, drag and drop the license file onto the 
Keysight License Manager “License Features” window. 
Alternatively, you can click the Keysight License Manager menu 
File.

3 Install and follow the prompts to install the license file. The license 
files are stored in different folder locations depending on whether 
the license Server and client reside on separate PCs or the same PC.

• License Server and Client reside on separate PCs:
C:\Program Files\Agilent\licensing

• License Server and Client reside on same PC:
C:\Program Files\Agilent\licensing\Remote Licenses

4 Verify the client PC configuration is correct.

When the license file is successful installed, The client floating licenses 
that are available on the license server are listed in the Keysight License 
Manager “License Products and Features” window. To view the available 
licenses, select the Localhost tree, Remote Licenses node. Ensure that 
your licensed options and features are shown.

Installing Module Licenses (not required for M8020A-BU1 and M8030A-BU1)

Module licenses enable specific features in the modules of the 
M8020A/M8030A system. Once a module license has been installed using 
the Keysight License Manager, the next time the M8070A software and 
M8020A/M8030A hardware are started, the license is recognized by the 
M8070A software and compared to the module’s serial number. If the PC 
Host ID and serial number match, the EEPROM in the module is 
programmed and the feature is enabled. Even if the M8070A software 
license is transported to another host computer, the module feature will 
remain enabled.

The following procedure shows how to redeem and install a module 
license.

1 Locate the Software License Entitlement Certificate.

2 Follow the instructions on the Software License Entitlement 
Certificate to redeem your license.

3 You will receive a license file (in an email). The file has the suffix .lic.

4 Follow the instructions in the email to complete the installation of the 
license file.
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5 In the M8070A software interface, verify that the license has been 
installed by selecting Help > Licenses then viewing the license status 
in the Installed column.

Transporting an M8070A License

Transportable licenses are licenses that can be moved from one host 
controller to another using the Keysight License Manager. 

If you need to download and install the Keysight License Manager, go to 
the following Web page:

http://www.keysight.com/find/LicenseManager

1 Start the Keysight License Manager by double clicking the Keysight 
License Notifier icon or click Start > (All) Programs > Keysight 
License Manager > Keysight License Manager.

2 In the Keysight License Manager, click on Help > Keysight License 
Manager Help and perform the procedure in the Transporting 
Licenses help topic.





Keysight M8070A System Software for M8000 Series of 
BER Test Solutions

User Guide

11 Troubleshooting

Updating software components

Updated versions of the M8020A, M8030A and module specific software 
components are available on the Keysight website.

These software components are available as .EXE files. To download a 
software upgrade:

1 Go to http://www.keysight.com.

2 Click the Technical Support tab.

3 Click Drivers and Software.

4 Type the model number of the instrument module for which software 
update is needed and click Find. Model number is located on the front 
panel of the module.

5 Click the Driver & Software link on the module page.

6 Download the required software update from the list of available 
updates.

The chassis does not power up

If the chassis or a module does not appear to power up, check the 
following:

• The circuit breakers at the rear of the chassis are set to the right, which
is the ON position.

• The AC power cords are connected to a working power source.

• The electrical circuits are not overloaded. Check the combined power
requirements of all equipment on the same circuit.

• There are no empty slots in the chassis. Leaving slots empty can
overheat the inserted modules, causing them to shut down.
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Module is exceptionally hot

Check that the vent holes on the chassis are not blocked.

Check that a filler panel module or an instrument module is installed into 
empty slots on either side of an instrument module.

Contacting Keysight Technologies

To locate a sales or service office near you, go to 
www.keysight.com/find/contactus.
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